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KATA PENGANTAR 

 

Desainer kreatif yang secara khusus bekerja pada bidang video editing saat ini mempunyai 
banyak pilihan software untuk membantu pekerjaannya menjadi lebih mudah. Seperti 
seorang animator, pada saat membuat karya perlu melalui proses kreatif yang sangat 
panjang hingga bisa menghasilkan sebuah karya. Sekarang ini proses kreatif untuk 
menghasilkan sebuah karya bisa terbantu berkat adanya software Adobe After Effects. 

Design Shack menyatakan bahwa After Effects merupakan software animasi membuat dan 
menambahkan visual efek bisaa juga disebut VFX, hingga motion graphic ke dalam sebuah 
video. Post-production, merupakan proses yang dilakukan setelah proses produksi untuk 
pengembangan lebih lanjut finalisasi sebuah proyek video atau film. After Effects 
mempunyai banyak elemen visual efek untuk menjadikan movie lebih menarik. 

After Effects juga mendukung penambahan objek dari produk Adobe, seperti Photoshop, 
Illustrator, dan lainnya. Ini sangat memudahkan desainer kreatif bidang editing video untuk 
mengembangkan karyanya. Selain itu After Effects juga support banyak tipe file footage agar 
dapat digunakan untuk membuat karya. 

Banyak versi dari After Effects, yang terbaru adalah After Effects CC 2022 dengan spesifikasi 
yang direkomendasikan oleh Adobe harus menggunakan processor 8 core atau diatasnya, 
OS Windows 10 64 bit V20H2, RAM 32 GB, VRAM 4GB atau lebih. Dari spesifikasi yang 
ditunjukkan, kebutuhan hardware dan software sangat besar (sangat mahal). 

Buku ini menggunakan After Effects CS6 dimaksudkan untuk meringankan beban kebutuhan 
hardware dan software ketika ingin membuat efek atau belajar membuat efek. Buku ini 
dikhususkan bagi pemula atau pelajar yang sedang belajar membuat efek. Selain itu buku ini 
juga bisa digunkan oleh mereka yang ingin meningkatkan kemampuan dalam menggunakan 
After Effects.  

Semoga buku ini dapat membantu para desainer kreatif bidang editing video untuk 
menambah pengetahuan. Bagi pemula aat digunakan sebagai referensi dan belajar 
menguasai After Effects dalam membuat desain kreatif efek video. Mohon maaf atas segala 
kekurangan dan kesalahan dalam penyusunan buku ini..  

 

 
Semarang, Desember 2022 
 
Andik Prakasa Hadi, S.Kom.,M.Kom 
Penulis 
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PENDAHULUAN 
 

 

CS6 memungkinkan membuat karya seni untuk berbagai kegunaan. Animasi dan alat 
pengomposisian After Effects tiada duanya, memperkenankan untuk memanipulasi teks, 
gambar, audio dan video. After Effects merupakan alat untuk mengekspresikan ide kreatif 
dalam video, film, dan broadband produksi. After Effects CS6 juga terintegrasi erat dengan 
produk Adobe lainnya seperti Photoshop®, Ilustrator®, dan Premiere Pro®. 

Buku …. ini layaknya seperti memiliki instruktur pribadi yang membimbing dalam setiap bab 
sesuai dengan gaya belayar Anda. Buku ini mencakup 12 bab mandiri yang memungkinkan 
Anda menemukan keterampilan penting dan menjelajahi fitur dan kemampuan baru After 
Effects CS6 di kedua jenis komputer Windows atau Mac OS. Setiap bab mencakup petunjuk 
langkah demi langkah. 

Sebelum memulai belajar tentang Adobe After Effects CS6, perlu diketahui terlebih dahulu  
tentang komputer dan sistem operasinya. Anda harus tahu bagaimana menggunakan sistem 
direktori komputer Anda, sehingga Anda dapat menavigasi melalui folder. Anda perlu 
memahami cara menemukan, menyimpan, dan membuka file. Anda juga harus tahu cara 
menggunakan mouse untuk mengakses menu dan perintah. Sebelum memulai belajar 
tentang Adobe After Effects CS6, pastikan Anda telah menginstal Adobe After Effects CS6. 
Perangkat lunak ini dijual terpisah, dan tidak disertakan dengan buku ini. Anda dapat 
menggunakan uji coba 30 hari versi Adobe After Effects CS6 tersedia di situs web 
adobe.com, dengan ketentuan perjanjian lisensinya. 

 

A. Kebutuhan Sistem 

Sebelum memulai Adobe After Effects CS6, pastikan komputer Anda dapat menjalankan 
Adobe After Effects CS6, yang harus dibeli secara terpisah. Persyaratan sistem minimum 
untuk komputer Anda dalam menjalankan perangkat lunak seperti di bawah ini, dan 
persyaratan sistem terkini di www.adobe.com/products/aftereffects/techspecs.html. 

 

1. Windows 

• Intel® Core™ Duo or AMD Phenom® II Processor yang mendukung sistem 64-bit. 

• Microsoft® Windows® 7 with Service Pack 1 (64 bit). 
• 4GB of RAM (8GB direkomendasikan). 
• 3GB ruang hard-disk yang tersedia; ruang kosong tambahan yang diperlukan 

selama instalasi (tidak dapat menginstal pada perangkat penyimpanan berbasis 
flash yang dapat dilepas). 

• Ruang tambahan untuk disk cache (10GB direkomendasikan). 
• 1280×900 display dengan OpenGL 2.0–capable system. 
• Software QuickTime 7.6.6 yang diperlukan untuk fitur QuickTime. 
• Broadband k oneksi internet diperlukan untuk aktivasi perangkat lunak dan akses 

ke layanan online. 

http://www.adobe.com/products/aftereffects/techspecs.html


2. Mac OS 

• Multicore Intel processor yang mendukung sistem 64-bit. 

• Mac OS X v10.6.8 atau v10.7. 

• 4GB of RAM (8GB direkomendasikan). 

• 4GB ruang hard-disk yang tersedia untuk instalasi; ruang kosong tambahan yang 
diperlukan selama penginstalan (tidak dapat menginstal pada volume yang 
menggunakan case sensitive file system atau pada perangkat penyimpanan 
berbasis flash yang dapat dilepas). 

• Ruang tambahan untuk disk cache (10GB direkomendasikan). 

• 1280×900 display dengan OpenGL 2.0–capable system. 

• Software QuickTime 7.6.6 yang diperlukan untuk fitur QuickTime. 

• Broadband k oneksi internet diperlukan untuk aktivasi perangkat lunak dan akses 
ke layanan online. 

 

B. Memulai Adobe After Effects CS6 

Seperti kebanyakan perangkat lunak, Adobe After Effects CS6 dapat dibuka aplikasinya 
dari folder Program (Windows) atau folder Aplikasi (Mac OS). Jika perlu, ikuti langkah-
langkah ini untuk memulai aplikasi Adobe After Effects CS6. 

Sistem Operasi Windows : 

1. Pilih Start > All Programs > Adobe After Effects CS6. Jika Anda telah menginstal 
Creative Suite, Anda mungkin harus memilih Adobe After Effects dari dalam folder 
Creative Suite. 

2. Tutup jendela Welcome dan layar Tip of the Day jika tampil. Adobe After Effects 
CS6 telah siap untuk digunakan. 

Sistem Operasi Mac : 

1. Buka folder aplikasi, kemudian buka folder Adobe After Effects CS6. 

2. Double-click di icon Adobe After Effects CS6 aplikasi. 

3. Tutup jendela Welcome dan layar Tip of the Day jika tampil. Adobe After Effects 
CS6 telah siap untuk digunakan. 

 

 

Catatan : 

Menu dan perintah digambarkan di seluruh buku dengan menggunakan simbol 
lebih besar (>). Misalnya, perintah untuk menyimpan proyek akan diidentifikasi 
dengan File > Save. 

 

 



C. Menyetel Ulang Preferensi Adobe After Effects CS6 

Saat memulai Adobe After Effects, maka pengaturan tertentu bersama dengan 
konfigurasi ruang kerja yang terakhir kali Anda gunakan akan selalu menempel dalam 
ruang kerja After Effects. Penting bagi Anda untuk memulai setiap project menggunakan 
pengaturan default sehingga Anda tidak melihat hasil yang tidak diharapkan saat 
mencoba project dalam buku ini. Gunakan langkah-langkah berikut untuk mengatur 
ulang preferensi Adobe After Effects CS6 Anda. 

Langkah-langkah untuk mereset preferensi Adobe After Effects CS6 

1. Keluar dari After Effects. 

2. Cari dan ganti nama file Adobe After Effects 11.0 MC Prefs, dengan cara sebagai 
berikut. 

• Windows : Ganti nama Adobe After Effects 11.0 MC Prefs (misalnya menjadi 
Adobe Effects 11.0 MC Prefs-old) di Users/(user)/AppData/Roaming/Adobe/After 
Effects/11.0. 

• Mac OS : Ganti nama file Adobe After Effects 11.0 MC Prefs di 
Pengguna/(pengguna)/Library/Preferences/Adobe/After Effects/11.0 folder. 

3. Buka After Effects. Akan tampil preferensi baru. 

 
  



BAB I 

Mengenal Motion Graphic 

 
Bab ini memberikan gambaran umum tentang berbagai jenis grafis  gerak dan proyek video 
digital yang dapat Anda buat di After Effects. Itu diisi dengan informasi penting yang perlu 
Anda ketahui untuk bekerja secara efektif dalam aplikasi ini. Jika Anda tidak sabar untuk 
mulai menggunakan program ini, lewati bab ini sekarang dan lanjutkan ke Bab 2, 
“Memahami Antarmuka After Effects.”. Jika Anda melewati ini, pastikan Anda kembali untuk 
meninjau di bab ini nanti. 

Apa Yang Akan Anda Pelajari Dalam Bab Ini : 

• Jenis konten apa yang dapat Anda buat di After Effects. 
• Properti file video yang akan Anda buat dan impor After Effects. 
• Tentang berbagai standar siaran dan broadband yang dapat Anda buat untuk konten. 

Memulai 

Bab ini mencakup informasi latar belakang yang berguna. Jika Anda lebih memilih untuk 
langsung bekerja dengan After Effects, Anda harus pindah ke bab kedua, yang langsung 
membantu Anda. 

 

A. Mendefinisikan Motion Graphic 

Adobe After Effects adalah alat standar industri untuk membuat grafis gerak yang 
digunakan untuk siaran televisi, film, dan grafis  gerak serta produksi video lainnya. After 
Effects digunakan untuk membuat konten yang muncul dalam grafis  presentasi dan di 
perangkat seluler. Ini adalah alat untuk mendongeng, membuat grafis  gerak yang 
menarik secara visual yang terintegrasi ke dalam media apa pun untuk meningkatkan 
presentasi, cerita, gambar, atau suasana hati. 

 

B. Grafis  Televisi Dan Video 

After Effects adalah alat penting bagi para profesional desain siaran. Ini digunakan untuk 
membuat konten asli untuk pengantara, sepertiga bagian bawah, bumper, dan bukaan 
acara. Banyak profesional video menganggapnya sebagai alat penting dalam pekerjaan 
sehari-hari mereka. Bahkan, Anda dapat melihatnya di jaringan seperti MTV, Spike, 
truTV, dan Food Network, di mana ia digunakan untuk menghasilkan paket desain gerak 
dan grafis berkualitas tinggi yang menakjubkan dengan cepat dan terjangkau. 

 

C. Internet Dan Perangkat Seluler 

Internet dan perangkat seluler menjadi media hiburan utama. Grafis  gerak berkualitas 
tinggi After Effects banyak digunakan untuk konten online dan seluler. Situs berbagi 
video, seperti Vimeo.com dan YouTube.com, memberi pembuat konten akses ke 



khalayak luas, yang menciptakan peluang distribusi tambahan untuk individu dan 
organisasi. 

 

D. Distribusi Desktop Dan Grafis Presentasi 

Tampilan digital seperti televisi definisi tinggi, monitor, dan proyektor telah menciptakan 
tempat baru untuk menampilkan grafis  gerak. After Effects digunakan untuk 
menambahkan dampak pada slide, bagan, dan grafis  statis. Dengan proliferasi dan 
keterjangkauan televisi definisi tinggi dan tampilan digital lainnya, banyak tempat umum 
seperti: mal, toko ritel, sekolah, dan bahkan pangkalan militer menggunakan grafis  
gerak untuk menginformasikan dan menghibur. 

Terlepas dari bagaimana Anda berencana untuk menggunakan After Effects, Anda akan 
menemukannya sebagai alat yang kuat dan lengkap yang, dengan sedikit latihan, dapat 
membantu Anda dengan baik. 

 

E. Dasar-Dasar Video Digital 

Jika mau, Anda dapat membuka After Effects dan mulai membuat grafis  tanpa 
memahami cara kerja video. (Jika Anda benar-benar tidak sabar untuk memulai, 
lanjutkan ke Bab 2, “Memahami Antarmuka After Effects.”) Namun, berhasil 
menghasilkan grafis  untuk video dan media lain mengharuskan Anda berhasil 
menghasilkan grafis  untuk video dan media lain mengharuskan Anda memahami 
beberapa persyaratan teknis. Jika Anda tidak memahami ini, Anda hanya akan menekan 
tombol dan mengklik kotak centang, jadi Anda harus mengambil beberapa menit untuk 
setidaknya mendapatkan dasar dalam video digital. 

Saat bekerja di After Effects, Anda akan ingin mempertimbangkan tujuan akhir untuk 
proyek Anda. Apakah akan digunakan di televisi, di video, di perangkat seluler? 
Mengetahui informasi ini memungkinkan Anda membuat konten After Effects secara 
akurat agar sesuai dengan tujuan yang Anda tuju. Proyek untuk televisi definisi tinggi 
berbeda dengan proyek untuk perangkat portabel dengan layar kecil. Masing-masing 
media ini memiliki standar sendiri untuk item, seperti kecepatan bingkai, rasio aspek, 
dan kecepatan bit. Memahami barang-barang ini menghemat waktu dan tenaga Anda 
dalam proses produksi. 

1. Memahami Format Video 

Beberapa format video secara umum digunakan untuk produksi video profesional, 
sementara yang lain hanya cocok untuk keperluan internet atau layar kecil. Ada dua 
standar utama yang digunakan untuk siaran televisi, beberapa standar bersaing 
untuk desktop dan web video, dan serangkaian standar perangkat khusus yang 
digunakan dalam perangkat seluler. Standar teknis, seperti yang disinggung di sini, 
sangat kompleks, dan deskripsi lengkap masing-masing berada di luar cakupan buku 
ini. Secara umum, terlepas dari platform pembuatan konten video, ada tiga properti 
utama yang perlu diingat yaitu : 

a. Dimensi 



Properti ini menentukan dimensi pixel dari file video—jumlah pixel secara 
horizontal dan vertikal yang membentuk gambar atau frame video. Nilai ini 
biasanya ditulis sebagai pasangan angka yang dipisahkan oleh x, di mana angka 
pertama adalah nilai horizontal dan yang kedua mewakili nilai vertikal, seperti 
1920×1080. Istilah Pixel merupakan singkatan dari kata picture element yang 
merupakan komponen individu terkecil dalam sebuah citra digital. Apakah Anda 
berurusan dengan gambar diam atau bekerja dengan video frame tidak ada 
bedanya, semua yang ditampilkan di layar terdiri dari pixel. Dimensi file video 
atau gambar diam menentukan aspek rasionya, proporsi unit horizontal gambar 
dengan unit vertikalnya. Biasanya ditulis dalam format berikut: unit 
horizontal:unit vertikal, dua rasio aspek yang paling umum terlihat dalam 
tampilan video saat ini adalah 4:3 dan 16:9. 

b. Frame rate 

Properti ini menentukan jumlah gambar individual yang membentuk setiap detik 
video. Frame rate diukur sebagai nilai FPS, yang merupakan singkatan dari 
frames per second. 

c. Aspek Rasio Pixel 

Properti ini menentukan bentuk pixel yang membentuk gambar. Pixel adalah 
bagian terkecil dari gambar digital, dan tampilan pada perangkat yang berbeda 
seperti televisi dan monitor komputer memiliki pixel dengan proporsi horizontal 
dan vertikal yang berbeda. Saat memproduksi grafis  untuk siaran televisi, Anda 
harus menyesuaikan dengan serangkaian format dan standar tertentu. Misalnya, 
Anda perlu mengetahui apakah grafis  Anda akan ditampilkan pada layar high 
definition (1080i, 1080p, 720p), layar definisi standar, perangkat seluler, atau 
wilayah yang menyiarkan menggunakan standar ATSC (sering disebut NTSC) atau 
PAL karena hal ini memengaruhi dimensi, aspek rasio, frame rate, dan pixel yang 
digunakan. Jika memproduksi animasi atau video untuk Web, Anda harus 
mengetahui format yang akan digunakan website saat pendistribusian, apakah 
itu Flash, Silverlight, H.264, atau lainnya, karena efek video tertentu tidak 
berfungsi dengan baik saat diekspor ke format tertentu. 

2. ATSC 

Di Amerika Serikat, ATSC atau Advanced Television Systems Committee, telah 
mengeluarkan seperangkat standar untuk transmisi televisi digital. Standar ini telah 
menggantikan format NTSC (National Television Standards Committee) analog 
sebelumnya. Standar yang dianut oleh ATSC termasuk definisi standar dan resolusi 
tampilan HD (high definition), aspek rasio, dan frame rates. Semua siaran video dan 
grafis  harus sesuai dengan salah satu standar ATSC. Informasi tentang berbagai 
standar ATSC tersedia di situs web mereka di ATSC.org. 

3. Televisi High Definition 

Sementara teknologi televisi high definition (HD) telah ada selama beberapa dekade, 
baru pada awal abad ke-21 hal itu menjadi perhatian rata-rata pemirsa televisi 
Amerika. Istilah HD digunakan untuk menggambarkan video yang memiliki resolusi 
lebih tinggi daripada sistem televisi tradisional, yang disebut SD (standart definition). 
Ada dua standar high definition utama untuk siaran televisi—720p dan 1080i—



sementara banyak televisi, konsol game (Playstation 3, Xbox 360, dan lainnya) dan 
pemutar disk Blu-ray dapat mendukung yang ketiga, 1080p. Huruf p dan i mengacu 
pada format yang digunakan, apakah metode tampilan progresif atau interlaced. 
Interlacing membagi setiap frame progresif atau disebut dengan metode tampilan 
interlaced. Interlacing membagi setiap frame video menjadi dua bidang terpisah. 
Saat digabungkan, kedua bidang ini membentuk satu frame video yang menampilkan 
satu gambar. Tampilan progresif mengabaikan pembagian bidang dan menggunakan 
setiap frame sebagai gambar uniknya sendiri. 

Secara umum, tampilan progresif lebih jelas dan terdefinisi dengan lebih baik, 
sementara tampilan interlaced membutuhkan bandwidth siaran yang lebih sedikit 
untuk ditransmisikan ke pemirsa. Kamera vidio kekinian memberi kebebasan pada 
pengguna untuk memilih, apakah akan merekam dalam format progresif atau 
interlaced. 

4. 720p 

Format 720p memiliki resolusi lebar 1280 pixel dengan tinggi 720 pixel dan 
mendukung berbagai frame rates, dari 24 fps yang digunakan oleh film, hingga 30 fps 
yang merupakan bagian dari standar NTSC lama, hingga 60 fps. 

5. 1080p dan 1080i 

Format 1080 hadir dalam versi progresif dan interlaced dan, seperti standar digital 
modern lainnya, mereka mendukung berbagai frame rates antara 24 fps dan 30 fps. 

6. Televisi definisi standar 

Sebelum penemuan definisi tinggi, hanya ada satu standar di Amerika Serikat, NTSC 
(Komite Sistem Televisi Nasional), yang mencakup pengaturan untuk rasio aspek 4:3 
dan 16:9. Meskipun secara teknis telah digantikan oleh standar ATSC, istilah NTSC 
masih digunakan oleh sebagian besar kamera video dan aplikasi pengeditan dan 
grafis  ketika mengacu pada definisi standar, video kualitas siaran. 

Layar lebar NTSC dan NTSC: Aplikasi grafis  yang dirancang untuk menghasilkan 
konten untuk siaran, seperti Adobe After Effects, Adobe Photoshop, Adobe 
Illustrator, dan lainnya, menyertakan pengaturan pra-bangun untuk membuat 
proyek video yang disebut preset yang sesuai dengan standar siaran yang paling 
umum digunakan. Prasetel NTSC mencakup pengaturan untuk rasio aspek standar 
(4:3) dan layar lebar (16:9). Mereka menggunakan dimensi yang sama, 720 × 480, 
tetapi rasio aspek pixel yang berbeda, dan inilah yang menyebabkan perbedaan 
bentuknya. Perangkat yang memenuhi standar NTSC menggunakan frame rate 29,97 
frame per detik. 

7. PAL 

PAL, atau Phase Alternating Line, adalah standar untuk siaran televisi yang digunakan 
di seluruh Eropa dan sebagian besar di dunia di luar Amerika Utara. PAL berbeda dari 
NTSC dalam beberapa hal utama, termasuk dimensi dan frame rates. PAL 
menggunakan frame rates 25 fps, yang mendekati 24 fps yang digunakan dalam film 
dan, seperti NTSC, ia memiliki pengaturan tampilan layar standar dan layar lebar. 



PAL widescreen dan PAL: Dalam aplikasi seperti After Effects, prasetelnya telah 
menyertakan aspek rasio standar (4:3) dan layar lebar (16:9). Perbandingannya sama 
seperti NTSC, mereka menggunakan dimensi pixel yang sama, dalam hal ini 720 × 
576, tetapi masing-masing memiliki aspek rasio pixel yang berbeda. 

8. Video Web Dan Perangkat Seluler 

Tidak ada standar untuk video di Web atau perangkat seluler, meskipun ada 
beberapa format audio/video yang saling bersaing. QuickTime, Windows Media 
Video, Flash Video, Silverlight, dan H.264 adalah format video utama. Format 
QuickTime dikendalikan oleh Apple Inc., dan selama bertahun-tahun merupakan 
standar de facto untuk video yang dikirimkan melalui web. QuickTime Player yang 
tersedia secara bebas, kompatibel dengan Windows dan Mac OS dan digunakan 
untuk melihat QuickTime Movie (.MOV) dan format file video lainnya. Video format 
QuickTime juga didukung di beberapa perangkat seluler seperti, iPod dan iPad 
buatan Apple Inc. 

Windows Media Video, sering disebut WMV, adalah standar Microsoft yang dibuat 
oleh founder sistem operasi Windows. Variasi WMV digunakan untuk video 
Silverlight, yang banyak digunakan oleh banyak organisasi media profesional, 
termasuk NBC Sports untuk liputan Olimpiade langsung dan Netflix untuk streaming 
video. Windows Media juga merupakan format yang didukung pada beberapa 
multimedia player dan perangkat seluler, seperti ponsel Windows. 

Video flash adalah format video asli dari platform Adobe Flash, dan karena itu, 
digunakan untuk distribusi sebagian besar konten video online dunia. Meskipun 
Flash player banyak digunakan di komputer desktop pengguna Internet, diperangkat 
seluler tidak demikian. Faktanya, Adobe menghentikan pengembangan Flash Player 
selulernya dan merekomendasikan penggunaan teknologi HTML5 untuk perangkat 
seluler. Bahkan sebelum ini, beberapa organisasi, perusahaan, dan pembuat konten 
online lainnya, telah mulai memindahkan konten multimedia mereka dari Flash ke 
platform lain, seperti HTML5. Dalam beberapa tahun terakhir, dominasi video flash 
mendapatkan tantangan dari format video HTML5 yang didukung browser asli, 
H.264, dan OGG Theora. H.264 adalah standar untuk video kompresi yang berasal 
dari standar MPEG-4, dibuat dan dipatenkan oleh MPEG LA, sedangkan OGG Theora 
adalah open source alternatifnya. Perangkat seluler seperti Apple iPod, Sony PSP dan 
Microsoft Zune, dan beberapa yang sesuai dengan browser HTML5, mendukung 
variasi H.264, begitu juga dengan banyak ponsel dan aplikasi pemutaran video pihak 
ketiga, seperti QuickTime Player, Flash Player, dan VLC Media Player. 

 

F. Frame Rates dan Resolusi 

Video pada dasarnya adalah serangkaian gambar diam individu yang ditampilkan dengan 
sangat cepat, satu persatu. Frame rates video diukur dengan jumlah frame yang direkam 
atau diputar ulang setiap detik, disingkat fps (frame per second), yang berarti frame per 
detik. Standar video yang berbeda memiliki frame rates yang berbeda, dan banyak 
standar video mendukung berbagai frame rates yang berbeda. Sebagai perbandingan, 
televisi Amerika disiarkan pada 30 fps, PAL menggunakan 25 fps, dan film menggunakan 
frame rate 24 fps. 



Jika Anda memiliki latar belakang desain grafis, Anda mungkin akrab dengan istilah 
resolusi, yang mengacu pada kerapatan pixel atau jumlah pixel dalam ruang tertentu. 
Dengan demikian, di Amerika Utara, resolusi dilambangkan dalam pixel per inch atau ppi. 
Misalnya, gambar yang dibuat untuk dicetak di majalah berkualitas tinggi biasanya 300 
ppi, sedangkan gambar yang dibuat untuk digunakan di situs web biasanya memiliki 
resolusi 72 ppi. Saat bekerja dengan video, ppi tidak digunakan untuk mengatasi 
resolusi. Saat membahas video, istilah resolusi digunakan untuk merujuk pada dimensi 
pixel suatu gambar: jumlah pixel horizontal dan vertikal yang membentuk gambar 
sebenarnya. Saat membuat grafis untuk web, dimensi pixel ini menentukan ukuran 
relatif konten web dengan ukuran frame video secara keseluruhan. 

 

G. Memahami Transparansi 

Grafis yang digunakan dalam video dibuat menggunakan mode warna RGB. Setiap pixel 
individu diberi nilai warna unik yang terdiri dari kombinasi merah, hijau, dan biru. 
Masing-masing warna ini disimpan ke saluran warnanya sendiri. Ketika warna 
digabungkan, komposit (gambar penuh warna) dibuat. Selain saluran warna gambar, 
beberapa format juga dapat berisi saluran tambahan yang menyimpan informasi tentang 
area gambar yang transparan. Saluran ini disebut alpha channel. Jika menggunakan 
Photoshop, Anda mungkin sudah akrab dengan alpha channel, meskipun arti alpha 
channel dalam video agak berbeda. Di Photoshop, setiap seleksi yang tersimpan disebut 
alpha channel, dan Anda dapat memiliki hingga 99 alpha channel. 

Di After Effects, seperti dalam aplikasi lain yang dirancang untuk bekerja dengan video, 
istilah alpha channel merujuk secara khusus pada transparansi gambar diam atau file 
video. Alpha channel menggunakan 256 warna abu-abu untuk mewakili transparansi. 
Alpha channel di sebagian besar aplikasi, pixel hitam mewakili yang sepenuhnya 
transparan, pixel putih sepenuhnya pekat, dan pixel abu-abu mewakili area semi-
transparan. Hanya beberapa format gambar dan video yang mendukung penyimpanan 
alpha channel, dengan informasi gambar lainnya. Format file yang umum digunakan 
yang terdapat alpha channel adalah: Format File Gambar Tagged (.tiff), TARGA 
(Truevision Advanced Raster Graphics Adapter, .tga), QuickTime (.mov), dan Flash Video 
(.flv dan .f4v). Alpha channel secara otomatis dibuat untuk area transparan file asli 
Photoshop dan Illustrator saat diimpor ke After Effects. 

 

H. Belajar Mandiri 

Dalam bab ini, Anda telah mengetahui tentang beberapa detail teknis yang 
memengaruhi keputusan Anda saat membuat proyek dengan After Effects. Saat format 
video, gambar, dan audio baru telah dikembangkan, dan dukungan untuk itu telah 
ditambahkan ke After Effects, Anda juga harus memahami standar baru yang muncul. 
Sumber yang bagus untuk meningkatkan pengetahuan Anda tetap up to date, salah 
satunya adalah situs web Adobe (adobe.com) dan/atau forum 
(adobe.com/support/forums). Ada juga berbagai macam jurnal cetak dan online yang 
membahas semua aspek video dan desain. Selamat mengembangkan diri. 

  



BAB II 

Memahami USER INTERFACE After Effects 
 

Antarmuka After Effects mungkin tampak komplek bagi pengguna pemula. Dalam bab ini, 
Anda akan memperoleh pemahaman tentang elemen kunci antarmuka dan cara bekerja 
dengan berbagai panel aplikasi. 

Apa yang akan Anda pelajari dalam bab ini: 

• Bekerja dengan panel utama yang merupakan bagian integral penggunaan After Effects 
• Mempreview file rekaman dan lapisan komposisi 
• Menyesuaikan dan menyimpan tata letak panel yang disebut ruang kerja 

Sebelum melanjutkan ke bagian dalam user interface di after effects CS6, marilah lihat 
beberapa hal tentang alur kerja after effects. 

 

A. Overview Alur Kerja Umum Di After Effects 

Baik Anda menggunakan Adobe After Effects untuk menganimasikan judul sederhana, 
membuat grafis  gerak yang kompleks, atau efek visual komposit yang realistis, Anda 
bisaanya ikuti alur kerja dasar yang sama, meskipun Anda dapat mengulangi atau 
melewatkan beberapa langkah. Misalnya, Anda dapat mengulangi siklus memodifikasi 
properti layer, menganimasikan, dan mempreview hingga semuanya terlihat benar. 
Anda dapat melewati langkah mengimpor rekaman jika Anda ingin membuat elemen 
grafis seluruhnya di After Effect. 

1. Impor dan atur rekaman 

Setelah Anda membuat project, impor video hasil rekaman Anda ke dalam panel 
Project. After Effects secara otomatis menginterpretasikan banyak format media, 
tetapi Anda juga dapat menentukan bagaimana After Effects menginterpretasikan 
atribut seperti frame rates dan pixel aspek rasio. Anda dapat melihat masing-masing 
item di panel Footage dan atur waktu mulai dan berakhirnya agar sesuai dengan 
komposisi Anda.  

2. Membuat, mengatur, dan menggabungkan layer dalam komposisi 

Buat satu atau lebih komposisi. Setiap item footage dapat menjadi sumber untuk 
satu atau lebih layer dalam suatu komposisi. Anda dapat mengatur layer spasial di 
panel Komposisi atau mengaturnya dalam waktu menggunakan panel Timeline. Anda 
dapat menumpuk layer dalam dua dimensi atau mengaturnya dalam tiga dimensi. 
Anda dapat menggunakan mask, blending modes, dan keying tools untuk komposit 
(menggabungkan), gambar dari beberapa layer. Anda bahkan dapat menggunakan 
shape layer, text layer, dan brush tool untuk membuat elemen visual Anda sendiri. 
Transparansi, opacity, dan compositing. 

3. Modifikasi dan animasi properti layer  

Anda dapat memodifikasi properti layer apa pun, seperti ukuran, posisi, dan 
opasitas. Anda dapat membuat kombinasi layer properti apa pun yang berubah 



seiring waktu, menggunakan keyframe dan expressions. Gunakan pelacakan gerakan 
untuk menstabilkan gerakan atau untuk menganimasikan satu layer sehingga 
mengikuti gerakan di layer lain.  

4. Tambahkan efek dan ubah properti efek 

Anda dapat menambahkan kombinasi efek apa pun untuk mengubah tampilan atau 
suara  layer, dan bahkan menghasilkan elemen visual dari awal. Kamu bisa 
menerapkan salah satu dari ratusan efek, preset animasi, dan layer style. Anda 
bahkan dapat membuat dan menyimpan preset animasi Anda sendiri. Kamu bisa 
menganimasikan properti efek juga, yang merupakan layer properti dalam grup 
properti efek.  

5. Preview 

Menampilakan hasil komposisi pada monitor komputer atau monitor video eksternal 
cepat dan mudah, bahkan untuk proyek yang kompleks, terutama jika Anda 
menggunakan teknologi OpenGL untuk mempercepat preview. Anda dapat 
mengubah kecepatan dan kualitas preview dengan menentukan frame rates dan 
resolusinya, dan dengan membatasi area dan durasi komposisi yang Anda preview. 
Anda dapat menggunakan fitur manajemen warna untuk melihat preview bagaimana 
film Anda nantinya terlihat pada perangkat output lain.  

6. Render dan ekspor 

Tambahkan satu atau beberapa komposisi ke antrian render untuk rendering 
komposisi sesuai dengan pengaturan kualitas yang Anda pilih dan untuk membuat 
film dalam format yang Anda inginkan. Dalam beberapa kasus, Anda mengekspor 
menggunakan menu File > Ekspor atau Komposisi, bukan panel Render Queue.  

 

B. Membuka Project dan Komposisi Baru 

After Effects memiliki sembilan menu di Windows dan 10 di Mac OS, terletak di bagian 
atas jendela aplikasi yang digabungkan dengan berbagai panel untuk membentuk 
antarmuka program. Beberapa nama menu mungkin tidak asing bagi Anda dari aplikasi 
lain, sementara yang lain mungkin baru dan asing. Anda akan mulai dengan menu File 
untuk membuka proyek After Effects yang sudah ada. 

 
Gambar 2.1. Menu After Effects CS6 di Sistem Operasi Windows 

 

C. Membuka proyek After Effects yang sudah ada 

Membuka proyek di After Effects sama seperti membuka file di program perangkat 
lunak lain. Dalam latihan ini, Anda akan bekerja dengan proyek After Effects yang sudah 
ada untuk membantu Anda memahami organisasi dan struktur antarmuka, dan Anda 
akan segera membuat proyek Anda sendiri. 



1. Pilih File > Buka Proyek. Arahkan ke folder tempat file project yang akan dibuka, klik 
file yang kan dibuka, klik OK. Project akan terbuka dan beberapa komposisi yang 
telah Anda buat akan terbuka juga. 

 
Gambar 2.2. Susunan Antarmuka Terakhir Kali Digunakan Dan Disimpan. 

 

2. Pilih File > Save, ini akan menyimpan project yang telah terbuka dan sudah diedit di 
beberapa bagiannya. Anda dapat menggunakan perintah Save As, jika ingin 
menyimpan project ke file baru dengan nama yang berbeda. 

 

D. Versi Software After Effects 

File proyek After Effects tidak kompatibel dengan versi sebelumnya, dan file yang dibuat 
dalam versi aplikasi yang lebih baru tidak dapat dibuka menggunakan versi perangkat 
lunak yang lebih lama. Saat Anda membuka file proyek After Effects yang lebih lama 
dalam versi yang lebih baru, Anda menerima pesan peringatan dan Anda harus 
menggunakan perintah Save As untuk menyimpan file dalam format yang lebih baru. 
Setelah file dikonversi ke format file terbaru, Anda tidak dapat kembali menggunakan 
versi perangkat lunak yang lebih lama untuk pengeditan tambahan. Untuk alasan ini, jika 
beberapa orang sedang mengerjakan proyek After Effects, mereka memerlukan versi 
perangkat lunak yang sama. 

 

E. Memahami Sistem Panel After Effects 

Secara default, After Effects menggunakan antarmuka berbasis panel docked, untuk 
mengatur area kerja. Seluruh konfigurasi antarmuka disebut ruang kerja, dan After 
Effects menyertakan berbagai ruang kerja yang dibuat sebelumnya untuk 
mengakomodasi gaya kerja dan tugas yang berbeda yang mungkin perlu Anda 
selesaikan. Anda juga dapat mengatur setiap panel untuk bergerak atau melayang di 
atas panel lainnya, secara mandiri. 



 
Gambar 2.3. Default tampilan Standar ruang kerja After Effects. 

 

F. Panel After Effects 

Antarmuka After Effects dibagi menjadi beberapa panel, di mana Anda akan melakukan 
sebagian besar pekerjaan Anda. Beberapa panel untuk melihat cuplikan atau animasi, 
dan yang lain mengatur opsi untuk alat, sementara yang lain untuk membuat animasi. 
Semua panel di After Effects dapat diakses melalui menu Window.  

1. Komposisi 

Panel Komposisi adalah salah satu panel terpenting di After Effects. Ini adalah 
jendela preview dan ruang animasi utama tempat Anda bekerja saat membangun 
proyek After Effects. Anda dapat membuat proyek animasi Anda di panel ini, dan 
panel ini memiliki fitur yang dapat Anda gunakan untuk mengubah cara preview 
komposisi Anda. 

Mungkin Anda ingin membuat, menampilkan, atau menyembunyikan pedoman. 
Atau mungkin Anda perlu mengisolasi alpha channel komposisi Anda sehingga Anda 
dapat melihat area mana yang transparan dan mana yang pekat. Ini semua dapat 
dilakukan di panel Komposisi. Dalam latihan ini, Anda akan bekerja dengan panel 
Komposisi untuk mengubah resolusi preview tampilan dan mempelajari cara 
menampilkan saluran alfa komposisi. 

 



A. Rulers Composition. B. Flowchart Selector. C. Selector. D. Composition. E. Always 
Preview Toggle. F. Magnification. G. Guide & Grid Options. H. Toggle Mask & Shape Path 
Visibility. I. Current Time. J. Take Snapshot. K. Show Snapshot. L. Show Channel and Color 
Management Settings. M. Resolution. N. Region of Interest. O. Toggle Transparency Grid. 
P. 3D View Pop-up.Q. Select View Layout. R. Toggle Pixel Aspect Ratio Correction. S. Fast 
Previews. T. Timeline. U. Composition Flowchart. V. Reset Exposure. W. Adjust Exposure. 

 

a. Membuka project yang sudah dibuat, pada contoh project yang sudah memiliki 
komposisi, klik dua kali pada komposisi bernama Alpha Komposisi untuk 
mengaktifkannya. Ini membuat komposisi terlihat di panel Komposisi dan juga 
menampilkan timeline comp di Panel Timeline. 

 
Gambar 2.4. Panel Project 

 

Komposisi ini mencakup satu layer bernama Tulip.jpg. Itu dibuat dari dokumen 
Photoshop yang berisi area transparan. Warna yang dapat Anda lihat di dalam 
gambar adalah warna obyek dalam komposisi itu sendiri. Itu hanya terlihat di 
area di mana dokumen Photoshop transparan. Dalam program video, 
transparansi sering disebut sebagai Alpha, atau Alpha Channel. Anda dapat 
mengubah tampilan panel Komposisi untuk mengonfirmasi area mana yang 
transparan. 

b. Dengan komposisi Alpha aktif, klik tombol Show Channel and Color Management 
Settings yang terletak di bagian bawah panel Composition. Dari daftar yang 
muncul, pilih Alpha. Semua informasi warna RGB telah disembunyikan karena 
Anda hanya menampilkan saluran Alpha komposisi. Ini hanya menyisakan 
representasi hitam-putih dari comp. Saat melihat informasi alfa, area hitam 
mewakili bagian yang sepenuhnya transparan, sedangkan area putih sepenuhnya 
buram dan area abu-abu adalah semi-transparan.  

c. Sekarang setelah Anda melihat bahwa obyek gambar sebagian besar transparan, 
untuk kembali ke tampilan standar dengan mengklik tombol Show Channel and 
Color Management Settings dan memilih RGB dari daftar. 

 



 
Gambar 2.6. Alpha Channel dalam Komposisi 

 

d. Klik tombol Pop-up Resolution/Down Sample Factor di bagian bawah panel 
Komposisi dan pilih Quarter dari daftar yang muncul. Anda dapat menggunakan 
menu ini untuk memvariasikan kualitas preview panel Komposisi. Perhatikan 
bahwa ini hanya memengaruhi tampilan komposisi, bukan cara hasilnya saat 
Anda merender proyek. Pengambilan sampel turun mungkin diperlukan untuk 
membuat preview yang lebih lama dan lebih cepat saat Anda bekerja dengan 
komposisi rumit yang mungkin membutuhkan waktu lama untuk melihat 
preview. 

Perhatikan bahwa preview ini tampak jauh lebih berpiksel, atau kotak-kotak, 
daripada aslinya, yang ditampilkan dengan resolusi penuh. Pada pengaturan 
resolusi seperempat, program hanya merender setiap piksel keempat, lalu 
memperbesar hasilnya agar sesuai dengan panel Komposisi. Hal ini 
memungkinkan untuk membuat preview lebih cepat dan dapat berguna untuk 
meninjau animasi yang rumit. Resolusi yang diturunkan ini hanya untuk tujuan 
preview; itu tidak mempengaruhi kualitas hasil akhir saat Anda mengeluarkan file 
Anda. 

e. Klik tombol Popup Resolution/Down Sample Factor di bagian bawah panel 
Composition dan kali ini pilih Half. Kualitas gambar tampak lebih tinggi daripada 
saat dihasilkan dengan resolusi seperempat pada langkah sebelumnya. Ini karena 
sekarang merender setiap piksel lain untuk membuat pratinjau ini, menghasilkan 
kualitas pengaturan dua kali lipat dari pengaturan sebelumnya, yang 
mempratinjau setiap piksel keempat. 

f. Klik tombol Pop-up Resolution/Down Sample Factor untuk terakhir kalinya dan 
pilih Otomatis dari daftar yang muncul. Perhatikan bahwa menu sekarang 
menampilkan pengaturan Penuh, tetapi dikelilingi oleh tanda kurung. Tanda 
kurung menunjukkan bahwa tampilan saat ini menggunakan pengaturan 
Otomatis. Pengaturan Otomatis menyesuaikan resolusi panel Komposisi untuk 
merender hanya piksel yang diperlukan untuk mempratinjau komposisi pada 
tingkat zoom saat ini. 

 



 

Pengaturan Otomatis memberikan kualitas gambar terbaik, dan pada saat yang 
sama menghindari rendering piksel yang tidak perlu dengan secara aktif 
menyesuaikan pratinjau panel Komposisi berdasarkan persentase Zoom yang 
sedang Anda gunakan. Misalnya, jika Anda melihat comp pada 25%, pengaturan 
Otomatis akan mengatur faktor Resolusi ke Kuartal untuk mempertahankan 
sumber daya sistem dan memberikan pratinjau yang lebih cepat. 

 

g. Pilih File > Simpan, atau gunakan pintasan keyboard Ctrl+S (Windows) atau 
Command+S (Mac OS) di keyboard. Jangan tutup file ini, Anda akan 
membutuhkannya nanti dalam pelajaran. Anda harus segera melihat dua panel 
lain sebelum masuk ke latihan lain dalam pelajaran. 

 

G. Effect Controls 

Panel Effect Controls bukan bagian dari ruang kerja default, tetapi secara otomatis 
terungkap setiap kali Anda menambahkan efek ke lapisan dalam komposisi Anda. Itu 
juga dapat dibuka dari menu Window. 

Gunakan panel Kontrol Efek untuk mengedit efek yang telah Anda terapkan ke lapisan 
dalam Komposisi Anda. Meskipun panel ini bukan bagian dari ruang kerja Standar, Anda 
dapat mengaksesnya menggunakan menu Window dengan memilih Window > Effect 
Controls. Untuk mengakses efek yang telah Anda terapkan pada sebuah layer, Anda 
harus terlebih dahulu memilih layer tersebut dengan mengkliknya di panel Timeline atau 
Composition, atau dengan menggunakan pintasan keyboard. Nomor lapisan dalam 
komposisi aktif Anda sesuai dengan angka pada tombol angka jika Anda menggunakan 
keyboard ukuran penuh. Jika Anda tidak memiliki lapisan yang dipilih, atau jika lapisan 
yang dipilih tidak menerapkan efek apa pun, panel ini akan tetap kosong. Meskipun ini 
bukan bagian dari ruang kerja Standar, panel akan ditambahkan saat pertama kali Anda 
menerapkan Efek ke lapisan apa pun. 

 
Gambar 2.7. Panel Efek Control 

 

H. Flowchart 

Panel Flowchart menyediakan bagan organisasi, atau representasi grafis dari hubungan 
antara item komposisi dan rekaman dalam proyek After Effects Anda. Panel Flowchart 
adalah alat pasif yang menampilkan hubungan antar elemen dalam proyek Anda; Anda 
tidak dapat menggunakannya untuk mengubah hubungan tersebut. Panel ini berguna 



saat bekerja dengan animasi yang sangat kompleks yang mungkin berisi banyak nested 
composition. 

Untuk melihat bagan alur Komposisi, pertama-tama Anda harus memilih komposisi di 
panel Proyek atau menjadikannya Komp yang aktif di Timeline, lalu pilih Komposisi > 
Composition Flowchart. Anda tidak akan menggunakan panel diagram alir lengkap dalam 
buku ini, melainkan akan bekerja dengan fitur pendamping, tampilan Bagan Alir Mini, di 
BAB 7, “Bekerja dengan Audio,” saat Anda mulai bekerja dengan file audio.  

 
Gambar2.8. Panel Flowchart 

 

I. Footage 

Saat bekerja di After Effects, Anda akan menggunakan panel Footage untuk melihat 
pratinjau setiap potongan footage. Mengklik dua kali pada bagian mana pun dari media 
yang diimpor di panel Proyek Anda menyebabkannya dipratinjau di panel Footage. Anda 
juga dapat menggunakan menu tarik-turun di bagian atas panel untuk memilih cuplikan 
yang akan dipratinjau. 

Dalam latihan ini, Anda akan membuka panel footage untuk menggunakannya untuk 
melihat pratinjau file video yang diimpor. 

 
Gambar 2.9. Panel Footage Objek Video 



A. Always Preview Toggle. B. Magnification. C. Guide & Grid Options. D. Current Time. E. Take 
Snapshot. F. Show Snapshot. G. Show Channel and Color Management Settings. H. Region of 
Interest. I. Toggle Transparency Grid. J. Toggle Pixel Aspect Ratio Correction. K. Reset 
Exposure. L. Adjust Exposure. M. Set IN Point to Current Time. N. Set OUT Point to Current 
Time. O. Duration. P. Ripple Insert Edit. Q. Overlay Edit. R. Time Ruler. 

 

1. Dengan proyek yang terbuka, masukkan file format video di panel Project. Pada 
contoh project ini bernama Jejak Asap.avi. 

2. Klik dua kali file Jejak Asap.avi di panel Proyek. Ini akan membuka panel Footage 
yang memungkinkan Anda untuk melihat pratinjau klip video. 

3. Tekan spasi pada keyboard Anda untuk melihat file video ini. Setelah diputar satu 
kali, Anda dapat menekan bilah spasi lagi untuk menghentikan pemutaran. 
Perhatikan bahwa panel Footage memiliki banyak tombol dan menu yang sama yang 
ada di panel Composition. 

 

Anda juga dapat mengklik Penggaris Waktu untuk menghentikan pemutaran juga. 
Setelah berhenti, Anda dapat memindahkan Penanda Waktu, irisan kuning pada 
Time Ruler, mundur dan maju untuk melihat pratinjau animasi. 

 

4. Di panel Project, klik dua kali pada item footage bernama cloud-30586.mp4 untuk 
membukanya di panel footage. Atur ukuran video hingga pas (65%) dengan item 
rekaman di panel. Perhatikan bahwa Anda selalu dapat melihat item footage atau 
komposisi pada perbesaran lebih tinggi dari 100%; namun, bila dilihat pada nilai yang 
jauh lebih besar daripada ukuran sebenarnya (100%), footage dan komposisi 
cenderung tampak berpiksel dan terdegradasi. 

5. Klik tombol Show Channel and Color Management Settings yang terletak di bagian 
bawah panel Composition. Dari daftar yang muncul, pilih Alpha. 

6. Anda dapat melihat masing-masing saluran untuk item rekaman di panel dengan 
cara yang sama seperti saat mempratinjau komposisi. 

7. Kembali ke tampilan standar dengan mengklik tombol Show Channel and Color 
Management Settings dan memilih RGB dari daftar. 

8. Pilih File > Save, atau tekan Ctrl+S (Windows) atau Command+S (Mac OS) pada 
keyboard. 

  

J. Layer 

Setelah ditambahkan ke Komposisi di panel Timeline, item rekaman menjadi lapisan di 
dalam komposisi tersebut. Nyatanya, item apa pun yang ditambahkan ke Komposisi 
menjadi lapisan baru; ini dapat mencakup audio, video, teks, solid, lampu, kamera, dan 
lainnya. Salah satu aspek yang akan Anda gunakan saat bekerja di aplikasi ini adalah 
bahwa setiap item di panel Timeline adalah layer tersendiri. Mengklik dua kali layer 
rekaman di panel Komposisi akan membukanya di panel Layer. Lapisan footage berisi file 



yang telah diimpor ke panel Project, berlawanan dengan item yang dibuat di After 
Effects, seperti teks atau komposisi. Beberapa efek, seperti cat, pelacakan gerak, dan 
stabilisasi, tidak dapat diterapkan di jendela Komposisi tetapi harus diterapkan di panel 
Lapisan. Di sini, Anda akan menjelajahi panel Layer. Selanjutnya, Anda akan belajar cara 
melompat bolak-balik antara komposisi dan panel lapisan. 

 
Gambar 2.10. Ikon Perintah dalam Panel Layer 

 

A. Always Preview Toggle. B. Magnification. C. Guide & Grid Options. D. Current Time. E. Take 
Snapshot. F. Show Snapshot. G. Show Channel and Color Management Settings. H. Region of 
Interest. I. Toggle Transparency Grid. J. Toggle Pixel Aspect Ratio Correction. K. Comp Button. 
L. Reset Exposure. M. Adjust Exposure. N. Time Ruler. O. Choose Effect/Layer Controls to 
Edit. P. Show rendered result for current view. Q. Duration. R. Set OUT Point to Current Time. 
S. Set IN Point to Current Time. T. Alpha Boundary/Overlay Opacity. U. Alpha 
Boundary/Overlay Color. V. Toggle Alpha Overlay. W. Toggle Alpha Boundary. X. Toggle Alpha.  

1. Seperti panel Footage, panel Layer bukanlah bagian dari Standar ruang kerja, tetapi 
ditambahkan ke antarmuka saat Anda mengklik dua kali pada lapisan footage. Panel 
ini juga dapat dibuka dengan memilih Window > Layer. 

Perhatikan bahwa seperti di panel Footage, banyak tombol dan menu di sini serupa 
dengan yang ada di panel Komposisi. Dari panel Lapisan, Anda dapat mempratinjau 
alfa atau saluran warna lain dari suatu lapisan, atau menyesuaikan durasi lapisan. 

Mengklik dua kali layer footage akan membuka panel Layer. Namun, saat Anda 
mengklik dua kali layer teks, ini memungkinkan Anda untuk mengedit teks. Ketika 
kamu klik dua kali layer komposisi, itu akan menampilkan garis waktu komposisi di 
panel Timeline. 

2. Klik Tombol Comp ( ) di bagian bawah panel Layer untuk kembali ke komposisi 
yang berhubungan dengan layer ini. Ini mengungkapkan panel Komposisi dengan 
memindahkannya di depan panel Footage dan Layer di antarmuka. 



3. Pilih File > Save atau tekan Ctrl+S (Windows) atau Command+S (Mac OS) pada 
keyboard untuk menyimpan proyek. Jangan tutup file ini. 

 

K. Project 

Panel Proyek berisi referensi ke semua file rekaman (video, audio, dan gambar) yang 
telah Anda impor ke Proyek After Effects Anda. Itu juga berisi semua Komposisi yang 
telah Anda buat dalam proyek Anda saat ini. Item media dilambangkan sebagai referensi 
karena cara program memperlakukan file yang diimpor. Saat diimpor, file media Anda 
tetap berada di lokasi aslinya di hard drive Anda; After Effects membuat tautan ke 
mereka. Jika file-file ini dimodifikasi di luar After Effects, aplikasi akan menghasilkan 
pratinjau baru dan memperbarui proyek Anda sesuai dengan itu. Sistem penautan ini 
sangat membantu karena Anda masih dapat memanipulasi objek yang diimpor dalam 
program aslinya, seperti mengedit gambar di Photoshop. Meskipun sangat berguna, 
menautkan file dengan cara ini juga dapat menyebabkan masalah: jika Anda 
memindahkan, mengganti nama, atau menghapus file media asli Anda, After Effects 
akan kehilangan tautannya, dan konten tidak dapat ditampilkan. 

Saat bekerja dengan file media yang diimpor di After Effects, Anda harus selalu 
mengingat di mana file tersebut berada dan apa namanya, karena file proyek Anda harus 
dapat menemukan objek yang Anda impor untuk menampilkannya. 

 
A. Pratinjau gambar mini. B. Bidang teks pencarian. C. Kolom. D. Menafsirkan Footage. E. 
Buat folder baru. F. Buat Komposisi baru. G. Kedalaman warna. H. Hapus item proyek 
yang dipilih. 

 

1. Dengan proyek yang masih terbuka, pilih Window > Workspace > Setel ulang 
"Standar". Pilih Ya di kotak dialog konfirmasi yang muncul, untuk mengonfirmasi 
bahwa Anda ingin mereset ruang kerja Standar ke konfigurasi aslinya. 

2. Klik pada bagian mana pun dari panel Proyek untuk memilihnya dan menjadikannya 
sebagai panel aktif. Anda dapat mengetahui bahwa sebuah panel aktif ketika 
memiliki garis oranye di sekitarnya. Tekan tombol tilde (~) pada keyboard Anda. 
Tombol tilde berfungsi sebagai pengalih layar penuh, memperbesar panel aktif ke 
ukuran layar penuh atau mengembalikannya ke ukuran normal jika sudah 
diperbesar. 

3. Perhatikan bahwa setelah diperluas ke mode layar penuh, panel Proyek 



menampilkan beberapa kolom yang sebelumnya tersembunyi. Saat ini, item dalam 
panel dicantumkan dalam urutan abjad, namun hal ini dapat disesuaikan sehingga 
dicantumkan dalam hierarki yang ditentukan oleh salah satu kolom. 

Klik bilah judul untuk kolom Jenis dan perhatikan bahwa konten panel menyusun 
ulang sehingga jenis file serupa ditempatkan berdekatan satu sama lain. 

 
Gambar 2.12. Urutan Objek dalam Panel Project 

 

4. Sekali lagi tekan tombol tilde (~) pada keyboard Anda untuk mengembalikan panel 
Proyek ke ukuran normalnya di ruang kerja. 

Mengubah ukuran tampilan panel tidak memengaruhi proyek, jadi file tidak perlu 
disimpan lagi, tetapi biarkan file tetap terbuka karena Anda akan membutuhkannya 
lagi nanti dalam pelajaran ini. 

  

L. Render Queue 

Setelah Anda menyelesaikan animasi Anda, Anda menggunakan panel Render Queue 
untuk memproduksi, atau merender, proyek Anda untuk mengirimkannya ke hasil akhir. 
Apakah Anda memproduksi konten untuk siaran atau distribusi broadband, Render 
Queue adalah alat Anda untuk mengekspor. Anda dapat menggunakan panel ini untuk 
menambahkan beberapa komposisi, menyetel opsi render dan tujuan masing-masing, 
lalu merender komposisi secara berurutan. Dalam buku ini, Anda akan menggunakan 
Render Queue di Pelajaran 12, “Menghasilkan Proyek After Effects.” 

 
Gambar 2.13. Panel Render Queue 

 

Render Queue, bukan perintah File > Export, adalah cara Anda merender proyek Anda 
sebagai file video sehingga Anda dapat melihatnya atau membawanya ke aplikasi lain. 



M. Timeline 

Panel Timeline adalah salah satu panel utama yang digunakan untuk membuat animasi. 
Setiap komposisi memiliki panel Timeline independennya sendiri, di mana Anda dapat 
menganimasikan properti layer dan efek, memposisikan layer dalam waktu, dan 
mengubah mode pencampuran layer. 

Saat bekerja dengan lapisan dua dimensi, urutan susunan lapisan mengontrol lapisan 
mana yang muncul paling belakang, atau di belakang, lapisan lainnya. 

Indikator Waktu Saat Ini, juga disebut playhead, adalah garis vertikal merah yang tegak 
lurus dengan Penggaris Waktu. Ini menunjukkan bingkai saat ini yang sedang 
ditampilkan, bergerak saat animasi atau komposisi dimainkan. 

Tampilan default dari panel Timeline adalah mode layer bar. Ini menampilkan waktu 
komposisi sebagai Time Ruler di bagian atas panel, sedangkan nama layer dan properti 
ditampilkan di sebelah kiri. Mode bilah lapisan juga dapat dialihkan sehingga panel 
menampilkan Editor Grafik, alat canggih untuk animasi yang memungkinkan kontrol 
properti animasi yang lebih tepat. Di sini, Anda akan bekerja dengan Timeline. 

Anda akan menampilkan komposisi di panel Timeline dan Composition, dan mengubah 
susunan susunan layernya untuk mengubah seluruh tampilan komposisi. 

 
A. Waktu Saat Ini. B. Bidang Pencarian. C. Bagan Alir Mini Komposisi. D. Pembaruan 
Langsung. E. Mengaktifkan Draf 3D. F. Sembunyikan Lapisan "Malu". G. Mengaktifkan 
Pencampuran Bingkai. H. Mengaktifkan Motion Blur. I. Brainstorming. J. Bingkai kunci 
otomatis. K. Editor Graf. L. Indikator Waktu Saat Ini (playhead). 

 

N. Memahami Ruang Kerja 

Organisasi dan posisi semua panel di layar disebut ruang kerja. After Effects dilengkapi 
dengan serangkaian preset ruang kerja yang dapat Anda gunakan. After Effects 
menampilkan panel tertentu tergantung pada ruang kerja yang dipilih, dan diberi nama 
berdasarkan tugas umum yang mungkin perlu Anda lakukan. Beberapa ruang kerja 
default ini adalah: All Panels, Animation, Minimal, Motion Tracking, Paint, Standard, 
Text, and Undocked Panels. Saat Anda menjalankan After Effects untuk pertama kalinya, 
aplikasi menampilkan ruang kerja Standar. 

 

O. Melihat Dan Menyembunyikan Panel 

Untuk memodifikasi ruang kerja, Anda dapat membuka, menyembunyikan, 
memindahkan, mengubah ukuran, float, atau dock panel. Fungsionalitas ini membuat 



antarmuka After Effects dapat disesuaikan untuk memenuhi preferensi dan gaya kerja 
Anda. Setelah memutuskan panel mana yang ingin Anda tampilkan, tutup semua panel 
yang tidak Anda perlukan dan buka panel yang ingin Anda gunakan. Selanjutnya, Anda 
akan bekerja dengan berbagai panel aplikasi untuk menyesuaikan dan kemudian 
menyimpan ruang kerja kustom Anda sendiri. 

Anda tidak perlu membuka proyek untuk menyelesaikan bagian pembahaan ini. 
1. Pilih Window > Workspace > Animation untuk mengubah ruang kerja saat ini. Ruang 

kerja Animasi memiliki beberapa alat umum yang dapat Anda gunakan saat 
menganimasikan pekerjaan Anda, dan Anda dapat menyesuaikannya untuk 
memenuhi kebutuhan Anda. 

2. Jika belum aktif, klik tab panel Info untuk mengaktifkannya dan bawa ke depan grup 
panelnya. Klik X di bagian atas panel Info untuk menyembunyikannya. Ini membuat 
panel Audio aktif di grup ini. Klik ikon X untuk juga menutup panel Audio. 

3. Pilih Window > Align untuk membuka panel Align. Itu muncul di sudut kanan bawah 
antarmuka, tepat di bawah panel Efek & Preset. 

4. Klik ikon X di tab panel Efek & Preset untuk menutupnya. Hal ini menyebabkan panel 
Align bergeser. Selanjutnya, Anda akan mengonfigurasi ulang ruang kerja sehingga 
panel Align ditempatkan di area ruang kerja yang lebih nyaman. 

  

P. Docking Dan Undocking Panel 

Panel After Effects dilekatkan ke sisi jendela aplikasi dan panel lainnya. Ini menciptakan 
antarmuka yang sangat stabil dan saling bertautan yang dapat diskalakan agar sesuai 
dengan berbagai resolusi layar. Kadang-kadang, Anda mungkin menemukan bahwa 
konfigurasi dock default tidak sesuai. Dalam kasus seperti itu, Anda dapat mengubah 
default dengan memasang dan melepaskan panel agar sesuai dengan kebiasaan kerja 
Anda. Situasi di mana Anda mungkin perlu melepas panel atau beberapa panel dalam 
aplikasi adalah saat Anda bekerja dengan konfigurasi sistem yang menggunakan banyak 
monitor komputer. 
1. Klik tab di bagian atas panel Align. Tekan dan tahan tombol Ctrl (Windows) atau 

Command (Mac OS) pada keyboard sambil menyeret panel Align ke tengah layar. Ini 
menghapus panel dari antarmuka yang saling menempel, membuatnya menjadi 
panel yang tidak menempel, atau float. 

2. Klik tab nama panel Character dan seret panel ke arah panel Paragraph di sudut 
kanan bawah antarmuka Anda. Karena Anda tidak lagi menahan tombol Ctrl 
(Windows) atau Command (Mac OS), Anda akan melihat area abu-abu dan ungu 
muncul saat Anda menggerakkan panel di sekitar layar. Ini disebut Drop Zone, dan 
menyoroti area tempat yang Anda pilih untuk memasang panel. 

3. Jika Anda lepaskan pada panel Paragraph, maka panel Character akan diletakkan 
dismping kiri panel Paragraph. 



 
Gambar Drop Zone Panel Paragraph 

 

Q. Mengubah Ukuran Panel 

Selain menyembunyikan, membuka, menyambungkan, dan melepaskan panel, 
antarmuka After Effects memungkinkan Anda dengan mudah mengubah ukuran panel 
yang dipasangkan sehingga memakan lebih banyak atau lebih sedikit ruang pada 
tampilan. 

1. Tempatkan kursor pada garis pemisah vertikal abu-abu gelap antara panel Komposisi 
dan Proyek. Kursor berubah menjadi panah ganda, saat kursor diarahkan ke garis 
pemisah. 

2. Klik dan seret garis pemisah ke arah panel Proyek untuk memperbesar ukuran panel 
Komposisi. 

 
Gambar Pointer Mouse alam Tampilan Resize Panel 

 

3. Posisikan kursor pada garis pemisah horizontal berwarna abu-abu gelap antara panel 
Composition dan Timeline. Seret garis pemisah ke bawah untuk mengecilkan panel 
Timeline dan membuat panel Komposisi lebih besar. 

 

R. Menyimpan Ruang Kerja Kustom 

Anda dapat menyimpan modifikasi yang Anda buat pada ruang kerja dan menyimpannya 
sebagai ruang kerja baru yang sesuai. Ruang kerja kustom memungkinkan Anda hanya 
menampilkan panel yang Anda butuhkan. Di sini Anda akan menyimpan ruang kerja 
kustom tersebut. 

1. Pilih Window > Workspace > New Workspace untuk membuka kotak dialog New 



Workspace. 

2. Beri nama ruang kerja Anda Modif dan klik OK untuk menyimpannya. 

3. Pilih Window > Workspace. Anda sekarang melihat nama Modif di antara daftar 
ruang kerja yang tersedia. Selain itu, Anda harus mencatat bahwa saat ini ada tanda 
centang di sebelahnya yang menunjukkan bahwa itu adalah ruang kerja yang sedang 
aktif. 

4. Klik di bagian mana pun dari antarmuka After Effects untuk menutup menu Window 
tanpa mengubah ruang kerja. 

  

S. Mengatur Ulang Ruang Kerja 

Saat Anda membuat ruang kerja kustom, Anda sebenarnya mengubah konfigurasi ruang 
kerja tempat Anda memulai. Misalnya, dalam pelajaran sebelumnya Anda memulai di 
ruang kerja Animasi. Setelah menambahkan panel, melepas panel, dan menyimpan 
ruang kerja kustom, ruang kerja awal tidak secara otomatis diatur ulang kembali ke 
tampilan aslinya. Namun, Anda dapat dengan cepat kembali ke ruang kerja asli dan 
meresetnya ke konfigurasi default. 

1. Pilih Jendela > Ruang Kerja > Animasi untuk kembali ke ruang kerja Animasi. 
Perhatikan bahwa masih terlihat persis seperti ruang kerja Modifikasi-Animasi yang 
Anda buat di bagian pelajaran sebelumnya. 

2. Pilih Window > Workspace > Reset ‘Animation’ untuk membuka kotak dialog Reset. 

3. Konfirmasikan pengaturan ulang ruang kerja dengan mengklik Ya; ruang kerja 
Animasi diatur ulang ke tampilan aslinya. 

  



BAB III 

KOMPOSISI DAN LAYER 
 

A. Project, Composition, dan Layer 

File project adalah inti dari semua pekerjaan yang Anda lakukan di Adobe After Effects. 
File project berisi tautan ke semua media yang Anda gunakan dalam komposisi Anda 
serta komposisi itu sendiri. Meskipun sebuah project dapat berisi banyak elemen dan 
komposisi media yang berbeda, hanya satu project yang dapat dibuka pada satu waktu 
di After Effects. Anda dapat menganggap file project sebagai wadah, tas kerja untuk 
membawa konten animasi Anda. File project di After Effects disimpan sangat kecil 
karena media tidak disematkan atau ditambahkan ke file project. Alih-alih, file project 
berisi tautan atau referensi ke media apa pun (audio, video, atau gambar diam) yang 
Anda impor. Ini menciptakan situasi dimana project bergantung pada file media yang 
tetap tidak berubah dan di lokasi relatif yang sama di hard drive Anda. Jadi jika Anda 
memiliki situasi yang mengharuskan Anda memindahkan project dari satu komputer ke 
komputer lain, Anda tidak hanya harus memindahkan file project tetapi juga media asli 
yang disimpan di hard drive Anda. Namun, tidak setiap elemen yang akan Anda gunakan 
bersifat eksternal; komposisi, bentuk, lampu, kamera, dan konten lain yang Anda buat di 
After Effects disimpan sebagai bagian dari file project. 

Komposisi, sering disebut comps, adalah fitur unik dari After Effects, meskipun mirip 
dengan urutan, yang dapat ditemukan dalam program pengeditan video dan animasi 
seperti Adobe Premiere atau Apple Final Cut Pro. Mereka adalah salah satu fitur 
program utama yang akan Anda gunakan saat Anda mulai menguasai After Effects. 
Setiap komposisi—Anda dapat memiliki beberapa komposisi di setiap project—mewakili 
Garis Waktu independen dan dapat berisi kombinasi video, audio, gambar diam, layer 
bentuk, dan elemen lainnya. Komposisi bahkan dapat berisi komposisi lain (ini disebut 
komposisi bersarang), dan fitur ini adalah kunci untuk membuat animasi dan komposit 
yang lebih kompleks. Saat membuat komposisi, Anda ingin mengatur propertinya untuk 
format yang ingin Anda hasilkan. 

Jika Anda memiliki latar belakang pengeditan video, ini mungkin akan sangat 
bertentangan dengan apa yang telah diajarkan kepada Anda, tetapi sebenarnya ini 
adalah cara kerja standar di After Effects. Jadi jika Anda membuat grafik untuk televisi 
siaran definisi standar, Anda akan ingin membuat comps Anda dengan standar NTSC, 
dan jika Anda membuat grafik untuk ditampilkan di layar komputer, Anda akan ingin 
membuat comps yang sesuai dengan resolusi layar yang Anda harapkan. 

Jika Anda pernah menggunakan aplikasi grafis lain seperti Photoshop, Illustrator, atau 
Flash, layer mungkin merupakan konsep yang familiar bagi Anda. Jika Anda baru 
mengenal konsep layer, maka, seperti komposisi, itu adalah fitur After Effects yang akan 
Anda kenal lebih baik saat Anda mempelajari pelajaran dalam buku ini. Anda tidak dapat 
mengedit media dalam komposisi secara langsung; sebaliknya, setiap bagian dari media 
yang ditempatkan ke dalam komposisi ada di jalurnya sendiri, yang disebut layer. 

Setiap layer memiliki properti seperti posisi, opasitas, dan durasi yang dapat Anda 
sesuaikan satu per satu atau bersama-sama dengan layer lainnya. Selain properti 



bawaan layer yang dapat diedit, Anda memiliki kemampuan untuk menambahkan 
berbagai macam efek dari menu Efek ke layer apa pun, dan dengan memanipulasi 
properti layer dan efeknya Anda dapat membuat animasi Anda. 

  

B. Membuat Project Baru 

Secara teknis, setiap kali Anda membuka After Effects, program membuat project 
kosong baru untuk Anda. Sebuah project bukanlah hal yang sangat mengesankan; itu 
benar-benar hanya sebuah wadah yang menyimpan referensi ke file media yang Anda 
kerjakan, bersama dengan komposisi yang Anda buat dan konten asli apa pun, seperti 
kamera, lampu, dan bentuk. Satu project mungkin berisi tautan ke lusinan, mungkin 
ratusan file berbeda yang berada di hard drive Anda. 

1. Mengimpor File Media 

Salah satu kekuatan besar After Effects adalah beragam media yang dapat Anda 
gunakan dengannya. After Effects mendukung file gambar diam, audio, dan video 
format standar. Di bagian pelajaran ini, Anda akan membuat project After Effects 
baru dan belajar mengimpor dua jenis media yang sangat umum: audio dan video. 
Selain format umum seperti .tiff, .jpg, .aif, dan .mp3, program ini menawarkan 
dukungan yang ditingkatkan untuk format file asli tertentu seperti Photoshop (.psd) 
dan Illustrator (.ai). 

a. Buat project After Effects baru yang kosong dengan memilih File > New > New 
Project, dan setel ulang ruang kerja Anda ke tata letak standar dengan memilih 
Window > Workspace > Standard, lalu pilih Window > Workspace > Reset 
“Standard.” Klik Ya di kotak dialog yang meminta Anda mengonfirmasi bahwa 
Anda ingin mengatur ulang ruang kerja. 

b. Pilih File > Impor > File untuk membuka kotak dialog Impor File. 

c. Pilih file yang ingin dimasukkan ke project After Effects. 

 

Gambar 3.1. Open Foler pada Import File 

Ada banyak cara untuk membuka kotak dialog Import File. Anda dapat 
menggunakan pintasan keyboard, Ctrl+I (Windows) atau Command+I (Mac OS); 



Anda dapat mengeklik kanan di area kosong mana pun di panel Project dan 
memilih Impor > File dari menu konteks yang muncul; dan Anda dapat mengklik 
dua kali area kosong di panel Project untuk segera membuka kotak dialog. 

Secara default, After Effects menggunakan nama file dari item footage asli Anda 
di panel Project. Anda dapat mengubahnya dengan mengklik kanan item dan 
memilih Ganti nama dari menu. 

d. Panel Project adalah salah satu dari banyak panel yang harus berbagi ruang di 
layar, jadi setelah file video diimpor ke project Anda, mungkin sangat sulit untuk 
melihat apakah panel Project kecil. Untuk mengatasi masalah ini, After Effects 
menawarkan fungsi toggle yang memungkinkan Anda menyesuaikan panel apa 
pun dengan ukuran penuh layar. Klik pada panel Project untuk membuatnya 
aktif. Panel menampilkan sorotan oranye di sekitarnya saat aktif. Tekan tombol 
tilde (~) pada keyboard Anda untuk memperbesar panel ke ukuran layar penuh. 

Tekan tombol tilde (~) untuk memperbesar panel yang sedang aktif ke layar 
penuh. Tekan lagi untuk kembali ke tata letak panel normal. Tekan lagi tombol 
tilde (~) saat Anda ingin kembali ke ruang kerja standar. 

e. Simpan Project setelah memasukkan footage atau imort file. Perintah keyboard 
untuk fungsi Simpan adalah Ctrl+S (Windows) atau Command+S (Mac OS). 

2. Menemukan File Yang Hilang 

Saat Anda mengimpor file, After Effects membuat tautan ke file media asli di hard 
drive Anda. Tautan ini adalah apa yang Anda lihat di panel Proyek. File-file ini 
ditautkan dan sebenarnya bukan bagian dari proyek itu sendiri. Jika terjadi sesuatu 
pada file asli, yaitu dihapus, dipindahkan, atau diganti namanya, ini akan 
menimbulkan masalah. 

Saat Anda mencoba membuka proyek, After Effects memeriksa tautan media untuk 
memastikan semuanya masih utuh, dan jika menemui masalah akan menampilkan 
dialog peringatan yang memberi tahu Anda berapa banyak file yang saat ini hilang. 
Jumlah file yang hilang akan bervariasi tergantung pada proyek yang Anda coba 
buka. 

 

Gambar 3.2. Missing File Footage Saat Imort File 

 

Untuk memperbaiki masalah ini, Anda harus menautkan kembali rekaman yang 
hilang dengan mengganti rekaman asli yang ditautkan dengan rekaman itu sendiri. 
Untuk menemukan file Anda yang hilang: 

a. Klik OK untuk menutup dialog peringatan awal. 



b. Temukan salah satu item footage yang hilang di panel Project. Mereka akan 
mudah diidentifikasi dengan ikon Color Bar di sebelah kiri nama footage. 

c. Klik kanan pada item footage yang hilang dan dari menu yang muncul, pilih 
Replace Footage > File. 

d. Saat kotak dialog Replace Footage File muncul, arahkan ke folder yang berisi file 
yang hilang yang sesuai dengan item footage ini. Nama file harus terlihat di bilah 
judul kotak dialog. 

e. Sorot file yang hilang dan klik Buka. Setelah jeda singkat saat komputer Anda 
menganalisis konten folder dan menautkan kembali file yang hilang yang 
ditemukannya di sini, dialog konfirmasi akan muncul yang memberi tahu Anda 
bahwa file yang hilang sebelumnya telah ditemukan. 

Jumlah file yang dipulihkan akan bervariasi tergantung pada jumlah item yang 
hilang yang dapat ditemukan oleh After Effects. 

f. Klik OK untuk menutup kotak dialog ini. 

Jika semua file Anda masih memiliki nama yang sama dan berada di lokasi folder 
relatif yang sama seperti saat diimpor, operasi penggantian yang satu ini akan 
menemukan semua item footage Anda yang hilang. Jika tidak, Anda harus 
mengulangi proses ini beberapa kali untuk menemukan semua file yang hilang. 
Secara umum, jauh lebih mudah ditemukan file media Anda yang hilang saat 
dipindahkan dan tidak diganti namanya. Jika item rekaman Anda telah dihapus, tidak 
ada yang dapat dilakukan After Effects untuk membantu Anda. Satu-satunya 
tindakan Anda adalah membuat ulang atau memulihkan item dari salinan cadangan 
hard drive atau file media Anda. 

3. Mengganti Nama File 

Mengganti nama file di After Effects sedikit berbeda dari program lain yang mungkin 
biasa Anda gunakan. Di sebagian besar program, Anda cukup mengeklik file yang 
disorot untuk mengganti namanya. Mencoba pendekatan ini di After Effects tidak 
berhasil. Di sini Anda akan mengubah nama file Washington City Street.jpg. 

a. Dengan panel Proyek disorot, klik tombol tilde (~) pada keyboard Anda untuk 
memaksimalkannya ke ukuran layar penuh. Kemudian klik file bernama 
Washington City Street.jpg untuk menyorotnya. 

b. Tekan tombol Enter (Windows) atau Return (Mac OS) pada keyboard Anda. 
Nama file menjadi dapat diedit. 

c. Ubah nama file dengan menempatkan kursor Anda di akhir kata Street dan 
menambahkan -daytime di akhir sehingga sekarang terbaca sebagai Washington 
City Street-dayday.jpg, lalu tekan Enter/Return untuk menyelesaikan pengeditan 
teks dan melakukan perubahan. 



 

Gambar 3.3. Mengganti Nama File dalam Project 

 

Mengubah nama file di panel Project tidak memengaruhi file sebenarnya di 
komputer Anda. Seperti semua program pengeditan video, After Effects memiliki 
alur kerja yang tidak merusak. Tidak ada yang Anda lakukan di After Effects 
mengubah file asli di hard drive Anda. Satu-satunya pengecualian untuk ini 
adalah saat Anda menggunakan perintah Edit Asli, yang dirancang untuk 
membuka file sumber asli yang Anda impor di aplikasi pengeditan eksternal 
seperti Photoshop dan Illustrator. 

d. Tekan tombol tilde pada keyboard Anda untuk meminimalkan panel Proyek dan 
kembali ke ruang kerja Standar. 

e. Simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl+S 
(Windows) atau Command+S (Mac OS) pada keyboard. 

4. Mengatur Panel Project 

Anda tidak dapat menyimpan panel project Anda dalam ukuran layar penuh 
sepanjang waktu, atau Anda tidak akan pernah bisa menyelesaikan pekerjaan apa 
pun. Dan bahkan dengan panel Project sebesar ini, mungkin masih memerlukan 
beberapa modifikasi agar Anda dapat bekerja lebih efisien. Secara default, panel 
menampilkan semua file yang diimpor dalam urutan abjad, tetapi ini seringkali bukan 
pendekatan terbaik untuk mengatur media Anda. Yang ingin Anda lakukan adalah 
membuatnya semudah mungkin untuk menemukan media yang Anda perlukan tepat 
saat Anda perlu menggunakannya. Untuk melakukannya, Anda akan menyesuaikan 
tampilan panel Project. 

Saat Anda bekerja di After Effects, Anda pasti akan membuka dan menutup banyak 
panel, tergantung pada jenis pekerjaan yang Anda lakukan. Namun, saat 
mengerjakan proyek dalam buku ini, penting untuk memiliki antarmuka yang sesuai 
dengan pelajaran. Untuk tujuan ini, Anda harus selalu mengatur ulang ruang kerja 
Anda ke konfigurasi Standar prasetel. Di After Effects CS6, pilih Window > Workspace 
> Standard untuk mengubah konfigurasi tampilan ruang kerja Anda saat ini. 

  

C. Memahami Alur Kerja Animasi 

Saat bekerja di After Effects, penting untuk dipahami bahwa program ini bisaanya 
digunakan untuk menganimasikan atau menggabungkan aset yang dibuat di aplikasi lain. 
Aman untuk mengatakan bahwa sebagian besar pengguna After Effects profesional 
seringkali adalah pengguna ahli, dari program grafis dan desain lainnya. Mereka sering 
menggunakan Adobe Photoshop, dan terkadang Illustrator, bersama dengan berbagai 



paket yang dapat membuat grafik 3D seperti 3D Studio Max, Maya, atau Cinema 4D 
untuk membuat media yang akan mereka gunakan di After Effects. 

Untuk mempercepat proses pembelajaran, banyak pelajaran dalam buku ini yang Anda 
mulai dengan proyek yang dibuat sendiri dan berkelanjutan untuk pembehasan 
selanjutnya. Pelajaran ini akan sedikit berbeda, karena akan membawa Anda melalui 
seluruh alur kerja, mulai dari membuat komposisi, hingga mengimpor berbagai konten 
media, dan terakhir melalui proses animasi dan preview. Dalam pelajaran ini, Anda akan 
bekerja dengan berbagai aset media untuk menghasilkan animasi dan efek untuk 
kebutuhan film. 

  

D. Membuat Dan Bekerja Dengan Komposisi 

Di Adobe After Effects, komposisi adalah tempat Anda melakukan semua pekerjaan 
animasi dan komposisi. Di dalam sebuah komposisi, setiap bagian dari media berada 
pada layernya masing-masing. Pikirkan setiap komposisi sebagai Timeline independen 
dalam proyek Anda. Selain berbagai macam rekaman yang Anda impor ke After Effects, 
komposisi juga dapat berisi komposisi lain, memungkinkan lingkungan desain yang 
terorganisir dan proyek animasi yang sangat kompleks. Menempatkan satu komposisi di 
dalam yang lain disebut komposisi bersarang, dan Anda akan mempelajarinya lebih 
lanjut dalam pelajaran ini. Pada pelajaran bagian pertama ini, Anda akan membuat 
komposisi awal untuk menampung objek gambar dan animasi yang akan Anda buat. 

1. Membuat Komposisi Baru 

Seperti disebutkan sebelumnya, proyek itu sendiri benar-benar tidak memiliki 
properti yang dapat diedit; dalam komposisi Anda mengatur segalanya mulai dari 
kecepatan bingkai hingga dimensi piksel hingga rasio aspek. Komposisi dapat diimpor 
dari proyek After Effects lainnya, dibuat secara otomatis saat Anda mengimpor file 
Photoshop atau Illustrator berlapis, atau dibuat dari awal seperti yang akan Anda 
lakukan di sini. 

a. Pilih Komposisi > Komposisi Baru dari menu di bagian atas antarmuka After 
Effects untuk membuka kotak dialog Pengaturan Komposisi. Anda juga dapat 
menggunakan pintasan keyboard, Ctrl+N (Windows) atau Command+N (Mac OS). 

b. Di kotak dialog, ubah nama komposisi default menjadi Vehicle. Dari menu drop-
down Preset, Custom. Memilih preset Custom berarti menentukan sendiri Width, 
Height, Pixel Aspect Ratio, dan Frame Rate. 

 
Gambar 3.4. Setting Custom untuk Composition Baru 



c. Tentukan nilai Resolution diatur Full 

d. Ubah Duration menjadi 0;00;30;00 (30 detik). 

e. Klik kotak Background Color untuk membuka kotak dialog Warna Latar Belakang. 
Saat muncul, perhatikan bahwa Color Picker di kotak dialog memungkinkan Anda 
memasukkan nilai numerik untuk warna menggunakan nilai HSB (Hue, 
Saturation, Brightness), RGB (Red, Green, Blue), dan heksadesimal. 

f. Klik pada nilai R (Merah) dan ketik 141. Ulangi ini untuk nilai G (Hijau) dan B 
(Biru) juga. Ini menghasilkan warna latar abu-abu muda. 

 
Gambar 3.5. Kotak Dialog Background Color 

 

g. Klik OK di kotak dialog Background Color untuk kembali ke kotak dialog 
Composition Settings, lalu klik OK lagi di kotak dialog untuk menambahkan comp 
baru ke proyek Anda. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

2. Memahami Pengaturan Komposisi 

Kotak dialog Pengaturan Komposisi memungkinkan Anda mengatur dan mengedit 
properti komposisi Anda. Kotak dialog terbuka secara otomatis saat Anda membuat 
komposisi baru dan dapat dibuka secara manual dengan memilih komposisi dan 
memilih Komposisi > Pengaturan Komposisi atau dengan menekan Ctrl+K (Windows) 
atau Command+K (Mac OS). Kotak dialog dibagi menjadi dua bagian, untuk 
pengaturan dasar dan lanjutan. 

a. Basic Setting 

 
Gambar 3.6. Basic Composition Setting 



Keterangan Gambar : 

A. Preset : Proyek video bisaanya harus sesuai dengan standar 
yang ditetapkan seperti NTSC atau PAL. Menu preset 
berisi berbagai pengaturan komposisi prebuilt agar 
sesuai dengan standar yang paling umum digunakan. 
Karena sebagian besar proyek video akan cocok dengan 
salah satu standar video yang ditetapkan, cara paling 
efisien untuk memulai adalah dengan memilih prasetel 
dari menu drop-down dan kemudian memodifikasi 
properti apa pun yang tidak sesuai dengan proyek 
khusus Anda. Di sebelah kanan menu ada dua tombol: 
satu untuk menyimpan prasetel khusus dan satu lagi 
untuk menghapusnya. 

B. Width dan Height : Pengaturan ini menentukan dimensi fisik, dalam piksel, 
komputer Anda. Ini sebanding dengan ukuran dokumen 
di aplikasi lain. 

C. Pixel Aspect Ratio : Pengaturan ini menentukan bentuk piksel di komputer 
Anda. Standar video yang berbeda menggunakan rasio 
aspek piksel yang berbeda untuk menampilkan konten. 
Rasio aspek piksel yang salah akan menyebabkan karya 
Anda tampak terdistorsi. Preset yang Anda pilih 
bisaanya menetapkan properti ini untuk Anda. 

D. Frame Rate : Pengaturan ini menentukan jumlah bingkai per detik 
(fps) yang menyusun komposisi Anda. 

E. Timebase : Pengaturan ini menentukan apakah Composition baru 
akan menggunakan timebase drop-frame atau non-
drop-frame. 

F. Resolution : Pengaturan ini menentukan kualitas tampilan panel 
Komposisi. Nilai yang lebih rendah membutuhkan lebih 
sedikit RAM untuk melihat preview. 

G. Start Timecode : Pengaturan ini menentukan nilai kode waktu di awal, 
atau asal, Timeline. Standar After Effects adalah 
00;00;00;00 tetapi jika mengekspor animasi Anda ke 
kaset video untuk disiarkan, sebagian besar stasiun 
memerlukan asal kode waktu diatur ke 01;00;00;00 (1 
jam). 

H. Duration : Pengaturan ini menentukan panjang Timeline 
komposisi. 

I. Background Color : Pengaturan ini menentukan warna latar belakang untuk 
komposisi. 

 

 



b. Advanced Setting 

 
Gambar 3.7. Advanced Setting pada Composition 

 

Keterangan Gambar : 

A. Anchor : Pengaturan ini tidak dapat diedit saat membuat comp 
baru, hanya saat mengedit pengaturan yang sudah ada. 
Jika Anda memperbesar atau memperkecil dimensi 
fisiknya, pengaturan jangkar menentukan bagaimana 
hasil transformasi dengan mengunci area tertentu pada 
tempatnya. 

B. Rendering Plug-in : Pengaturan ini menentukan mesin yang akan digunakan 
untuk merender layer 3D. Pengaturan ini 
memungkinkan Anda memilih antara 3D Klasik dan 3D 
Raytraced. Mesin raytracing baru di After Effects CS6 
memungkinkan Anda untuk membuat layer teks dan 
bentuk yang diekstrusi, dan menyediakan tampilan 
berkualitas lebih tinggi untuk konten 3D. 

C. Preserve frame rate when nested or in Render Queue : 

Pengaturan ini menentukan apakah laju bingkai comp dipertahankan atau 
dikonversi saat Anda menempatkannya di dalam komposisi lain. 

D. Preserve resolution when nested : 

Pengaturan ini menentukan apakah pengaturan resolusi comp dipertahankan 
atau dikonversi saat Anda menempatkannya di dalam komposisi lain. 

E. Motion Blur : Pengaturan ini menentukan kekuatan efek Motion Blur 
saat diaktifkan untuk layer. Menggunakan Motion Blur 
dibahas lebih mendetail nanti dalam pelajaran ini. 

 



E. Bekerja Dengan Layer 

Jika Anda sudah familiar dengan program grafik seperti Adobe Photoshop dan Illustrator, 
maka Anda mungkin sudah familiar dengan konsep umum penggunaan layer, meskipun 
di sini cara kerjanya sedikit berbeda. Di After Effects, setiap rekaman yang Anda 
tempatkan dalam komposisi berada pada layer yang terpisah dan individual. Layer ini 
terlihat di panel Timeline dan setiap layer berisi propertinya sendiri yang dapat 
dimanipulasi atau dianimasikan secara terpisah dari yang lain. 

Sekarang setelah Anda membuat komposisi utama dan mengimpor aset media yang 
akan Anda gunakan, saatnya untuk menangani bekerja dengan panel Layer. Di bagian 
pelajaran ini, Anda akan menambahkan media ke timeline dan bekerja dengan layer 
footage yang dibuat untuk mengatur tata letak komposisi Anda. 

1. Setelah Anda membuat project baru dan composition baru, maka akan tampil 
komposisi dengan nama vehicle. 

2. Masukkan dalam project baru tersebut dengan file (footage) yang dibutuhkan dalam 
project dengan klik kanan pada panel Project > klik Import > klik File. Klik file yang 
sudah disiapkan, klik Open. Jika file footage telah diorganisir dalam satu forder, klik 
folder, klik Import Folder 

 
Gambar 3.8. Import File Window 

 

Penting untuk dicatat bahwa ketika Anda mengklik dua kali pada sebuah komposisi, 
itu akan dipreview di panel Komposisi dan Timeline secara bersamaan. Namun, cara 
previewnya sedikit berbeda. Hanya ada satu panel Komposisi secara default, jadi 
mengklik dua kali pada comp membuatnya aktif di jendela dan menyembunyikan 
mana saja yang mungkin telah terlihat sebelumnya. Namun, panel Timeline berbasis 
tab (seperti browser Internet Anda), sehingga Anda dapat melihat beberapa tab 
comp sekaligus. Akibatnya, mengklik dua kali pada comp di panel Project hanya akan 
membawa tabnya ke depan dan membuatnya aktif. 



 
Gambar 3.9. File Footage yang Telah di Import 

 

File footage dapat dimasukkan dari folder yang sama atau dari folder yang berbeda. 
Gunakan perintah import untuk memasukkan file footage dari folder yang berbeda 
beberapa kali sehingga file footage masuk semua dalam projects. 

3. Di panel Proyek, klik dan tahan pada file Antah Berantah.jpg untuk memilihnya, dan 
seret ke Timeline vehicle comp. 

4. Saat file telah berada dalam area Timeline comp, lepaskan tombol mouse Anda. File  
ditambahkan ke Timeline, dan gambar akan terlihat di panel Composition. 

 
Gambar 3.10. Memasukkan Footage dalam Timeline 

 

5. Sekali lagi, di panel Project, klik pada file Cloud.png, lalu seret dan jatuhkan di bawah 
layer Antah Berantah.jpg pada vehicle Timeline. 

 
Gambar 3.11. Penambahan Footage dalam Timeline 



 

Jika Anda melihat panel Composition, Anda tidak menemukan gambar Cloud.png, ini 
karena gambar dari footage Antah Berantah ada di depannya. Anda akan 
memperbaiki ini di latihan berikutnya. 

6. Simpan file Anda dengan memilih File > Save. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

 

F. Memahami Berbagai Jenis Layer 

Di After Effects, footage yang Anda impor ditambahkan ke layer saat Anda 
menempatkannya ke dalam komposisi, tetapi bagaimana dengan objek lain, seperti 
lampu, camera, atau bentuk lainnya? Mereka juga berupa layer; sebenarnya, selain layer 
standar yang akan Anda buat dari konten bisa diimpor, seperti video, gambar, dan audio, 
ada jenis layer lain yang dapat dibuat sepenuhnya di dalam After Effects: 

Layer Text, dapat dianimasikan menggunakan properti transformasi layer standar 
(seperti posisi atau rotasi). Selain itu, layer teks memiliki properti unik (disebut animator 
teks) yang memberi Anda lebih banyak kontrol atas teks. Contoh saat Anda akan 
menggunakan animator teks adalah jika Anda ingin memutar setiap karakter dalam 
sebuah kata. Layer teks sering digunakan untuk membuat kredit, sepertiga bagian 
bawah, atau efek tipografi kinetik. 

Layer solid, juga disebut layer padat adalah layer warna tunggal yang dibuat langsung di 
After Effects. Mereka sering digunakan sebagai bidang warna, bentuk persegi panjang, 
atau untuk efek yang dihasilkan secara internal di dalam After Effects, seperti efek petir, 
atau efek sinar . 

 
Gambar 3.12. Tampilan Setelah Klik Kanan dalam Timeline 

 

Layer Light, digunakan untuk menerangi layer 3D dan menghasilkan bayangan. Sebagai 
alat estetika, lampu digunakan untuk meningkatkan kesan kedalaman dan volume dalam 
sebuah pemandangan. 

Layer Camera, dirancang untuk mensimulasikan kinerja dan perilaku camera video 
dalam kehidupan nyata, dan dapat digeser, dimiringkan, dan dipindahkan untuk 
menciptakan kesan pergerakan melalui ruang. 

Layer Null Object, adalah layer tak terlihat (yang terlihat di panel komposisi dan 



timeline, tetapi tidak dirender) yang memiliki semua properti transformasi dari layer lain 
yang terlihat. Mereka berguna sebagai objek pembantu, mereka meminta Anda untuk 
mengasuh properti dari satu layer ke layer lainnya, dan sering digunakan sebagai objek 
pengontrol untuk camera dan layer tiga dimensi. 

Layer Shape, adalah objek bentuk vektor yang dibuat dengan alat bentuk (persegi 
panjang, elips, poligon, dll.) di After Effects. Mirip dengan teks dan layer padat, keduanya 
memiliki properti transformasi layer dan properti bentuk khusus hanya untuk layer 
bentuk. 

Layer Adjustment, adalah layer tak terlihat yang dapat menjadi target efek, yang mirip 
dengan layer penyesuaian di Photoshop. Mereka digunakan ketika Anda ingin 
menerapkan efek tertentu atau serangkaian efek ke beberapa layer secara bersamaan. 
Karena setiap layer di bawah layer penyesuaian yang ditargetkan akan ditampilkan 
seolah-olah efek diterapkan padanya, ini menghindari masalah karena harus 
menerapkan efek yang sama beberapa kali. 

 

G. Memahami Switch Layer 

Jika Anda telah bekerja dengan program desain atau grafik sebelum menggunakan After 
Effects, maka gagasan memiliki sakelar untuk menyembunyikan atau mengunci layer 
bukanlah hal baru bagi Anda. Namun selain kontrol standar ini, area Layer Timeline berisi 
beberapa sakelar khusus lainnya yang digunakan untuk mengaktifkan atau 
menonaktifkan berbagai fitur layer. Selain dapat menampilkan, menyembunyikan, dan 
mengunci layer, Anda dapat melakukan solo, pemalu, atau mengaktifkan fitur seperti 
motion blur atau frame blending. Jika istilah tersebut baru bagi Anda, bagian ini akan 
membantu Anda memahaminya. Setiap sakelar layer sesuai dengan label di atasnya yang 
merinci nama dan penggunaannya. 

 
Gambar 3.13. Switch Layer 

 

A. Video On/Off : Klik sakelar ini untuk mengalihkan visibilitas video pada layer. 
Sakelar ini hanya tersedia saat bekerja dengan layer yang 
berisi video; jika tidak, ruang kosong. Di After Effects, 
pengaturan ini berlaku untuk gambar diam dan video 
sebenarnya. Saat trek video layer dinonaktifkan, itu tidak 
dipreview di panel Komposisi dan tidak disertakan saat Anda 
merender komposisi untuk hasil akhir. 



B. Audio On/Off : Klik sakelar ini untuk membisukan audio layer. Sakelar ini 
hanya tersedia saat bekerja dengan layer yang berisi audio. 
Dalam hal ini, audio dapat berada di layernya sendiri, seperti 
saat Anda menambahkan file MP3, WAV, atau AIFF ke 
komposisi, atau disematkan dalam file video. Saat Anda 
menonaktifkan trek audio layer, itu tidak dipreview di panel 
Komposisi dan tidak disertakan saat Anda merender komposisi 
untuk hasil akhir. 

C. Solo  : Sakelar ini menyembunyikan semua layer yang tidak 
mengaktifkan sakelar Solo. Seringkali Anda ingin mempreview 
hanya satu layer dalam komposisi yang jauh lebih besar. 
Dalam situasi seperti ini, mematikan video dan audio untuk 
banyak layer bisa sangat memakan waktu. Sakelar ini 
memungkinkan Anda untuk mengisolasi hanya layer yang 
mengaktifkan Solo. Saat trek dibuat solo, audio dan videonya 
tidak dipreview di panel Komposisi dan tidak disertakan saat 
Anda merender komposisi untuk hasil akhir. 

D. Lock : Sakelar ini mencegah pengeditan apa pun pada konten layer. 
Saat diaktifkan, layer tidak dapat dipilih atau diubah sama 
sekali. Gunakan sakelar ini untuk mencegah perubahan tak 
disengaja pada konten yang ingin diisolasi, namun ingin tetap 
terlihat dalam komposisi. 

E. Label : Ini adalah menu tarik-turun yang digunakan untuk 
menerapkan label warna ke setiap layer. Warna digunakan di 
dua tempat: sebagai warna batas di sekitar konten yang 
disorot di Timeline, dan juga sebagai warna highlight layer di 
Timeline. Meskipun Anda dapat memodifikasi warna, warna 
defaultnya adalah warna tertentu berdasarkan jenis footage 
pada layer. Anda dapat mengubah default ini di kotak dialog 
Preferensi dengan mengedit konten kategori Label. 

F. Number (#) : Ini adalah nilai numerik yang ditetapkan untuk menunjukkan 
urutan susunan layer dalam komposisi. Layer pertama berada 
di atas semua layer lainnya, diikuti layer bernomor 2, lalu 3, 
dan seterusnya. Jika Anda menggunakan keyboard dengan 
tombol angka, Anda dapat memilih layer dengan menekan 
tombol yang sesuai. 

G. Layer/Source Name : Kolom ini dapat diubah untuk menampilkan dua nilai yang 
berbeda. Opsi Source name menampilkan nama item rekaman 
dari panel Proyek, sementara memilih nama layer menampil-
kan nama khusus (jika ada) yang telah Anda tetapkan ke layer 
di panel Timeline. Komposisi baru default ke tampilan Nama 
sumber, di mana mereka menggunakan nama rekaman dari 
panel Proyek. Saat diedit, kolom secara otomatis beralih ke 
mode nama Layer, yang memungkinkan Anda menggabungkan 
nama khusus yang diubah di Timeline dengan nama Sumber. 



H. Shy : Sakelar Pemalu adalah alat untuk mengoptimalkan tampilan 
panel Komposisi. Anda dapat mengaktifkan mode Shy layer, 
lalu gunakan sakelar komposisi Hide Shy Layers di bagian atas 
panel Timeline untuk menyembunyikan semua layer Shy di 
comp. Ini bisa menjadi alternatif yang bermanfaat untuk 
memaksimalkan panel Timeline ke mode layar penuh, karena 
menghilangkan layer Shy dari tampilan layer tetapi bukan 
panel Komposisi. Layer pemalu masih dipreview di panel 
Komposisi dan juga disertakan saat dirender untuk hasil akhir. 

I. Collapse Transformations/Continuously Rasterize : 

Fungsi sakelar ini berubah, bergantung pada jenis rekaman 
layernya. Saat diterapkan pada komposisi, ini menciutkan 
transformasi pada layer tersebut, secara efektif mengubah 
urutan efek dan transformasi yang diberikan dalam komposisi 
bersarang. Rasterisasi berkelanjutan hanya berlaku untuk 
konten berbasis vektor yang diimpor dari program seperti 
Adobe Illustrator. Saat diaktifkan, layer terus diraster, yang 
menghasilkan hasil yang lebih baik dalam menganimasikan 
properti, seperti skala, tetapi melakukannya dengan 
peningkatan biaya kinerja. 

J. Quality : Pengaturan Quality dari sebuah layer menentukan seberapa 
tepatnya itu dirender. Pengaturan ini diterapkan pada 
tampilan layer dalam preview, tetapi juga berlaku saat 
dirender untuk hasil akhir. Saat Anda mengganti kualitas layer, 
Anda dapat memilih mode Best, Draft, dan Wireframe. Mode 
kualitas Terbaik menampilkan render dengan kualitas 
tertinggi, tetapi membutuhkan waktu lebih lama untuk 
merender daripada mode Draft atau Wireframe. Mode Draf 
adalah preview dengan kualitas lebih rendah daripada Terbaik, 
dan dimaksudkan untuk menampilkan layer Anda, tetapi 
beberapa efek tidak ditampilkan atau mungkin diterapkan 
secara tidak akurat. Kualitas wireframe hanya menampilkan 
garis luar sebuah layer, membuang tampilan dan semua 
efeknya. Kemampuan untuk mengubah kualitas sangat 
membantu karena kualitas tampilan yang lebih rendah 
mempreview dan merender lebih cepat, dan fitur ini bisa 
sangat berguna saat menyinkronkan posisi atau waktu elemen. 

K. Effects : Sakelar ini dinonaktifkan kecuali jika efek telah diterapkan ke 
layer, saat diaktifkan secara otomatis. Anda menggunakan 
sakelar ini untuk menonaktifkan efek pada layer, menghasilkan 
preview yang lebih cepat. 

L. Frame Blend : Sakelar ini bisaanya diaktifkan saat menggunakan efek 
pemetaan ulang waktu untuk mempercepat atau 
memperlambat rekaman video. Efek ini dapat menyebabkan 
gerakan tersentak-sentak, yang dirancang untuk dikompensasi 



oleh pencampuran bingkai dengan menggabungkan beberapa 
bingkai secara bersamaan. 

M. Motion Blur : Sakelar ini mengaktifkan motion blur di layer, membantu 
menciptakan kesan gerakan yang familiar bagi pemirsa dari 
menonton video dan film. 

N. Adjustment Layers : Saat diaktifkan, sakelar ini mengubah layer menjadi layer 
penyesuaian. Saat menggunakan layer penyesuaian, konten 
layer diabaikan dan sebagai gantinya, efek yang diterapkan 
pada layer target hanya memengaruhi layer di bawahnya. 

O. 3D Layer : Saat diaktifkan, sakelar ini mengubah layer dua dimensi 
menjadi layer tiga dimensi. 

P. Parenting : Kolom ini berisi kontrol untuk menyetel layer sebagai anak, 
sehingga memungkinkan layer induk untuk mengontrol 
posisinya, rotasi, skala, dan anchor point. 

 

H. Memahami Urutan Susun Layer 

Ketika sebuah komposisi terdiri dari banyak layer, susunan layer tersebut, yang disebut 
susunan susun, sangat penting. Ketika layer yang sepenuhnya buram ditempatkan di 
atas layer lain, hasilnya hanya layer atas yang terlihat. Namun, jika layer atas memiliki 
area transparan, Anda dapat melihat melalui area transparan tersebut ke layer atau 
layer di bawahnya. Anda dapat dengan mudah memodifikasi susunan layer di panel 
Timeline, seperti yang akan Anda lakukan sekarang. 

1. Di Timeline, cari kolom Source name dan tempatkan kursor Anda pada garis pemisah 
di sebelah kanan kolom. Panel panel Timeline dapat diperluas atau dikontrak 
tergantung pada kebutuhan Anda. 

2. Saat kursor Anda berubah menjadi panah ganda, klik dan seret garis pemisah ke 
kanan untuk memperbesar kolom Nama Sumber. 

 
Gambar 3.14. Mengubah Ukuran Kolom 

 

3. Klik dan tahan pada layer Cloud.png, untuk memilihnya, dan seret ke atas layer 
Antah Berantah.jpg. 

 
Gambar 3.15. Mengubah Urutan Layer 



4. Sekarang Anda seharusnya dapat melihat komposisi Cloud.png seperti pada gambar 
di bawah ini. Simpan file Anda dengan memilih File > Save atau dengan menekan 
Ctrl+S (Windows) atau Command+S (Mac OS) pada keyboard. 

 
Gambar 3.16. Layer Cloud Sekarang Berada di Atas Layer Antah Berantah 

 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

 

I. Mengubah Nama Layer 

Secara default, nama yang ditampilkan di panel Timeline diambil langsung dari nama 
rekaman sumber seperti yang muncul di panel Project. Namun, banyak orang lebih 
memilih untuk memiliki nama layer yang menjelaskan konten mereka, karena hal ini 
membuat mereka lebih mudah ditemukan saat memindai atau mencari komposisi 
dengan cepat. 

1. Klik layer Antah Berantah.jpg di panel Timeline Anda untuk menyorotnya. 

2. Dengan layer yang disorot, tekan tombol Enter (Windows) atau Return (Mac OS) 
pada keyboard Anda. Ini membuat nama layer dapat diedit. 

3. Ubah nama layer menjadi background. Tekan tombol Enter/Return lagi untuk keluar 
dari mode pengeditan ini. 

Ada beberapa hal yang telah berubah di panel Timeline. Nama kolom tidak lagi 
disebut Source name tetapi sekarang diberi judul Nama Layer. Selain itu, layer Cloud 
sekarang tampil dalam tanda kurung, menunjukkan bahwa itu masih dirujuk oleh 
Nama Sumber. 

4. Simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl+S 
(Windows) atau Command+S (Mac OS) pada keyboard. 

 

J. Memahami Properti Layer 

Setiap layer visual memiliki lima properti bawaan yang dapat dianimasikan: Position, 
Opacity, Rotation, Anchor Point, dan Scale. Masing-masing properti ini dapat 
dianimasikan baik secara individual maupun kombinasi dengan properti lain untuk 
membuat animasi. 



A. Posisi : Properti ini menentukan koordinat X, Y, dan Z (bila sakelar 3D 
layer diaktifkan) dari layer. Satuan ukuran yang digunakan oleh 
properti Posisi adalah piksel, dan relatif terhadap titik asal 
komposisi (0,0, 0,0) yang terletak di sudut kiri atas. Penting 
untuk dicatat bahwa properti ini adalah untuk anchor point 
dari sebuah layer, bukan konten sebenarnya. 

B. Opacity : Properti ini menentukan transparansi layer sebagai nilai antara 
0 (nol) dan 100 persen, di mana 0 persen akan sepenuhnya 
transparan, dan 100 persen akan sepenuhnya buram. 

C. Rotas : Properti ini menentukan jumlah layer yang berputar di sekitar 
poros tengahnya. Saat berhadapan dengan layer dua dimensi, 
semua rotasi berada di sekitar sumbu z. Namun, setelah 
sakelar layer 3D diaktifkan, properti Rotasi dibagi menjadi tiga: 
Rotasi X, Rotasi Y, dan Rotasi Z. Baik untuk dua dimensi atau 
tiga, properti Rotasi ditampilkan sebagai rangkaian angka, 0x + 
0,0º, di mana nilai pertama adalah jumlah atau waktu rotasi 
lengkap yang harus dilakukan, dan angka kedua adalah nilai 
derajat akhir. Jadi nilai 1x + 0,0º berarti berputar satu kali 
penuh dan berhenti di 0º, sedangkan nilai 2x + 45º berarti 
melakukan dua putaran penuh, lalu berhenti di 45º. 

D. Anchor Point : Ini adalah titik referensi atau registrasi dari sebuah layer. Ini 
adalah titik di mana semua transformasi (rotasi, gerakan, 
skala, dan sebagainya) terjadi di sekitarnya, sehingga 
terkadang disebut titik transformasi. 

E. Skala : Properti ini menentukan ukuran horizontal dan vertikal relatif 
dari sebuah layer sebagai nilai default ke 100 persen. Nilai di 
atas 100 persen membuat layer lebih besar, sedangkan nilai di 
bawah 100 persen membuatnya lebih kecil. 

Layer khusus, seperti camera dan lampu, memiliki properti yang sedikit berbeda. 
Misalnya, keduanya tidak memiliki Anchor Point dan sebagai gantinya memiliki properti 
bernama Point of Interest, yang menentukan area layar target yang diarahkan oleh 
cahaya atau camera. 

Setiap properti layer dapat dianimasikan secara independen dari yang lainnya. Setelah 
animasi diaktifkan, setiap perubahan pada properti tersebut, baik dengan menggunakan 
alat Transform di panel Komposisi atau dengan mengedit nilainya di Timeline, akan 
menghasilkan bingkai kunci baru di posisi playhead saat ini. Jika ada bingkai kunci yang 
ada di posisi playhead saat ini, Anda akan mengubah nilainya saat mengubah properti. 

 

K. Membuat Kinestasis Dengan Menganimasikan Anchor Point 

Kinestasis adalah teknik yang sangat populer saat bekerja dengan gambar diam. Kadang 
juga disebut efek Ken Burns atau Pan dan Zoom. Sebelum munculnya perangkat lunak 
modern, efeknya dibuat dengan menggeser camera video di atas gambar diam. Era saat 
ini, dalam motion graphic modern, efek ini paling sering dibuat ulang di After Effects 



dengan menganimasikan anchor point layer. 

Untuk inilah semua persiapan Anda sampai saat ini. Anda akan menganimasikan layer 
yang telah Anda tambahkan ke komposisi Anda untuk menciptakan efek kinestatik. 

Properti seperti Anchor point, Posisi, dan Skala memiliki banyak nilai untuk setiap bingkai 
utama. Nilai-nilai ini numerik dan sesuai dengan objek di layar Anda, yang pada 
gilirannya dapat dianimasikan. Misalnya dengan Posisi, Anda akan memiliki nilai X 
(horizontal) dan nilai Y (vertikal). Mengatur dua bagian ini dengan nilai berbeda, Anda 
dapat menganimasikan objek secara horizontal, vertikal, atau keduanya. Sedangkan 
layer tiga dimensi akan memiliki nilai ketiga dengan menambah posisi sumbu Z. 

1. Jika belum terbuka, buka proyek yang Anda simpan sebelumnya. Proyek ini memiliki 
komposisi gambar bertipe .jpg dan .png yang telah diimpor sebelumnya, bersama 
dengan folder yang dibuat secara otomatis untuk mengatur setiap layer file. 

2. Di panel Proyek, klik dua kali pada Vehicle comp untuk mempreviewnya di panel 
Komposisi dan Timeline. Pada latihan sebelumnya, dua layer ditambahkan ke comp: 
Cloud dan background. Layer harus dimodifikasi sedikit sebelum Anda dapat 
menerapkan efek Kinestasis. Kedua layer jauh lebih besar dari comp sebenarnya dan 
harus diperkecil agar berguna, dan layer Cloud harus dipindahkan ke posisi yang 
tepat untuk efeknya. 

3. Di panel Timeline, klik pada layer Cloud untuk menyorotnya. Tahan tombol Shift dan 
klik pada layer latar belakang untuk menambahkannya ke pilihan Anda. 

4. Klik reveal triangle di sebelah kiri nama layer Cloud untuk melihat properti Transform 
untuk layer tersebut. Karena kedua layer dipilih, dua properti Transform terungkap. 

 
Gambar 3.17. Tombol untuk Mengungkap Properti Layer 

 

5. Klik pada reveal triangle untuk properti Transform layer Cloud untuk melihat lima 
properti individual yang melekat pada semua layer yang terlihat. 

 
Gambar 3.18. Transform Properti pada Layer 

 

Banyak properti layer dan efek disembunyikan di dalam grup properti seperti 
Transform, yang harus Anda ungkapkan untuk mengaksesnya. 

6. Klik pada nilai Skala untuk membuatnya dapat diedit. Ketik 70 di bidang teks numerik 



dan tekan tombol Enter (Windows) atau Return (Mac OS) pada keyboard Anda. 
Karena banyak layer dipilih saat Anda melakukan ini, keduanya skala layer turun 
hingga 70 persen dari ukuran aslinya. 

7. Tekan Ctrl+Shift+A (Windows) atau Command+Shift+A (Mac OS) untuk membatalkan 
pilihan semua layer. Kemudian klik pada layer Cloud untuk memilihnya. 

8. Untuk layer Cloud, dalam kategori Posisi, klik pada nilai untuk Posisi X (nilai pertama 
yang tercantum untuk Position properti) dan ubah menjadi 100. Kemudian klik pada 
nilai untuk Posisi Y (nilai kedua yang tercantum untuk Position properti) dan ubah ke 
100. Tekan Enter atau Return untuk melakukan perubahan ini. 

 
Gambar 3.19. Perubahan Tranform Position pada Layer 

 

Hingga saat ini, Anda telah mengubah properti layer secara global. Ini mengubahnya 
ke nilai yang sama untuk seluruh durasi komposisi. Sekarang Anda akan 
menganimasikan properti Anchor Point untuk membuat gerakan. 

9. Jika kursor Anda tidak berada di awal (0;00;00;00) dari Timeline, klik kolom Current 
Time di pojok kiri atas Timeline untuk menyorotnya, ketikkan angka 0 (nol), dan 
tekan tombol Enter (Windows) atau Return (Mac OS) untuk memindahkan playhead 
kembali ke awal Timeline. 

10. Klik Time-Vary Stopwatch di sebelah kiri properti Anchor Point untuk mengaktifkan 
animasi di properti ini. Ini akan membuat keyframe pada posisi playhead saat ini. 

 
Gambar 3.20. Mengatur Anamasi Layer Cloud 

 



Keyframes menyimpan nilai properti. Untuk membuat animasi, Anda akan membuat 
keyframe kedua di Timeline dengan nilai yang berbeda. Program kemudian akan 
menganimasikan perubahan untuk Anda. 

11. Klik bidang Waktu Saat Ini untuk menyorotnya, ketik 1000 ke dalam bidang teks 
numerik, dan klik area kosong Timeline untuk memindahkan playhead ke 10 detik. 

12. Klik pada nilai X dari properti Anchor Point dan ubah ke 185. Ini membuat anchor 
point kedua dan melengkapi pasangan yang diperlukan untuk menganimasikan 
properti. Klik Masuk atau Kembali untuk menerima 

 
Gambar 3.21. Menambahkan Keyframe dalam Transform Position 

 

13. Klik pada playhead dan seret ke awal Timeline. Tekan bilah spasi pada keyboard Anda 
untuk mempreview animasi. Layer Cloud bergeser ke kanan, sedangkan layer latar 
belakang statis. 

14. Simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl+S (Windows) 
atau Command+S (Mac OS) pada keyboard. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

  

L. Animasi Rotasi  

Rotasi animasi memungkinkan Anda memutar layer di sekitar sumbu z pusatnya. Anda 
dapat menggunakannya untuk mensimulasikan pendulum yang berayun, jarum jam, 
atau lempar koin. Dalam latihan ini, Anda akan menganimasikan layer dalam komposisi 
Rotator untuk memutar serangkaian lingkaran dekoratif di sekitar titik tengah yang 
sama. 

Dalam latihan ini, Anda akan bekerja dengan salah satu komposisi Illustrator yang telah 
ditambahkan ke proyek di awal pelajaran. 

1. Buat project dan composition baru, dengan pengaturan seperti sebelumnya atau 
pengaturan sendiri. Beri nama composition dengan nama Rotator. 

2. Klik dan tahan Rectangle tool, klik Ellipse tool. 

   
Gambar 3.22. Tools Membuat Objek Shape Bentuk Lingkaran 



Buat seperti gambar di bawah ini : 

 
Gambar 3.23. Gambar Shape Layer 1 

 

Duplikasi layer Shape Layer 1 menggunakan pintasan Ctrl+D atau klik menu Edit, klik 
Duplicate sebanyak 3 kali. Tentukan nilai transform Rotation dalam : 

a. Shape Layer 2 menjadi 0x90° 

b. Shape Layer 3 menjadi 0x45° 

c. Shape Layer 2 menjadi 0x-45° 

   
Gambar 3.24. Bentuk Shape Layer Setelah di Duplikasi 

 

3. Di Timeline, klik layer pertama, Shape Layer 1, untuk menyorotnya. Untuk 
mengungkapkan properti Rotasi, tekan tombol R pada keyboard Anda. 

4. Pastikan playhead Anda berada di awal Timeline (0;00;00;00) dan klik Time-Vary 
Stopwatch di sebelah kiri Rotasi untuk mengaktifkan animasi untuk properti ini dan 
membuat keyframe pertama. 

5. Seret playhead ke akhir Timeline (0;00;05;00). Untuk animasi ini Anda akan 
membuat objek berputar lima kali. Klik angka pertama pada nilai rotasi, ubah 
menjadi 5, dan tekan tombol Enter (Windows) atau Return (Mac OS) pada keyboard 
Anda. Nilai properti Rotasi sekarang seharusnya tertulis 5x+0,0º. Ini menyebabkan 
objek berputar sekali setiap satu detik untuk menyelesaikan lima putaran yang 
ditugaskan. 

6. Pindahkan playhead kembali ke awal Timeline dan tekan bilah spasi pada keyboard 
untuk mempreview animasi. Cincin berputar searah jarum jam lima kali antara awal 
timeline sampai posisi keyframe ke-2, atau kira-kira satu putaran setiap 1 detik. 
Tekan bilah spasi lagi untuk menghentikan rotasi. 

7. Di Timeline, klik pada layer kedua, Shape Layer 2, untuk menyorotnya dan 



mengungkapkan properti Rotasi dengan menekan tombol R pada keyboard Anda. 

 

8. Sekali lagi, pastikan playhead Anda berada di asal Timeline dan klik Time-Vary 
Stopwatch di sebelah kiri Rotasi untuk mengaktifkan animasi untuk properti ini dan 
membuat keyframe. 

 
Gambar 3.25. Dua Keyframe untuk Animasi Shape Layer 1 

 

M. Menggunakan Layer Parenting Untuk Memudahkan Pengulangan 

Animasi objek yang digunakan dalam latihan ini sebenarnya terdiri dari rangkaian 
lingkaran konsentris, masing-masing dengan desainnya sendiri dan masing-masing pada 
layernya sendiri. Anda baru saja menganimasikan dua layer pertama yang bergerak 
berlawanan arah, tapi bagaimana dengan yang lainnya? Jika Anda ingin melanjutkan 
pola dan membuat setiap lingkaran berputar ke arah yang berlawanan dengan 
pendahulunya, Anda dapat menambahkan keyframe ke semuanya secara manual, tetapi 
ini akan sedikit membosankan. Semua keyframe individu ini juga akan menciptakan 
mimpi buruk jika Anda memutuskan untuk mengubah pengaturan waktu animasi nanti. 
Situasi seperti inilah di mana parenting menjadi penting. 

Parenting adalah alat untuk menghilangkan pengulangan yang sering melekat pada 
animasi yang kompleks. Dengannya Anda dapat menghubungkan layer-layer sehingga 
satu layer akan mengikuti layer lainnya. Layer anak mewarisi properti Posisi, Rotasi, 
Anchor point, dan Skala dari layer induknya, tetapi bukan Opacity. Keuntungan nyata 
dari parenting adalah bahwa sementara layer mengikuti pergerakan induknya, 
pergerakan ini relatif, sehingga setiap properti masih dapat memiliki keyframe 
independennya sendiri. 

Pada latihan ini, semua layer bernomor ganjil akan menjadi anak dari layer 1, sedangkan 
semua layer yang bernomor genap akan menjadi anak dari layer 2. 

1. Di Timeline, klik pada layer nomor 3, yang bernama Shape Layer 3, untuk 
menyorotnya. Tahan tombol Ctrl (Windows) atau Command (Mac OS) jika ingin 
menyorot layer yang tidak berurutan. 

2. Pada kolom Induk di sebelah kanan panel Layer Switches, klik menu drop-down 
untuk layer 3 dan pilih 1. Shape Layer 1 sebagai induk untuk semua layer bernomor 
ganjil. 

 
Gambar 3.26. Parenting Layer 



Ketika banyak layer disorot, setiap perubahan yang dilakukan pada properti salah 
satunya akan dilakukan pada semuanya. 

3. Klik pada layer 4 untuk menyorotnya. Pada panel Parent, klik menu drop-down untuk 
layer 4 dan pilih 2. Shape Layer 2 sebagai induk untuk semua layer bernomor genap. 

Karena parenting menciptakan pergerakan yang relatif terhadap pergerakan layer 
asli, Anda dapat menyesuaikan properti setiap layer sesuai kebutuhan. 

4. Pindahkan playhead ke 0, lalu tekan bilah spasi pada keyboard untuk melihat 
preview animasi. Tekan bilah spasi lagi untuk menghentikan animasi, lalu simpan file 
Anda dengan memilih File > Simpan. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

 

N. Menggunakan Mode Pencampuran 

Bagi pengguna aplikasi seperti Adobe Photoshop dan Illustrator, blending mode mungkin 
sudah menjadi topik yang sangat familiar. Mereka memungkinkan Anda untuk 
mengontrol bagaimana konten dari dua atau lebih layer bercampur atau menyatu. 
Secara default, layer berinteraksi dengan cara yang sangat mudah: area buram dari layer 
hanya menutupi dan menyembunyikan apa pun di bawahnya. Tapi Anda bisa 
mengubahnya untuk membuat komposisi yang lebih menarik. Dalam latihan ini, Anda 
akan menambahkan layer bentuk baru ke comp dan menggunakan mode blending untuk 
membuatnya mewarnai layer di bawahnya. 

1. Jika belum terbuka, buka proyek berisi komposisi vehicle yang Anda simpan di awal 
pelajaran ini. Di panel Project, klik dua kali pada Vehicle comp untuk 
mengaktifkannya di panel Composition dan Timeline. Mengklik dua kali pada 
komposisi di panel Proyek akan membukanya di Panel Komposisi dan Timeline. 

2. Batalkan pilihan semua layer di Timeline dengan memilih Edit > Deselect All. 

3. Dari panel Tools di bagian atas antarmuka After Effects, klik Rectangle tool untuk 
aktifkan tool Anda. Ini mengaktifkan opsi Fill dan Stroke di bagian kanan kanan. 

 
Gambar 3.27. Shape Tool 

 

Mengaktifkan shape tool secara otomatis mengaktifkan properti untuk fill untuk 
warna area dan stroke sebagai warna garis. 

4. Klik pada teks Fill di panel Tool untuk membuka kotak dialog Fill Options, dan pilih 
tombol kedua untuk mengisi shape baru dengan Solid Color. 

Konfirmasikan bahwa menu drop-down diatur ke Normal, Opacity 100 persen, dan 
kotak centang Preview diaktifkan, dan klik OK untuk menutup kotak dialog. 



 
Gambar 3.28 Fill Option dalam Shape Tool 

 
Isi adalah warna interior bentuk vektor dan Anda dapat mengaturnya menjadi warna 
solid, gradien linier atau radial, atau tidak sama sekali. Bentuk dapat diberi warna 
isian dan/atau garis sebelum atau setelah dibuat. 

5. Klik pada kotak Fill Color di samping kata Fill untuk membuka kotak dialog Shape Fill 
Color. Pilih warna biru tua sebagai Fill dengan mengatur nilai RGB ke R:5, G:16, 
B:103. Klik OK untuk menutup kotak dialog. 

 
Gambar 3.29. Color Editor dalam Shape Tool 

 

Alih-alih mengetikkan nilai warna, Anda dapat memilih warna secara visual 
menggunakan penggeser dan kotak warna di sisi kiri dialog. 

6. Klik pada teks Stroke pada panel Tool untuk membuka kotak dialog Stroke Options, 
dan pilih tombol pertama untuk mengatur Stroke bentuk baru menjadi None. 
Konfirmasikan bahwa kotak centang Preview diaktifkan dan klik OK untuk menutup 
kotak dialog. Stroke adalah garis tepi bentuk vektor, dan dengan memilih None, 
Anda menonaktifkannya sehingga bentuk ini hanya memiliki warna Isian. 

7. Klik dua kali pada Rectangle tool di panel Tools untuk membuat persegi panjang 
dengan ukuran yang sama dengan komposisi. Karena layer baru ditempatkan di atas 
dua layer sebelumnya, seluruh panel Komposisi diisi dengan warna biru. 

 
Gambar 3.30. Layer Baru Berisikan Shape Rectangle 

 
Mengklik dua kali pada alat bentuk apa pun akan secara otomatis membuat bentuk 
yang sesuai dengan ukuran komposisi. 



8. Klik pada layer Shape baru untuk menyorotnya. Tekan tombol Enter (Windows) atau 
Return (Mac OS) pada keyboard Anda untuk membuat nama layer dapat diedit dan 
mengubahnya menjadi Overlay. Tekan Enter/Return lagi. 

9. Klik pada tombol Expand atau Collapse Transfer Controls Pane di sudut kiri bawah 
panel Timeline untuk menampilkan kontrol Mode (Blending), dan ubah mode layer 
Overlay dari Normal ke Soft Light. Ini memberi komposisi warna ungu yang lembut. 

10. Di Timeline, seret layer Overlay di bawah layer Cloud sehingga pewarnaan warna 
hanya memengaruhi layer Background. 

Layer dapat diseret ke atas dan ke bawah di Timeline untuk mengubah urutan 
penumpukan kapan saja. 

 
Gambar 3.31. Pengaturan Blending Mode 

 

Sekali lagi, klik tombol Perluas atau Ciutkan Panel Kontrol Transfer ( ) di sudut kiri 
bawah panel Timeline untuk menyembunyikan Mode (Blending) kontrol. 

11. Simpan file Anda dengan memilih File > Save. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

 

O. Memahami Nested Komposisi Dan Precomposing 

Proyek kompleks jarang dibuat sebagai komposisi tunggal; sebaliknya, itu adalah hasil 
dari beberapa comps yang dianimasikan secara individual. Proses menempatkan satu 
comp di dalam yang lain disebut nesting. Bersarang memungkinkan Anda membuat 
animasi berurutan atau berturut-turut karena setiap komponen memiliki Timeline 
independennya sendiri. Precomposing adalah teknik yang memungkinkan Anda 
membuat comp dari layer yang sudah ada di Timeline Anda dan mengganti layer 
tersebut dengan comp baru. Ini bisa menjadi teknik yang sangat membantu ketika Anda 
ingin menggabungkan beberapa layer menjadi komposisi baru, sehingga Anda dapat 
menerapkan efek atau transformasi ke semuanya secara bersamaan, atau sebagai alat 
untuk menjaga agar panel Timeline tetap teratur. 

  



P. Menambahkan Nested Komposisi  

Dalam latihan ini, Anda akan menambahkan Rotator dan komposisi logo dison yang 
Anda animasikan di awal pelajaran ke komposisi Dison Intro. 

1. Jika belum terbuka, buka proyek yang berisi komposisi Rotator yang telah Anda 
simpan sebelumnya dalam pelajaran ini, dan klik dua kali pada Rotator comp untuk 
mengaktifkannya di panel Composition dan Timeline. 

2. Terlihat dalam komposisi Rotator terdapat Shape Layer 1 sampai dengan Shape 
Layer 4. BUka properti Rotation Shape Layer 2, tempatkan playhead di frame awal. 
Hilangkan pengaturan animasi Shape Layer 2 dengan klik pada icon stopwatch. 

Ubah Parenting Shape Layer 2, 3, 4 ke Shape Layer 1. INi untuk menentukan gerakan 
animasi Shape Layer 2,3,4 mengikuti gerakan Shape layer 1. 

3. Ukuran dan posisi layer baru perlu diatur agar lebih sesuai dengan komposisi ini. 
Dengan layer Shape Layer 1 terpilih, tekan tombol P pada keyboard Anda untuk 
menampilkan properti Position. Selanjutnya, tahan tombol Shift dan tekan tombol S, 
untuk membuka properti Skala juga. 

4. Ikon Tautan Rantai di sebelah kanan nilai Skala membatasi proporsi, memastikan 
bahwa jika Anda mengubah skala horizontal, skala vertikal akan berubah dalam 
jumlah relatif, mempertahankan proporsional tampilan layer. Pastikan bahwa opsi 
Constrain Proporsions diaktifkan dengan mengonfirmasi ikon Tautan Rantai terlihat 
dan mengubah salah satu dari nilai Skala menjadi 75 persen. Meski masih besar, ini 
akan membuatnya menjadi ukuran yang lebih mudah diatur. 

5. Pilih semua layer (Shape Layer 1-4) gunakan tombol Shift atau Ctrl, setelah semua 
terpilih tekan Ctrl+ D untuk menduplikasi semua layer yang terpilih. 

6. Terlihat layer Shape Layer 4-8 berada diantara Shape Layer 1-4. Ini akan 
membingungkan ketika akan mengatur properti atau menganimasikannya. 

7. Klik kanan pada Shape Layer 8, klik Pre-Compose untuk mengubah semua layer yang 
terpilih menjadi komposisi baru dan berada dalam komposisi yang aktif. Berikan 
nama komposisi bunga kecil di kotak isian New Composition Name, kemudian klik 
OK. Terlihat dalam komposisi Rotator satu komposisi baru bernama bunga kecil. 

 
Gambar 3.32. Komposisi Baru Hasil dari Perintah Pre-Compose 

 

8. Lakukan yang sama untuk Shape Layer 1-4 dan berikan nama komposisi dengan 
bunga bersar. 



9. Pilih layer bunga kecil, tekan tombol S untuk menampilkan properti Scale, ubah 
ukuran layer bunga kecil menjadi 60. Perubahan ukuran tidak terlihat dalam layer 
bunga kecil dikarenakan layer bunga kecil memiliki warna yang sama dengan layer 
bunga besar. 

10. Klik dobel layer bunga kecil, akan terbuka komposisi bunga kecil di Timeline dan 
Composition. Sekarang tampil kembali Shape Layer 5-8. Pilih semua layer dan ubah 
warnanya menggunakan kotak Fill seperti pembahasan sebelumnya. 

Tidak hanya warna yang sama antara layer bunga besar dan layer bunga kecil, 
melainkan animasinya juga memiliki gerakan yang sama. 

11. Klik dalam Shape Layer 6, tekan R dakam keyboard dan tempatkan playhead diawal 
frame klik ikon stopwatch untuk menghilangkan animasinya, kemudian ubah 
parenting layer menjadi Shape Layer 5 pada semua layer. 

 
Gambar 3.33. Perubahan Warna dan Animasi Layer di Komposisi Bunga Kecil 

 

Penggunaan perintah di atas menunjukkan proses pembuatan Nested Composition atu 
dikenal juga dengan KOmposisi Bersarang, dimana dalam satu komposisi terdapat 
komposisi lain di dalamnya untuk memudahkan pengaturan, maupun animasi komposisi 
yang terdiri dari banyak layer. 

Seperti terlihat dalam hasil, pengubahan ukuran Shape Layer 5-8 tidak perlu dilakukan 
satu persatu, melainkan bias dilakukan langsung dari komposisi bunga kecil. Demikian 
juga pengaturan property lain seperti Anchor Point, Position, dan lainnya. 

 
Gambar 3.34. Hasil Akhir 

 



BAB III 

KOMPOSISI DAN LAYER 
 

A. Project, Composition, dan Layer 

File project adalah inti dari semua pekerjaan yang Anda lakukan di Adobe After Effects. 
File project berisi tautan ke semua media yang Anda gunakan dalam komposisi Anda 
serta komposisi itu sendiri. Meskipun sebuah project dapat berisi banyak elemen dan 
komposisi media yang berbeda, hanya satu project yang dapat dibuka pada satu waktu 
di After Effects. Anda dapat menganggap file project sebagai wadah, tas kerja untuk 
membawa konten animasi Anda. File project di After Effects disimpan sangat kecil 
karena media tidak disematkan atau ditambahkan ke file project. Alih-alih, file project 
berisi tautan atau referensi ke media apa pun (audio, video, atau gambar diam) yang 
Anda impor. Ini menciptakan situasi dimana project bergantung pada file media yang 
tetap tidak berubah dan di lokasi relatif yang sama di hard drive Anda. Jadi jika Anda 
memiliki situasi yang mengharuskan Anda memindahkan project dari satu komputer ke 
komputer lain, Anda tidak hanya harus memindahkan file project tetapi juga media asli 
yang disimpan di hard drive Anda. Namun, tidak setiap elemen yang akan Anda gunakan 
bersifat eksternal; komposisi, bentuk, lampu, kamera, dan konten lain yang Anda buat di 
After Effects disimpan sebagai bagian dari file project. 

Komposisi, sering disebut comps, adalah fitur unik dari After Effects, meskipun mirip 
dengan urutan, yang dapat ditemukan dalam program pengeditan video dan animasi 
seperti Adobe Premiere atau Apple Final Cut Pro. Mereka adalah salah satu fitur 
program utama yang akan Anda gunakan saat Anda mulai menguasai After Effects. 
Setiap komposisi—Anda dapat memiliki beberapa komposisi di setiap project—mewakili 
Garis Waktu independen dan dapat berisi kombinasi video, audio, gambar diam, layer 
bentuk, dan elemen lainnya. Komposisi bahkan dapat berisi komposisi lain (ini disebut 
komposisi bersarang), dan fitur ini adalah kunci untuk membuat animasi dan komposit 
yang lebih kompleks. Saat membuat komposisi, Anda ingin mengatur propertinya untuk 
format yang ingin Anda hasilkan. 

Jika Anda memiliki latar belakang pengeditan video, ini mungkin akan sangat 
bertentangan dengan apa yang telah diajarkan kepada Anda, tetapi sebenarnya ini 
adalah cara kerja standar di After Effects. Jadi jika Anda membuat grafik untuk televisi 
siaran definisi standar, Anda akan ingin membuat comps Anda dengan standar NTSC, 
dan jika Anda membuat grafik untuk ditampilkan di layar komputer, Anda akan ingin 
membuat comps yang sesuai dengan resolusi layar yang Anda harapkan. 

Jika Anda pernah menggunakan aplikasi grafis lain seperti Photoshop, Illustrator, atau 
Flash, layer mungkin merupakan konsep yang familiar bagi Anda. Jika Anda baru 
mengenal konsep layer, maka, seperti komposisi, itu adalah fitur After Effects yang akan 
Anda kenal lebih baik saat Anda mempelajari pelajaran dalam buku ini. Anda tidak dapat 
mengedit media dalam komposisi secara langsung; sebaliknya, setiap bagian dari media 
yang ditempatkan ke dalam komposisi ada di jalurnya sendiri, yang disebut layer. 



Setiap layer memiliki properti seperti posisi, opasitas, dan durasi yang dapat Anda 
sesuaikan satu per satu atau bersama-sama dengan layer lainnya. Selain properti 
bawaan layer yang dapat diedit, Anda memiliki kemampuan untuk menambahkan 
berbagai macam efek dari menu Efek ke layer apa pun, dan dengan memanipulasi 
properti layer dan efeknya Anda dapat membuat animasi Anda. 

  

B. Membuat Project Baru 

Secara teknis, setiap kali Anda membuka After Effects, program membuat project 
kosong baru untuk Anda. Sebuah project bukanlah hal yang sangat mengesankan; itu 
benar-benar hanya sebuah wadah yang menyimpan referensi ke file media yang Anda 
kerjakan, bersama dengan komposisi yang Anda buat dan konten asli apa pun, seperti 
kamera, lampu, dan bentuk. Satu project mungkin berisi tautan ke lusinan, mungkin 
ratusan file berbeda yang berada di hard drive Anda. 

1. Mengimpor File Media 

Salah satu kekuatan besar After Effects adalah beragam media yang dapat Anda 
gunakan dengannya. After Effects mendukung file gambar diam, audio, dan video 
format standar. Di bagian pelajaran ini, Anda akan membuat project After Effects 
baru dan belajar mengimpor dua jenis media yang sangat umum: audio dan video. 
Selain format umum seperti .tiff, .jpg, .aif, dan .mp3, program ini menawarkan 
dukungan yang ditingkatkan untuk format file asli tertentu seperti Photoshop (.psd) 
dan Illustrator (.ai). 

a. Buat project After Effects baru yang kosong dengan memilih File > New > New 
Project, dan setel ulang ruang kerja Anda ke tata letak standar dengan memilih 
Window > Workspace > Standard, lalu pilih Window > Workspace > Reset 
“Standard.” Klik Ya di kotak dialog yang meminta Anda mengonfirmasi bahwa 
Anda ingin mengatur ulang ruang kerja. 

b. Pilih File > Impor > File untuk membuka kotak dialog Impor File. 

c. Pilih file yang ingin dimasukkan ke project After Effects. 

 

Gambar 3.1. Open Foler pada Import File 



Ada banyak cara untuk membuka kotak dialog Import File. Anda dapat 
menggunakan pintasan keyboard, Ctrl+I (Windows) atau Command+I (Mac OS); 
Anda dapat mengeklik kanan di area kosong mana pun di panel Project dan 
memilih Impor > File dari menu konteks yang muncul; dan Anda dapat mengklik 
dua kali area kosong di panel Project untuk segera membuka kotak dialog. 

Secara default, After Effects menggunakan nama file dari item footage asli Anda 
di panel Project. Anda dapat mengubahnya dengan mengklik kanan item dan 
memilih Ganti nama dari menu. 

d. Panel Project adalah salah satu dari banyak panel yang harus berbagi ruang di 
layar, jadi setelah file video diimpor ke project Anda, mungkin sangat sulit untuk 
melihat apakah panel Project kecil. Untuk mengatasi masalah ini, After Effects 
menawarkan fungsi toggle yang memungkinkan Anda menyesuaikan panel apa 
pun dengan ukuran penuh layar. Klik pada panel Project untuk membuatnya 
aktif. Panel menampilkan sorotan oranye di sekitarnya saat aktif. Tekan tombol 
tilde (~) pada keyboard Anda untuk memperbesar panel ke ukuran layar penuh. 

Tekan tombol tilde (~) untuk memperbesar panel yang sedang aktif ke layar 
penuh. Tekan lagi untuk kembali ke tata letak panel normal. Tekan lagi tombol 
tilde (~) saat Anda ingin kembali ke ruang kerja standar. 

e. Simpan Project setelah memasukkan footage atau imort file. Perintah keyboard 
untuk fungsi Simpan adalah Ctrl+S (Windows) atau Command+S (Mac OS). 

2. Menemukan File Yang Hilang 

Saat Anda mengimpor file, After Effects membuat tautan ke file media asli di hard 
drive Anda. Tautan ini adalah apa yang Anda lihat di panel Proyek. File-file ini 
ditautkan dan sebenarnya bukan bagian dari proyek itu sendiri. Jika terjadi sesuatu 
pada file asli, yaitu dihapus, dipindahkan, atau diganti namanya, ini akan 
menimbulkan masalah. 

Saat Anda mencoba membuka proyek, After Effects memeriksa tautan media untuk 
memastikan semuanya masih utuh, dan jika menemui masalah akan menampilkan 
dialog peringatan yang memberi tahu Anda berapa banyak file yang saat ini hilang. 
Jumlah file yang hilang akan bervariasi tergantung pada proyek yang Anda coba 
buka. 

 

Gambar 3.2. Missing File Footage Saat Imort File 

 

Untuk memperbaiki masalah ini, Anda harus menautkan kembali rekaman yang 
hilang dengan mengganti rekaman asli yang ditautkan dengan rekaman itu sendiri. 
Untuk menemukan file Anda yang hilang: 



a. Klik OK untuk menutup dialog peringatan awal. 

b. Temukan salah satu item footage yang hilang di panel Project. Mereka akan 
mudah diidentifikasi dengan ikon Color Bar di sebelah kiri nama footage. 

c. Klik kanan pada item footage yang hilang dan dari menu yang muncul, pilih 
Replace Footage > File. 

d. Saat kotak dialog Replace Footage File muncul, arahkan ke folder yang berisi file 
yang hilang yang sesuai dengan item footage ini. Nama file harus terlihat di bilah 
judul kotak dialog. 

e. Sorot file yang hilang dan klik Buka. Setelah jeda singkat saat komputer Anda 
menganalisis konten folder dan menautkan kembali file yang hilang yang 
ditemukannya di sini, dialog konfirmasi akan muncul yang memberi tahu Anda 
bahwa file yang hilang sebelumnya telah ditemukan. 

Jumlah file yang dipulihkan akan bervariasi tergantung pada jumlah item yang 
hilang yang dapat ditemukan oleh After Effects. 

f. Klik OK untuk menutup kotak dialog ini. 

Jika semua file Anda masih memiliki nama yang sama dan berada di lokasi folder 
relatif yang sama seperti saat diimpor, operasi penggantian yang satu ini akan 
menemukan semua item footage Anda yang hilang. Jika tidak, Anda harus 
mengulangi proses ini beberapa kali untuk menemukan semua file yang hilang. 
Secara umum, jauh lebih mudah ditemukan file media Anda yang hilang saat 
dipindahkan dan tidak diganti namanya. Jika item rekaman Anda telah dihapus, tidak 
ada yang dapat dilakukan After Effects untuk membantu Anda. Satu-satunya 
tindakan Anda adalah membuat ulang atau memulihkan item dari salinan cadangan 
hard drive atau file media Anda. 

3. Mengganti Nama File 

Mengganti nama file di After Effects sedikit berbeda dari program lain yang mungkin 
biasa Anda gunakan. Di sebagian besar program, Anda cukup mengeklik file yang 
disorot untuk mengganti namanya. Mencoba pendekatan ini di After Effects tidak 
berhasil. Di sini Anda akan mengubah nama file Washington City Street.jpg. 

a. Dengan panel Proyek disorot, klik tombol tilde (~) pada keyboard Anda untuk 
memaksimalkannya ke ukuran layar penuh. Kemudian klik file bernama 
Washington City Street.jpg untuk menyorotnya. 

b. Tekan tombol Enter (Windows) atau Return (Mac OS) pada keyboard Anda. 
Nama file menjadi dapat diedit. 

c. Ubah nama file dengan menempatkan kursor Anda di akhir kata Street dan 
menambahkan -daytime di akhir sehingga sekarang terbaca sebagai Washington 
City Street-dayday.jpg, lalu tekan Enter/Return untuk menyelesaikan pengeditan 
teks dan melakukan perubahan. 



 

Gambar 3.3. Mengganti Nama File dalam Project 

 

Mengubah nama file di panel Project tidak memengaruhi file sebenarnya di 
komputer Anda. Seperti semua program pengeditan video, After Effects memiliki 
alur kerja yang tidak merusak. Tidak ada yang Anda lakukan di After Effects 
mengubah file asli di hard drive Anda. Satu-satunya pengecualian untuk ini 
adalah saat Anda menggunakan perintah Edit Asli, yang dirancang untuk 
membuka file sumber asli yang Anda impor di aplikasi pengeditan eksternal 
seperti Photoshop dan Illustrator. 

d. Tekan tombol tilde pada keyboard Anda untuk meminimalkan panel Proyek dan 
kembali ke ruang kerja Standar. 

e. Simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl+S 
(Windows) atau Command+S (Mac OS) pada keyboard. 

4. Mengatur Panel Project 

Anda tidak dapat menyimpan panel project Anda dalam ukuran layar penuh 
sepanjang waktu, atau Anda tidak akan pernah bisa menyelesaikan pekerjaan apa 
pun. Dan bahkan dengan panel Project sebesar ini, mungkin masih memerlukan 
beberapa modifikasi agar Anda dapat bekerja lebih efisien. Secara default, panel 
menampilkan semua file yang diimpor dalam urutan abjad, tetapi ini seringkali bukan 
pendekatan terbaik untuk mengatur media Anda. Yang ingin Anda lakukan adalah 
membuatnya semudah mungkin untuk menemukan media yang Anda perlukan tepat 
saat Anda perlu menggunakannya. Untuk melakukannya, Anda akan menyesuaikan 
tampilan panel Project. 

Saat Anda bekerja di After Effects, Anda pasti akan membuka dan menutup banyak 
panel, tergantung pada jenis pekerjaan yang Anda lakukan. Namun, saat 
mengerjakan proyek dalam buku ini, penting untuk memiliki antarmuka yang sesuai 
dengan pelajaran. Untuk tujuan ini, Anda harus selalu mengatur ulang ruang kerja 
Anda ke konfigurasi Standar prasetel. Di After Effects CS6, pilih Window > Workspace 
> Standard untuk mengubah konfigurasi tampilan ruang kerja Anda saat ini. 

  

C. Memahami Alur Kerja Animasi 

Saat bekerja di After Effects, penting untuk dipahami bahwa program ini bisaanya 
digunakan untuk menganimasikan atau menggabungkan aset yang dibuat di aplikasi lain. 
Aman untuk mengatakan bahwa sebagian besar pengguna After Effects profesional 
seringkali adalah pengguna ahli, dari program grafis dan desain lainnya. Mereka sering 
menggunakan Adobe Photoshop, dan terkadang Illustrator, bersama dengan berbagai 



paket yang dapat membuat grafik 3D seperti 3D Studio Max, Maya, atau Cinema 4D 
untuk membuat media yang akan mereka gunakan di After Effects. 

Untuk mempercepat proses pembelajaran, banyak pelajaran dalam buku ini yang Anda 
mulai dengan proyek yang dibuat sendiri dan berkelanjutan untuk pembehasan 
selanjutnya. Pelajaran ini akan sedikit berbeda, karena akan membawa Anda melalui 
seluruh alur kerja, mulai dari membuat komposisi, hingga mengimpor berbagai konten 
media, dan terakhir melalui proses animasi dan preview. Dalam pelajaran ini, Anda akan 
bekerja dengan berbagai aset media untuk menghasilkan animasi dan efek untuk 
kebutuhan film. 

  

D. Membuat Dan Bekerja Dengan Komposisi 

Di Adobe After Effects, komposisi adalah tempat Anda melakukan semua pekerjaan 
animasi dan komposisi. Di dalam sebuah komposisi, setiap bagian dari media berada 
pada layernya masing-masing. Pikirkan setiap komposisi sebagai Timeline independen 
dalam proyek Anda. Selain berbagai macam rekaman yang Anda impor ke After Effects, 
komposisi juga dapat berisi komposisi lain, memungkinkan lingkungan desain yang 
terorganisir dan proyek animasi yang sangat kompleks. Menempatkan satu komposisi di 
dalam yang lain disebut komposisi bersarang, dan Anda akan mempelajarinya lebih 
lanjut dalam pelajaran ini. Pada pelajaran bagian pertama ini, Anda akan membuat 
komposisi awal untuk menampung objek gambar dan animasi yang akan Anda buat. 

1. Membuat Komposisi Baru 

Seperti disebutkan sebelumnya, proyek itu sendiri benar-benar tidak memiliki 
properti yang dapat diedit; dalam komposisi Anda mengatur segalanya mulai dari 
kecepatan bingkai hingga dimensi piksel hingga rasio aspek. Komposisi dapat diimpor 
dari proyek After Effects lainnya, dibuat secara otomatis saat Anda mengimpor file 
Photoshop atau Illustrator berlapis, atau dibuat dari awal seperti yang akan Anda 
lakukan di sini. 

a. Pilih Komposisi > Komposisi Baru dari menu di bagian atas antarmuka After 
Effects untuk membuka kotak dialog Pengaturan Komposisi. Anda juga dapat 
menggunakan pintasan keyboard, Ctrl+N (Windows) atau Command+N (Mac OS). 

b. Di kotak dialog, ubah nama komposisi default menjadi Vehicle. Dari menu drop-
down Preset, Custom. Memilih preset Custom berarti menentukan sendiri Width, 
Height, Pixel Aspect Ratio, dan Frame Rate. 

 
Gambar 3.4. Setting Custom untuk Composition Baru 



c. Tentukan nilai Resolution diatur Full 

d. Ubah Duration menjadi 0;00;30;00 (30 detik). 

e. Klik kotak Background Color untuk membuka kotak dialog Warna Latar Belakang. 
Saat muncul, perhatikan bahwa Color Picker di kotak dialog memungkinkan Anda 
memasukkan nilai numerik untuk warna menggunakan nilai HSB (Hue, 
Saturation, Brightness), RGB (Red, Green, Blue), dan heksadesimal. 

f. Klik pada nilai R (Merah) dan ketik 141. Ulangi ini untuk nilai G (Hijau) dan B 
(Biru) juga. Ini menghasilkan warna latar abu-abu muda. 

 
Gambar 3.5. Kotak Dialog Background Color 

 

g. Klik OK di kotak dialog Background Color untuk kembali ke kotak dialog 
Composition Settings, lalu klik OK lagi di kotak dialog untuk menambahkan comp 
baru ke proyek Anda. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

2. Memahami Pengaturan Komposisi 

Kotak dialog Pengaturan Komposisi memungkinkan Anda mengatur dan mengedit 
properti komposisi Anda. Kotak dialog terbuka secara otomatis saat Anda membuat 
komposisi baru dan dapat dibuka secara manual dengan memilih komposisi dan 
memilih Komposisi > Pengaturan Komposisi atau dengan menekan Ctrl+K (Windows) 
atau Command+K (Mac OS). Kotak dialog dibagi menjadi dua bagian, untuk 
pengaturan dasar dan lanjutan. 

a. Basic Setting 

 
Gambar 3.6. Basic Composition Setting 



Keterangan Gambar : 

A. Preset : Proyek video bisaanya harus sesuai dengan standar 
yang ditetapkan seperti NTSC atau PAL. Menu preset 
berisi berbagai pengaturan komposisi prebuilt agar 
sesuai dengan standar yang paling umum digunakan. 
Karena sebagian besar proyek video akan cocok dengan 
salah satu standar video yang ditetapkan, cara paling 
efisien untuk memulai adalah dengan memilih prasetel 
dari menu drop-down dan kemudian memodifikasi 
properti apa pun yang tidak sesuai dengan proyek 
khusus Anda. Di sebelah kanan menu ada dua tombol: 
satu untuk menyimpan prasetel khusus dan satu lagi 
untuk menghapusnya. 

B. Width dan Height : Pengaturan ini menentukan dimensi fisik, dalam piksel, 
komputer Anda. Ini sebanding dengan ukuran dokumen 
di aplikasi lain. 

C. Pixel Aspect Ratio : Pengaturan ini menentukan bentuk piksel di komputer 
Anda. Standar video yang berbeda menggunakan rasio 
aspek piksel yang berbeda untuk menampilkan konten. 
Rasio aspek piksel yang salah akan menyebabkan karya 
Anda tampak terdistorsi. Preset yang Anda pilih 
bisaanya menetapkan properti ini untuk Anda. 

D. Frame Rate : Pengaturan ini menentukan jumlah bingkai per detik 
(fps) yang menyusun komposisi Anda. 

E. Timebase : Pengaturan ini menentukan apakah Composition baru 
akan menggunakan timebase drop-frame atau non-
drop-frame. 

F. Resolution : Pengaturan ini menentukan kualitas tampilan panel 
Komposisi. Nilai yang lebih rendah membutuhkan lebih 
sedikit RAM untuk melihat preview. 

G. Start Timecode : Pengaturan ini menentukan nilai kode waktu di awal, 
atau asal, Timeline. Standar After Effects adalah 
00;00;00;00 tetapi jika mengekspor animasi Anda ke 
kaset video untuk disiarkan, sebagian besar stasiun 
memerlukan asal kode waktu diatur ke 01;00;00;00 (1 
jam). 

H. Duration : Pengaturan ini menentukan panjang Timeline 
komposisi. 

I. Background Color : Pengaturan ini menentukan warna latar belakang untuk 
komposisi. 

 

 



b. Advanced Setting 

 
Gambar 3.7. Advanced Setting pada Composition 

 

Keterangan Gambar : 

A. Anchor : Pengaturan ini tidak dapat diedit saat membuat comp 
baru, hanya saat mengedit pengaturan yang sudah ada. 
Jika Anda memperbesar atau memperkecil dimensi 
fisiknya, pengaturan jangkar menentukan bagaimana 
hasil transformasi dengan mengunci area tertentu pada 
tempatnya. 

B. Rendering Plug-in : Pengaturan ini menentukan mesin yang akan digunakan 
untuk merender layer 3D. Pengaturan ini 
memungkinkan Anda memilih antara 3D Klasik dan 3D 
Raytraced. Mesin raytracing baru di After Effects CS6 
memungkinkan Anda untuk membuat layer teks dan 
bentuk yang diekstrusi, dan menyediakan tampilan 
berkualitas lebih tinggi untuk konten 3D. 

C. Preserve frame rate when nested or in Render Queue : 

Pengaturan ini menentukan apakah laju bingkai comp dipertahankan atau 
dikonversi saat Anda menempatkannya di dalam komposisi lain. 

D. Preserve resolution when nested : 

Pengaturan ini menentukan apakah pengaturan resolusi comp dipertahankan 
atau dikonversi saat Anda menempatkannya di dalam komposisi lain. 

E. Motion Blur : Pengaturan ini menentukan kekuatan efek Motion Blur 
saat diaktifkan untuk layer. Menggunakan Motion Blur 
dibahas lebih mendetail nanti dalam pelajaran ini. 

 



E. Bekerja Dengan Layer 

Jika Anda sudah familiar dengan program grafik seperti Adobe Photoshop dan Illustrator, 
maka Anda mungkin sudah familiar dengan konsep umum penggunaan layer, meskipun 
di sini cara kerjanya sedikit berbeda. Di After Effects, setiap rekaman yang Anda 
tempatkan dalam komposisi berada pada layer yang terpisah dan individual. Layer ini 
terlihat di panel Timeline dan setiap layer berisi propertinya sendiri yang dapat 
dimanipulasi atau dianimasikan secara terpisah dari yang lain. 

Sekarang setelah Anda membuat komposisi utama dan mengimpor aset media yang 
akan Anda gunakan, saatnya untuk menangani bekerja dengan panel Layer. Di bagian 
pelajaran ini, Anda akan menambahkan media ke timeline dan bekerja dengan layer 
footage yang dibuat untuk mengatur tata letak komposisi Anda. 

1. Setelah Anda membuat project baru dan composition baru, maka akan tampil 
komposisi dengan nama vehicle. 

2. Masukkan dalam project baru tersebut dengan file (footage) yang dibutuhkan dalam 
project dengan klik kanan pada panel Project > klik Import > klik File. Klik file yang 
sudah disiapkan, klik Open. Jika file footage telah diorganisir dalam satu forder, klik 
folder, klik Import Folder 

 
Gambar 3.8. Import File Window 

 

Penting untuk dicatat bahwa ketika Anda mengklik dua kali pada sebuah komposisi, 
itu akan dipreview di panel Komposisi dan Timeline secara bersamaan. Namun, cara 
previewnya sedikit berbeda. Hanya ada satu panel Komposisi secara default, jadi 
mengklik dua kali pada comp membuatnya aktif di jendela dan menyembunyikan 
mana saja yang mungkin telah terlihat sebelumnya. Namun, panel Timeline berbasis 
tab (seperti browser Internet Anda), sehingga Anda dapat melihat beberapa tab 
comp sekaligus. Akibatnya, mengklik dua kali pada comp di panel Project hanya akan 
membawa tabnya ke depan dan membuatnya aktif. 



 
Gambar 3.9. File Footage yang Telah di Import 

 

File footage dapat dimasukkan dari folder yang sama atau dari folder yang berbeda. 
Gunakan perintah import untuk memasukkan file footage dari folder yang berbeda 
beberapa kali sehingga file footage masuk semua dalam projects. 

3. Di panel Proyek, klik dan tahan pada file Antah Berantah.jpg untuk memilihnya, dan 
seret ke Timeline vehicle comp. 

4. Saat file telah berada dalam area Timeline comp, lepaskan tombol mouse Anda. File  
ditambahkan ke Timeline, dan gambar akan terlihat di panel Composition. 

 
Gambar 3.10. Memasukkan Footage dalam Timeline 

 

5. Sekali lagi, di panel Project, klik pada file Cloud.png, lalu seret dan jatuhkan di bawah 
layer Antah Berantah.jpg pada vehicle Timeline. 

 
Gambar 3.11. Penambahan Footage dalam Timeline 



 

Jika Anda melihat panel Composition, Anda tidak menemukan gambar Cloud.png, ini 
karena gambar dari footage Antah Berantah ada di depannya. Anda akan 
memperbaiki ini di latihan berikutnya. 

6. Simpan file Anda dengan memilih File > Save. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

 

F. Memahami Berbagai Jenis Layer 

Di After Effects, footage yang Anda impor ditambahkan ke layer saat Anda 
menempatkannya ke dalam komposisi, tetapi bagaimana dengan objek lain, seperti 
lampu, camera, atau bentuk lainnya? Mereka juga berupa layer; sebenarnya, selain layer 
standar yang akan Anda buat dari konten bisa diimpor, seperti video, gambar, dan audio, 
ada jenis layer lain yang dapat dibuat sepenuhnya di dalam After Effects: 

Layer Text, dapat dianimasikan menggunakan properti transformasi layer standar 
(seperti posisi atau rotasi). Selain itu, layer teks memiliki properti unik (disebut animator 
teks) yang memberi Anda lebih banyak kontrol atas teks. Contoh saat Anda akan 
menggunakan animator teks adalah jika Anda ingin memutar setiap karakter dalam 
sebuah kata. Layer teks sering digunakan untuk membuat kredit, sepertiga bagian 
bawah, atau efek tipografi kinetik. 

Layer solid, juga disebut layer padat adalah layer warna tunggal yang dibuat langsung di 
After Effects. Mereka sering digunakan sebagai bidang warna, bentuk persegi panjang, 
atau untuk efek yang dihasilkan secara internal di dalam After Effects, seperti efek petir, 
atau efek sinar . 

 
Gambar 3.12. Tampilan Setelah Klik Kanan dalam Timeline 

 

Layer Light, digunakan untuk menerangi layer 3D dan menghasilkan bayangan. Sebagai 
alat estetika, lampu digunakan untuk meningkatkan kesan kedalaman dan volume dalam 
sebuah pemandangan. 

Layer Camera, dirancang untuk mensimulasikan kinerja dan perilaku camera video 
dalam kehidupan nyata, dan dapat digeser, dimiringkan, dan dipindahkan untuk 
menciptakan kesan pergerakan melalui ruang. 

Layer Null Object, adalah layer tak terlihat (yang terlihat di panel komposisi dan 



timeline, tetapi tidak dirender) yang memiliki semua properti transformasi dari layer lain 
yang terlihat. Mereka berguna sebagai objek pembantu, mereka meminta Anda untuk 
mengasuh properti dari satu layer ke layer lainnya, dan sering digunakan sebagai objek 
pengontrol untuk camera dan layer tiga dimensi. 

Layer Shape, adalah objek bentuk vektor yang dibuat dengan alat bentuk (persegi 
panjang, elips, poligon, dll.) di After Effects. Mirip dengan teks dan layer padat, keduanya 
memiliki properti transformasi layer dan properti bentuk khusus hanya untuk layer 
bentuk. 

Layer Adjustment, adalah layer tak terlihat yang dapat menjadi target efek, yang mirip 
dengan layer penyesuaian di Photoshop. Mereka digunakan ketika Anda ingin 
menerapkan efek tertentu atau serangkaian efek ke beberapa layer secara bersamaan. 
Karena setiap layer di bawah layer penyesuaian yang ditargetkan akan ditampilkan 
seolah-olah efek diterapkan padanya, ini menghindari masalah karena harus 
menerapkan efek yang sama beberapa kali. 

 

G. Memahami Switch Layer 

Jika Anda telah bekerja dengan program desain atau grafik sebelum menggunakan After 
Effects, maka gagasan memiliki sakelar untuk menyembunyikan atau mengunci layer 
bukanlah hal baru bagi Anda. Namun selain kontrol standar ini, area Layer Timeline berisi 
beberapa sakelar khusus lainnya yang digunakan untuk mengaktifkan atau 
menonaktifkan berbagai fitur layer. Selain dapat menampilkan, menyembunyikan, dan 
mengunci layer, Anda dapat melakukan solo, pemalu, atau mengaktifkan fitur seperti 
motion blur atau frame blending. Jika istilah tersebut baru bagi Anda, bagian ini akan 
membantu Anda memahaminya. Setiap sakelar layer sesuai dengan label di atasnya yang 
merinci nama dan penggunaannya. 

 
Gambar 3.13. Switch Layer 

 

A. Video On/Off : Klik sakelar ini untuk mengalihkan visibilitas video pada layer. 
Sakelar ini hanya tersedia saat bekerja dengan layer yang 
berisi video; jika tidak, ruang kosong. Di After Effects, 
pengaturan ini berlaku untuk gambar diam dan video 
sebenarnya. Saat trek video layer dinonaktifkan, itu tidak 
dipreview di panel Komposisi dan tidak disertakan saat Anda 
merender komposisi untuk hasil akhir. 



B. Audio On/Off : Klik sakelar ini untuk membisukan audio layer. Sakelar ini 
hanya tersedia saat bekerja dengan layer yang berisi audio. 
Dalam hal ini, audio dapat berada di layernya sendiri, seperti 
saat Anda menambahkan file MP3, WAV, atau AIFF ke 
komposisi, atau disematkan dalam file video. Saat Anda 
menonaktifkan trek audio layer, itu tidak dipreview di panel 
Komposisi dan tidak disertakan saat Anda merender komposisi 
untuk hasil akhir. 

C. Solo  : Sakelar ini menyembunyikan semua layer yang tidak 
mengaktifkan sakelar Solo. Seringkali Anda ingin mempreview 
hanya satu layer dalam komposisi yang jauh lebih besar. 
Dalam situasi seperti ini, mematikan video dan audio untuk 
banyak layer bisa sangat memakan waktu. Sakelar ini 
memungkinkan Anda untuk mengisolasi hanya layer yang 
mengaktifkan Solo. Saat trek dibuat solo, audio dan videonya 
tidak dipreview di panel Komposisi dan tidak disertakan saat 
Anda merender komposisi untuk hasil akhir. 

D. Lock : Sakelar ini mencegah pengeditan apa pun pada konten layer. 
Saat diaktifkan, layer tidak dapat dipilih atau diubah sama 
sekali. Gunakan sakelar ini untuk mencegah perubahan tak 
disengaja pada konten yang ingin diisolasi, namun ingin tetap 
terlihat dalam komposisi. 

E. Label : Ini adalah menu tarik-turun yang digunakan untuk 
menerapkan label warna ke setiap layer. Warna digunakan di 
dua tempat: sebagai warna batas di sekitar konten yang 
disorot di Timeline, dan juga sebagai warna highlight layer di 
Timeline. Meskipun Anda dapat memodifikasi warna, warna 
defaultnya adalah warna tertentu berdasarkan jenis footage 
pada layer. Anda dapat mengubah default ini di kotak dialog 
Preferensi dengan mengedit konten kategori Label. 

F. Number (#) : Ini adalah nilai numerik yang ditetapkan untuk menunjukkan 
urutan susunan layer dalam komposisi. Layer pertama berada 
di atas semua layer lainnya, diikuti layer bernomor 2, lalu 3, 
dan seterusnya. Jika Anda menggunakan keyboard dengan 
tombol angka, Anda dapat memilih layer dengan menekan 
tombol yang sesuai. 

G. Layer/Source Name : Kolom ini dapat diubah untuk menampilkan dua nilai yang 
berbeda. Opsi Source name menampilkan nama item rekaman 
dari panel Proyek, sementara memilih nama layer menampil-
kan nama khusus (jika ada) yang telah Anda tetapkan ke layer 
di panel Timeline. Komposisi baru default ke tampilan Nama 
sumber, di mana mereka menggunakan nama rekaman dari 
panel Proyek. Saat diedit, kolom secara otomatis beralih ke 
mode nama Layer, yang memungkinkan Anda menggabungkan 
nama khusus yang diubah di Timeline dengan nama Sumber. 



H. Shy : Sakelar Pemalu adalah alat untuk mengoptimalkan tampilan 
panel Komposisi. Anda dapat mengaktifkan mode Shy layer, 
lalu gunakan sakelar komposisi Hide Shy Layers di bagian atas 
panel Timeline untuk menyembunyikan semua layer Shy di 
comp. Ini bisa menjadi alternatif yang bermanfaat untuk 
memaksimalkan panel Timeline ke mode layar penuh, karena 
menghilangkan layer Shy dari tampilan layer tetapi bukan 
panel Komposisi. Layer pemalu masih dipreview di panel 
Komposisi dan juga disertakan saat dirender untuk hasil akhir. 

I. Collapse Transformations/Continuously Rasterize : 

Fungsi sakelar ini berubah, bergantung pada jenis rekaman 
layernya. Saat diterapkan pada komposisi, ini menciutkan 
transformasi pada layer tersebut, secara efektif mengubah 
urutan efek dan transformasi yang diberikan dalam komposisi 
bersarang. Rasterisasi berkelanjutan hanya berlaku untuk 
konten berbasis vektor yang diimpor dari program seperti 
Adobe Illustrator. Saat diaktifkan, layer terus diraster, yang 
menghasilkan hasil yang lebih baik dalam menganimasikan 
properti, seperti skala, tetapi melakukannya dengan 
peningkatan biaya kinerja. 

J. Quality : Pengaturan Quality dari sebuah layer menentukan seberapa 
tepatnya itu dirender. Pengaturan ini diterapkan pada 
tampilan layer dalam preview, tetapi juga berlaku saat 
dirender untuk hasil akhir. Saat Anda mengganti kualitas layer, 
Anda dapat memilih mode Best, Draft, dan Wireframe. Mode 
kualitas Terbaik menampilkan render dengan kualitas 
tertinggi, tetapi membutuhkan waktu lebih lama untuk 
merender daripada mode Draft atau Wireframe. Mode Draf 
adalah preview dengan kualitas lebih rendah daripada Terbaik, 
dan dimaksudkan untuk menampilkan layer Anda, tetapi 
beberapa efek tidak ditampilkan atau mungkin diterapkan 
secara tidak akurat. Kualitas wireframe hanya menampilkan 
garis luar sebuah layer, membuang tampilan dan semua 
efeknya. Kemampuan untuk mengubah kualitas sangat 
membantu karena kualitas tampilan yang lebih rendah 
mempreview dan merender lebih cepat, dan fitur ini bisa 
sangat berguna saat menyinkronkan posisi atau waktu elemen. 

K. Effects : Sakelar ini dinonaktifkan kecuali jika efek telah diterapkan ke 
layer, saat diaktifkan secara otomatis. Anda menggunakan 
sakelar ini untuk menonaktifkan efek pada layer, menghasilkan 
preview yang lebih cepat. 

L. Frame Blend : Sakelar ini bisaanya diaktifkan saat menggunakan efek 
pemetaan ulang waktu untuk mempercepat atau 
memperlambat rekaman video. Efek ini dapat menyebabkan 
gerakan tersentak-sentak, yang dirancang untuk dikompensasi 



oleh pencampuran bingkai dengan menggabungkan beberapa 
bingkai secara bersamaan. 

M. Motion Blur : Sakelar ini mengaktifkan motion blur di layer, membantu 
menciptakan kesan gerakan yang familiar bagi pemirsa dari 
menonton video dan film. 

N. Adjustment Layers : Saat diaktifkan, sakelar ini mengubah layer menjadi layer 
penyesuaian. Saat menggunakan layer penyesuaian, konten 
layer diabaikan dan sebagai gantinya, efek yang diterapkan 
pada layer target hanya memengaruhi layer di bawahnya. 

O. 3D Layer : Saat diaktifkan, sakelar ini mengubah layer dua dimensi 
menjadi layer tiga dimensi. 

P. Parenting : Kolom ini berisi kontrol untuk menyetel layer sebagai anak, 
sehingga memungkinkan layer induk untuk mengontrol 
posisinya, rotasi, skala, dan anchor point. 

 

H. Memahami Urutan Susun Layer 

Ketika sebuah komposisi terdiri dari banyak layer, susunan layer tersebut, yang disebut 
susunan susun, sangat penting. Ketika layer yang sepenuhnya buram ditempatkan di 
atas layer lain, hasilnya hanya layer atas yang terlihat. Namun, jika layer atas memiliki 
area transparan, Anda dapat melihat melalui area transparan tersebut ke layer atau 
layer di bawahnya. Anda dapat dengan mudah memodifikasi susunan layer di panel 
Timeline, seperti yang akan Anda lakukan sekarang. 

1. Di Timeline, cari kolom Source name dan tempatkan kursor Anda pada garis pemisah 
di sebelah kanan kolom. Panel panel Timeline dapat diperluas atau dikontrak 
tergantung pada kebutuhan Anda. 

2. Saat kursor Anda berubah menjadi panah ganda, klik dan seret garis pemisah ke 
kanan untuk memperbesar kolom Nama Sumber. 

 
Gambar 3.14. Mengubah Ukuran Kolom 

 

3. Klik dan tahan pada layer Cloud.png, untuk memilihnya, dan seret ke atas layer 
Antah Berantah.jpg. 

 
Gambar 3.15. Mengubah Urutan Layer 



4. Sekarang Anda seharusnya dapat melihat komposisi Cloud.png seperti pada gambar 
di bawah ini. Simpan file Anda dengan memilih File > Save atau dengan menekan 
Ctrl+S (Windows) atau Command+S (Mac OS) pada keyboard. 

 
Gambar 3.16. Layer Cloud Sekarang Berada di Atas Layer Antah Berantah 

 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

 

I. Mengubah Nama Layer 

Secara default, nama yang ditampilkan di panel Timeline diambil langsung dari nama 
rekaman sumber seperti yang muncul di panel Project. Namun, banyak orang lebih 
memilih untuk memiliki nama layer yang menjelaskan konten mereka, karena hal ini 
membuat mereka lebih mudah ditemukan saat memindai atau mencari komposisi 
dengan cepat. 

1. Klik layer Antah Berantah.jpg di panel Timeline Anda untuk menyorotnya. 

2. Dengan layer yang disorot, tekan tombol Enter (Windows) atau Return (Mac OS) 
pada keyboard Anda. Ini membuat nama layer dapat diedit. 

3. Ubah nama layer menjadi background. Tekan tombol Enter/Return lagi untuk keluar 
dari mode pengeditan ini. 

Ada beberapa hal yang telah berubah di panel Timeline. Nama kolom tidak lagi 
disebut Source name tetapi sekarang diberi judul Nama Layer. Selain itu, layer Cloud 
sekarang tampil dalam tanda kurung, menunjukkan bahwa itu masih dirujuk oleh 
Nama Sumber. 

4. Simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl+S 
(Windows) atau Command+S (Mac OS) pada keyboard. 

 

J. Memahami Properti Layer 

Setiap layer visual memiliki lima properti bawaan yang dapat dianimasikan: Position, 
Opacity, Rotation, Anchor Point, dan Scale. Masing-masing properti ini dapat 
dianimasikan baik secara individual maupun kombinasi dengan properti lain untuk 
membuat animasi. 



A. Posisi : Properti ini menentukan koordinat X, Y, dan Z (bila sakelar 3D 
layer diaktifkan) dari layer. Satuan ukuran yang digunakan oleh 
properti Posisi adalah piksel, dan relatif terhadap titik asal 
komposisi (0,0, 0,0) yang terletak di sudut kiri atas. Penting 
untuk dicatat bahwa properti ini adalah untuk anchor point 
dari sebuah layer, bukan konten sebenarnya. 

B. Opacity : Properti ini menentukan transparansi layer sebagai nilai antara 
0 (nol) dan 100 persen, di mana 0 persen akan sepenuhnya 
transparan, dan 100 persen akan sepenuhnya buram. 

C. Rotas : Properti ini menentukan jumlah layer yang berputar di sekitar 
poros tengahnya. Saat berhadapan dengan layer dua dimensi, 
semua rotasi berada di sekitar sumbu z. Namun, setelah 
sakelar layer 3D diaktifkan, properti Rotasi dibagi menjadi tiga: 
Rotasi X, Rotasi Y, dan Rotasi Z. Baik untuk dua dimensi atau 
tiga, properti Rotasi ditampilkan sebagai rangkaian angka, 0x + 
0,0º, di mana nilai pertama adalah jumlah atau waktu rotasi 
lengkap yang harus dilakukan, dan angka kedua adalah nilai 
derajat akhir. Jadi nilai 1x + 0,0º berarti berputar satu kali 
penuh dan berhenti di 0º, sedangkan nilai 2x + 45º berarti 
melakukan dua putaran penuh, lalu berhenti di 45º. 

D. Anchor Point : Ini adalah titik referensi atau registrasi dari sebuah layer. Ini 
adalah titik di mana semua transformasi (rotasi, gerakan, 
skala, dan sebagainya) terjadi di sekitarnya, sehingga 
terkadang disebut titik transformasi. 

E. Skala : Properti ini menentukan ukuran horizontal dan vertikal relatif 
dari sebuah layer sebagai nilai default ke 100 persen. Nilai di 
atas 100 persen membuat layer lebih besar, sedangkan nilai di 
bawah 100 persen membuatnya lebih kecil. 

Layer khusus, seperti camera dan lampu, memiliki properti yang sedikit berbeda. 
Misalnya, keduanya tidak memiliki Anchor Point dan sebagai gantinya memiliki properti 
bernama Point of Interest, yang menentukan area layar target yang diarahkan oleh 
cahaya atau camera. 

Setiap properti layer dapat dianimasikan secara independen dari yang lainnya. Setelah 
animasi diaktifkan, setiap perubahan pada properti tersebut, baik dengan menggunakan 
alat Transform di panel Komposisi atau dengan mengedit nilainya di Timeline, akan 
menghasilkan bingkai kunci baru di posisi playhead saat ini. Jika ada bingkai kunci yang 
ada di posisi playhead saat ini, Anda akan mengubah nilainya saat mengubah properti. 

 

K. Membuat Kinestasis Dengan Menganimasikan Anchor Point 

Kinestasis adalah teknik yang sangat populer saat bekerja dengan gambar diam. Kadang 
juga disebut efek Ken Burns atau Pan dan Zoom. Sebelum munculnya perangkat lunak 
modern, efeknya dibuat dengan menggeser camera video di atas gambar diam. Era saat 
ini, dalam motion graphic modern, efek ini paling sering dibuat ulang di After Effects 



dengan menganimasikan anchor point layer. 

Untuk inilah semua persiapan Anda sampai saat ini. Anda akan menganimasikan layer 
yang telah Anda tambahkan ke komposisi Anda untuk menciptakan efek kinestatik. 

Properti seperti Anchor point, Posisi, dan Skala memiliki banyak nilai untuk setiap bingkai 
utama. Nilai-nilai ini numerik dan sesuai dengan objek di layar Anda, yang pada 
gilirannya dapat dianimasikan. Misalnya dengan Posisi, Anda akan memiliki nilai X 
(horizontal) dan nilai Y (vertikal). Mengatur dua bagian ini dengan nilai berbeda, Anda 
dapat menganimasikan objek secara horizontal, vertikal, atau keduanya. Sedangkan 
layer tiga dimensi akan memiliki nilai ketiga dengan menambah posisi sumbu Z. 

1. Jika belum terbuka, buka proyek yang Anda simpan sebelumnya. Proyek ini memiliki 
komposisi gambar bertipe .jpg dan .png yang telah diimpor sebelumnya, bersama 
dengan folder yang dibuat secara otomatis untuk mengatur setiap layer file. 

2. Di panel Proyek, klik dua kali pada Vehicle comp untuk mempreviewnya di panel 
Komposisi dan Timeline. Pada latihan sebelumnya, dua layer ditambahkan ke comp: 
Cloud dan background. Layer harus dimodifikasi sedikit sebelum Anda dapat 
menerapkan efek Kinestasis. Kedua layer jauh lebih besar dari comp sebenarnya dan 
harus diperkecil agar berguna, dan layer Cloud harus dipindahkan ke posisi yang 
tepat untuk efeknya. 

3. Di panel Timeline, klik pada layer Cloud untuk menyorotnya. Tahan tombol Shift dan 
klik pada layer latar belakang untuk menambahkannya ke pilihan Anda. 

4. Klik reveal triangle di sebelah kiri nama layer Cloud untuk melihat properti Transform 
untuk layer tersebut. Karena kedua layer dipilih, dua properti Transform terungkap. 

 
Gambar 3.17. Tombol untuk Mengungkap Properti Layer 

 

5. Klik pada reveal triangle untuk properti Transform layer Cloud untuk melihat lima 
properti individual yang melekat pada semua layer yang terlihat. 

 
Gambar 3.18. Transform Properti pada Layer 

 

Banyak properti layer dan efek disembunyikan di dalam grup properti seperti 
Transform, yang harus Anda ungkapkan untuk mengaksesnya. 

6. Klik pada nilai Skala untuk membuatnya dapat diedit. Ketik 70 di bidang teks numerik 



dan tekan tombol Enter (Windows) atau Return (Mac OS) pada keyboard Anda. 
Karena banyak layer dipilih saat Anda melakukan ini, keduanya skala layer turun 
hingga 70 persen dari ukuran aslinya. 

7. Tekan Ctrl+Shift+A (Windows) atau Command+Shift+A (Mac OS) untuk membatalkan 
pilihan semua layer. Kemudian klik pada layer Cloud untuk memilihnya. 

8. Untuk layer Cloud, dalam kategori Posisi, klik pada nilai untuk Posisi X (nilai pertama 
yang tercantum untuk Position properti) dan ubah menjadi 100. Kemudian klik pada 
nilai untuk Posisi Y (nilai kedua yang tercantum untuk Position properti) dan ubah ke 
100. Tekan Enter atau Return untuk melakukan perubahan ini. 

 
Gambar 3.19. Perubahan Tranform Position pada Layer 

 

Hingga saat ini, Anda telah mengubah properti layer secara global. Ini mengubahnya 
ke nilai yang sama untuk seluruh durasi komposisi. Sekarang Anda akan 
menganimasikan properti Anchor Point untuk membuat gerakan. 

9. Jika kursor Anda tidak berada di awal (0;00;00;00) dari Timeline, klik kolom Current 
Time di pojok kiri atas Timeline untuk menyorotnya, ketikkan angka 0 (nol), dan 
tekan tombol Enter (Windows) atau Return (Mac OS) untuk memindahkan playhead 
kembali ke awal Timeline. 

10. Klik Time-Vary Stopwatch di sebelah kiri properti Anchor Point untuk mengaktifkan 
animasi di properti ini. Ini akan membuat keyframe pada posisi playhead saat ini. 

 
Gambar 3.20. Mengatur Anamasi Layer Cloud 

 



Keyframes menyimpan nilai properti. Untuk membuat animasi, Anda akan membuat 
keyframe kedua di Timeline dengan nilai yang berbeda. Program kemudian akan 
menganimasikan perubahan untuk Anda. 

11. Klik bidang Waktu Saat Ini untuk menyorotnya, ketik 1000 ke dalam bidang teks 
numerik, dan klik area kosong Timeline untuk memindahkan playhead ke 10 detik. 

12. Klik pada nilai X dari properti Anchor Point dan ubah ke 185. Ini membuat anchor 
point kedua dan melengkapi pasangan yang diperlukan untuk menganimasikan 
properti. Klik Masuk atau Kembali untuk menerima 

 
Gambar 3.21. Menambahkan Keyframe dalam Transform Position 

 

13. Klik pada playhead dan seret ke awal Timeline. Tekan bilah spasi pada keyboard Anda 
untuk mempreview animasi. Layer Cloud bergeser ke kanan, sedangkan layer latar 
belakang statis. 

14. Simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl+S (Windows) 
atau Command+S (Mac OS) pada keyboard. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

  

L. Animasi Rotasi  

Rotasi animasi memungkinkan Anda memutar layer di sekitar sumbu z pusatnya. Anda 
dapat menggunakannya untuk mensimulasikan pendulum yang berayun, jarum jam, 
atau lempar koin. Dalam latihan ini, Anda akan menganimasikan layer dalam komposisi 
Rotator untuk memutar serangkaian lingkaran dekoratif di sekitar titik tengah yang 
sama. 

Dalam latihan ini, Anda akan bekerja dengan salah satu komposisi Illustrator yang telah 
ditambahkan ke proyek di awal pelajaran. 

1. Buat project dan composition baru, dengan pengaturan seperti sebelumnya atau 
pengaturan sendiri. Beri nama composition dengan nama Rotator. 

2. Klik dan tahan Rectangle tool, klik Ellipse tool. 

   
Gambar 3.22. Tools Membuat Objek Shape Bentuk Lingkaran 



Buat seperti gambar di bawah ini : 

 
Gambar 3.23. Gambar Shape Layer 1 

 

Duplikasi layer Shape Layer 1 menggunakan pintasan Ctrl+D atau klik menu Edit, klik 
Duplicate sebanyak 3 kali. Tentukan nilai transform Rotation dalam : 

a. Shape Layer 2 menjadi 0x90° 

b. Shape Layer 3 menjadi 0x45° 

c. Shape Layer 2 menjadi 0x-45° 

   
Gambar 3.24. Bentuk Shape Layer Setelah di Duplikasi 

 

3. Di Timeline, klik layer pertama, Shape Layer 1, untuk menyorotnya. Untuk 
mengungkapkan properti Rotasi, tekan tombol R pada keyboard Anda. 

4. Pastikan playhead Anda berada di awal Timeline (0;00;00;00) dan klik Time-Vary 
Stopwatch di sebelah kiri Rotasi untuk mengaktifkan animasi untuk properti ini dan 
membuat keyframe pertama. 

5. Seret playhead ke akhir Timeline (0;00;05;00). Untuk animasi ini Anda akan 
membuat objek berputar lima kali. Klik angka pertama pada nilai rotasi, ubah 
menjadi 5, dan tekan tombol Enter (Windows) atau Return (Mac OS) pada keyboard 
Anda. Nilai properti Rotasi sekarang seharusnya tertulis 5x+0,0º. Ini menyebabkan 
objek berputar sekali setiap satu detik untuk menyelesaikan lima putaran yang 
ditugaskan. 

6. Pindahkan playhead kembali ke awal Timeline dan tekan bilah spasi pada keyboard 
untuk mempreview animasi. Cincin berputar searah jarum jam lima kali antara awal 
timeline sampai posisi keyframe ke-2, atau kira-kira satu putaran setiap 1 detik. 
Tekan bilah spasi lagi untuk menghentikan rotasi. 

7. Di Timeline, klik pada layer kedua, Shape Layer 2, untuk menyorotnya dan 



mengungkapkan properti Rotasi dengan menekan tombol R pada keyboard Anda. 

 

8. Sekali lagi, pastikan playhead Anda berada di asal Timeline dan klik Time-Vary 
Stopwatch di sebelah kiri Rotasi untuk mengaktifkan animasi untuk properti ini dan 
membuat keyframe. 

 
Gambar 3.25. Dua Keyframe untuk Animasi Shape Layer 1 

 

M. Menggunakan Layer Parenting Untuk Memudahkan Pengulangan 

Animasi objek yang digunakan dalam latihan ini sebenarnya terdiri dari rangkaian 
lingkaran konsentris, masing-masing dengan desainnya sendiri dan masing-masing pada 
layernya sendiri. Anda baru saja menganimasikan dua layer pertama yang bergerak 
berlawanan arah, tapi bagaimana dengan yang lainnya? Jika Anda ingin melanjutkan 
pola dan membuat setiap lingkaran berputar ke arah yang berlawanan dengan 
pendahulunya, Anda dapat menambahkan keyframe ke semuanya secara manual, tetapi 
ini akan sedikit membosankan. Semua keyframe individu ini juga akan menciptakan 
mimpi buruk jika Anda memutuskan untuk mengubah pengaturan waktu animasi nanti. 
Situasi seperti inilah di mana parenting menjadi penting. 

Parenting adalah alat untuk menghilangkan pengulangan yang sering melekat pada 
animasi yang kompleks. Dengannya Anda dapat menghubungkan layer-layer sehingga 
satu layer akan mengikuti layer lainnya. Layer anak mewarisi properti Posisi, Rotasi, 
Anchor point, dan Skala dari layer induknya, tetapi bukan Opacity. Keuntungan nyata 
dari parenting adalah bahwa sementara layer mengikuti pergerakan induknya, 
pergerakan ini relatif, sehingga setiap properti masih dapat memiliki keyframe 
independennya sendiri. 

Pada latihan ini, semua layer bernomor ganjil akan menjadi anak dari layer 1, sedangkan 
semua layer yang bernomor genap akan menjadi anak dari layer 2. 

1. Di Timeline, klik pada layer nomor 3, yang bernama Shape Layer 3, untuk 
menyorotnya. Tahan tombol Ctrl (Windows) atau Command (Mac OS) jika ingin 
menyorot layer yang tidak berurutan. 

2. Pada kolom Induk di sebelah kanan panel Layer Switches, klik menu drop-down 
untuk layer 3 dan pilih 1. Shape Layer 1 sebagai induk untuk semua layer bernomor 
ganjil. 

 
Gambar 3.26. Parenting Layer 



Ketika banyak layer disorot, setiap perubahan yang dilakukan pada properti salah 
satunya akan dilakukan pada semuanya. 

3. Klik pada layer 4 untuk menyorotnya. Pada panel Parent, klik menu drop-down untuk 
layer 4 dan pilih 2. Shape Layer 2 sebagai induk untuk semua layer bernomor genap. 

Karena parenting menciptakan pergerakan yang relatif terhadap pergerakan layer 
asli, Anda dapat menyesuaikan properti setiap layer sesuai kebutuhan. 

4. Pindahkan playhead ke 0, lalu tekan bilah spasi pada keyboard untuk melihat 
preview animasi. Tekan bilah spasi lagi untuk menghentikan animasi, lalu simpan file 
Anda dengan memilih File > Simpan. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

 

N. Menggunakan Mode Pencampuran 

Bagi pengguna aplikasi seperti Adobe Photoshop dan Illustrator, blending mode mungkin 
sudah menjadi topik yang sangat familiar. Mereka memungkinkan Anda untuk 
mengontrol bagaimana konten dari dua atau lebih layer bercampur atau menyatu. 
Secara default, layer berinteraksi dengan cara yang sangat mudah: area buram dari layer 
hanya menutupi dan menyembunyikan apa pun di bawahnya. Tapi Anda bisa 
mengubahnya untuk membuat komposisi yang lebih menarik. Dalam latihan ini, Anda 
akan menambahkan layer bentuk baru ke comp dan menggunakan mode blending untuk 
membuatnya mewarnai layer di bawahnya. 

1. Jika belum terbuka, buka proyek berisi komposisi vehicle yang Anda simpan di awal 
pelajaran ini. Di panel Project, klik dua kali pada Vehicle comp untuk 
mengaktifkannya di panel Composition dan Timeline. Mengklik dua kali pada 
komposisi di panel Proyek akan membukanya di Panel Komposisi dan Timeline. 

2. Batalkan pilihan semua layer di Timeline dengan memilih Edit > Deselect All. 

3. Dari panel Tools di bagian atas antarmuka After Effects, klik Rectangle tool untuk 
aktifkan tool Anda. Ini mengaktifkan opsi Fill dan Stroke di bagian kanan kanan. 

 
Gambar 3.27. Shape Tool 

 

Mengaktifkan shape tool secara otomatis mengaktifkan properti untuk fill untuk 
warna area dan stroke sebagai warna garis. 

4. Klik pada teks Fill di panel Tool untuk membuka kotak dialog Fill Options, dan pilih 
tombol kedua untuk mengisi shape baru dengan Solid Color. 

Konfirmasikan bahwa menu drop-down diatur ke Normal, Opacity 100 persen, dan 
kotak centang Preview diaktifkan, dan klik OK untuk menutup kotak dialog. 



 
Gambar 3.28 Fill Option dalam Shape Tool 

 
Isi adalah warna interior bentuk vektor dan Anda dapat mengaturnya menjadi warna 
solid, gradien linier atau radial, atau tidak sama sekali. Bentuk dapat diberi warna 
isian dan/atau garis sebelum atau setelah dibuat. 

5. Klik pada kotak Fill Color di samping kata Fill untuk membuka kotak dialog Shape Fill 
Color. Pilih warna biru tua sebagai Fill dengan mengatur nilai RGB ke R:5, G:16, 
B:103. Klik OK untuk menutup kotak dialog. 

 
Gambar 3.29. Color Editor dalam Shape Tool 

 

Alih-alih mengetikkan nilai warna, Anda dapat memilih warna secara visual 
menggunakan penggeser dan kotak warna di sisi kiri dialog. 

6. Klik pada teks Stroke pada panel Tool untuk membuka kotak dialog Stroke Options, 
dan pilih tombol pertama untuk mengatur Stroke bentuk baru menjadi None. 
Konfirmasikan bahwa kotak centang Preview diaktifkan dan klik OK untuk menutup 
kotak dialog. Stroke adalah garis tepi bentuk vektor, dan dengan memilih None, 
Anda menonaktifkannya sehingga bentuk ini hanya memiliki warna Isian. 

7. Klik dua kali pada Rectangle tool di panel Tools untuk membuat persegi panjang 
dengan ukuran yang sama dengan komposisi. Karena layer baru ditempatkan di atas 
dua layer sebelumnya, seluruh panel Komposisi diisi dengan warna biru. 

 
Gambar 3.30. Layer Baru Berisikan Shape Rectangle 

 
Mengklik dua kali pada alat bentuk apa pun akan secara otomatis membuat bentuk 
yang sesuai dengan ukuran komposisi. 



8. Klik pada layer Shape baru untuk menyorotnya. Tekan tombol Enter (Windows) atau 
Return (Mac OS) pada keyboard Anda untuk membuat nama layer dapat diedit dan 
mengubahnya menjadi Overlay. Tekan Enter/Return lagi. 

9. Klik pada tombol Expand atau Collapse Transfer Controls Pane di sudut kiri bawah 
panel Timeline untuk menampilkan kontrol Mode (Blending), dan ubah mode layer 
Overlay dari Normal ke Soft Light. Ini memberi komposisi warna ungu yang lembut. 

10. Di Timeline, seret layer Overlay di bawah layer Cloud sehingga pewarnaan warna 
hanya memengaruhi layer Background. 

Layer dapat diseret ke atas dan ke bawah di Timeline untuk mengubah urutan 
penumpukan kapan saja. 

 
Gambar 3.31. Pengaturan Blending Mode 

 

Sekali lagi, klik tombol Perluas atau Ciutkan Panel Kontrol Transfer ( ) di sudut kiri 
bawah panel Timeline untuk menyembunyikan Mode (Blending) kontrol. 

11. Simpan file Anda dengan memilih File > Save. 

Jangan tutup proyek ini; Anda akan terus mengerjakannya di bagian selanjutnya dari 
pelajaran ini. 

 

O. Memahami Nested Komposisi Dan Precomposing 

Proyek kompleks jarang dibuat sebagai komposisi tunggal; sebaliknya, itu adalah hasil 
dari beberapa comps yang dianimasikan secara individual. Proses menempatkan satu 
comp di dalam yang lain disebut nesting. Bersarang memungkinkan Anda membuat 
animasi berurutan atau berturut-turut karena setiap komponen memiliki Timeline 
independennya sendiri. Precomposing adalah teknik yang memungkinkan Anda 
membuat comp dari layer yang sudah ada di Timeline Anda dan mengganti layer 
tersebut dengan comp baru. Ini bisa menjadi teknik yang sangat membantu ketika Anda 
ingin menggabungkan beberapa layer menjadi komposisi baru, sehingga Anda dapat 
menerapkan efek atau transformasi ke semuanya secara bersamaan, atau sebagai alat 
untuk menjaga agar panel Timeline tetap teratur. 

  



P. Menambahkan Nested Komposisi  

Dalam latihan ini, Anda akan menambahkan Rotator dan komposisi logo dison yang 
Anda animasikan di awal pelajaran ke komposisi Dison Intro. 

1. Jika belum terbuka, buka proyek yang berisi komposisi Rotator yang telah Anda 
simpan sebelumnya dalam pelajaran ini, dan klik dua kali pada Rotator comp untuk 
mengaktifkannya di panel Composition dan Timeline. 

2. Terlihat dalam komposisi Rotator terdapat Shape Layer 1 sampai dengan Shape 
Layer 4. BUka properti Rotation Shape Layer 2, tempatkan playhead di frame awal. 
Hilangkan pengaturan animasi Shape Layer 2 dengan klik pada icon stopwatch. 

Ubah Parenting Shape Layer 2, 3, 4 ke Shape Layer 1. INi untuk menentukan gerakan 
animasi Shape Layer 2,3,4 mengikuti gerakan Shape layer 1. 

3. Ukuran dan posisi layer baru perlu diatur agar lebih sesuai dengan komposisi ini. 
Dengan layer Shape Layer 1 terpilih, tekan tombol P pada keyboard Anda untuk 
menampilkan properti Position. Selanjutnya, tahan tombol Shift dan tekan tombol S, 
untuk membuka properti Skala juga. 

4. Ikon Tautan Rantai di sebelah kanan nilai Skala membatasi proporsi, memastikan 
bahwa jika Anda mengubah skala horizontal, skala vertikal akan berubah dalam 
jumlah relatif, mempertahankan proporsional tampilan layer. Pastikan bahwa opsi 
Constrain Proporsions diaktifkan dengan mengonfirmasi ikon Tautan Rantai terlihat 
dan mengubah salah satu dari nilai Skala menjadi 75 persen. Meski masih besar, ini 
akan membuatnya menjadi ukuran yang lebih mudah diatur. 

5. Pilih semua layer (Shape Layer 1-4) gunakan tombol Shift atau Ctrl, setelah semua 
terpilih tekan Ctrl+ D untuk menduplikasi semua layer yang terpilih. 

6. Terlihat layer Shape Layer 4-8 berada diantara Shape Layer 1-4. Ini akan 
membingungkan ketika akan mengatur properti atau menganimasikannya. 

7. Klik kanan pada Shape Layer 8, klik Pre-Compose untuk mengubah semua layer yang 
terpilih menjadi komposisi baru dan berada dalam komposisi yang aktif. Berikan 
nama komposisi bunga kecil di kotak isian New Composition Name, kemudian klik 
OK. Terlihat dalam komposisi Rotator satu komposisi baru bernama bunga kecil. 

 
Gambar 3.32. Komposisi Baru Hasil dari Perintah Pre-Compose 

 

8. Lakukan yang sama untuk Shape Layer 1-4 dan berikan nama komposisi dengan 
bunga bersar. 



9. Pilih layer bunga kecil, tekan tombol S untuk menampilkan properti Scale, ubah 
ukuran layer bunga kecil menjadi 60. Perubahan ukuran tidak terlihat dalam layer 
bunga kecil dikarenakan layer bunga kecil memiliki warna yang sama dengan layer 
bunga besar. 

10. Klik dobel layer bunga kecil, akan terbuka komposisi bunga kecil di Timeline dan 
Composition. Sekarang tampil kembali Shape Layer 5-8. Pilih semua layer dan ubah 
warnanya menggunakan kotak Fill seperti pembahasan sebelumnya. 

Tidak hanya warna yang sama antara layer bunga besar dan layer bunga kecil, 
melainkan animasinya juga memiliki gerakan yang sama. 

11. Klik dalam Shape Layer 6, tekan R dakam keyboard dan tempatkan playhead diawal 
frame klik ikon stopwatch untuk menghilangkan animasinya, kemudian ubah 
parenting layer menjadi Shape Layer 5 pada semua layer. 

 
Gambar 3.33. Perubahan Warna dan Animasi Layer di Komposisi Bunga Kecil 

 

Penggunaan perintah di atas menunjukkan proses pembuatan Nested Composition atu 
dikenal juga dengan KOmposisi Bersarang, dimana dalam satu komposisi terdapat 
komposisi lain di dalamnya untuk memudahkan pengaturan, maupun animasi komposisi 
yang terdiri dari banyak layer. 

Seperti terlihat dalam hasil, pengubahan ukuran Shape Layer 5-8 tidak perlu dilakukan 
satu persatu, melainkan bias dilakukan langsung dari komposisi bunga kecil. Demikian 
juga pengaturan property lain seperti Anchor Point, Position, dan lainnya. 

 
Gambar 3.34. Hasil Akhir 



BAB IV 

MASKING & Track Matte 
 

A. Bekerja dengan Mask 

After Effects, mask adalah jalur berbasis vektor yang digunakan untuk menyembunyikan 
atau mengungkapkan bagian dari layer. Jika Anda menggunakan aplikasi seperti Adobe 
Photoshop dan Illustrator, Anda akan menemukan mask di After Effects mirip dengan 
clipping mask di aplikasi tersebut, dengan pengecualian bahwa mask di After Effects 
dapat ditambahkan ke video dan juga gambar diam. Anda dapat membuat mask dari 
objek primitif sederhana seperti persegi panjang dan lingkaran, mengimpornya dari 
program menggambar berbasis vektor, seperti Adobe Illustrator, atau membuatnya dari 
awal di After Effects menggunakan tool pena dan bentuk. Seperti objek vektor lainnya, 
mask terdiri dari serangkaian vertice yang dihubungkan oleh segmen garis. Verteks ini 
mewakili satu titik dalam ruang dan digunakan untuk menambatkan setiap segmen garis 
sehingga Anda dapat membuat garis dan bentuk. Anda dapat menganimasikan vertice 
ini untuk membuat mask yang mengubah bentuk dan ukurannya agar sesuai dengan 
konten video Anda. Misalnya, Anda dapat menganimasikan Mask Path bingkai demi 
bingkai untuk membuat mask yang bergerak mengikuti jalur awan yang melintasi langit 
atau mobil yang melaju di sepanjang jalan. 

 
Gambar 4.1. A. Vertex. B. Direction handle. C. Line segment. 

 

Seperti jalur vektor di aplikasi lain, mask di After Effects dapat memiliki vertice sudut dan 
Bézier. Ini adalah vertice yang menentukan panjang dan bentuk ruas garis di antara 
mereka. Titik sudut selalu membuat garis lurus, sedangkan titik Bézier digunakan untuk 
membuat segmen garis melengkung. Kelengkungan kurva Bézier ini ditentukan oleh 
pegangan arah yang melekat pada setiap vertice, seperti yang ditunjukkan pada ilustrasi 
di bawah ini. 

 

B. Memahami Properti Mask 

Anda menggunakan mask untuk mengontrol transparansi layer. Mask pertama yang 
Anda buat memengaruhi alpha channel layer, dan mask tambahan apa pun yang Anda 



buat berinteraksi dengan semua mask di atas yang pertama. Semua mask memiliki 
empat properti yang dapat Anda modifikasi dan animasikan: 

1. Mask Path : Properti ini menentukan posisi titik-titik yang membentuk mask. 
Properti ini dianimasikan apakah Anda ingin memindahkan 
semua titik mask atau hanya sebagian saja, untuk membuat efek 
mask bergerak di sekitar layer atau mengubah bentuk. 

2. Mask Feather : Properti ini menentukan kelembutan tepi mask. Sebagai hasil 
dari feather, tepi mask menjadi lebih transparan, menciptakan 
efek layer dengan tepian yang memudar ke latar belakangnya. 

3. Mask Opacity : Properti ini menetapkan jumlah pengaruh yang dimiliki mask 
terhadap visibilitas layer tempat ia berada. Saat Anda menyetel 
properti ini pada nilai default 100 persen, layer yang dilingkupi 
mask akan berada pada opacity penuh. 

4. Mask Expansion : Anda dapat menggunakan properti ini untuk memperluas atau 
mengecilkan tepi mask. 

Selain properti di atas, setiap mask juga memiliki pengaturan mode yang mengontrol 
cara interaksinya dengan mask di atasnya dalam urutan penyusunan : 

1. None : Saat Anda menyetel mode ke Tidak Ada, mask tidak 
memengaruhi alpha channel layer. Pengaturan ini berguna saat 
Anda menggunakan mask sebagai target efek atau sebagai jalur 
gerakan untuk teks. 

2. Add : Efek mask ditambahkan ke mask di atasnya dalam urutan susun. 
Pengaturan Tambah membuat konten layer terlihat. 

3. Subtract : Efek mask dikurangi dari mask di atasnya, membuat lubang. Jika 
itu adalah satu-satunya mask di layer, pengaturan ini 
menyembunyikan apa pun di dalam mask. 

4. Intersect : Efek mask ini menambah yang di atasnya. Di area di mana mask 
tidak tumpang tindih dengan mask di atasnya, hasilnya adalah 
opasitas penuh. Namun, ketika semua mask pada layer diatur ke 
Intersect, hanya area yang dibentuk oleh tumpang tindih mask 
ini yang terlihat. 

5. Lighten : Efek mask ini ditambahkan ke mask di atasnya. Saat beberapa 
mask berpotongan, nilai Mask Opacity tertinggi digunakan untuk 
semua area yang tumpang tindih. 

6. Darken : Efek mask ini ditambahkan ke mask di atasnya. Saat beberapa 
mask berpotongan, nilai Mask Opacity terendah digunakan 
untuk semua area yang tumpang tindih. 

7. Difference : Efek mask ini menambah yang di atasnya. Saat menggunakan 
banyak mask pada satu layer, mask dengan pengaturan ini 
berperilaku seolah-olah diatur ke Tambahkan saat tidak 
tumpang tindih. Saat tumpang tindih dengan mask lain, 



pengaturan ini memungkinkan mask berperilaku seolah-olah 
diatur ke mode Kurangi. 

Efek kumulatif dari mode ini bervariasi, tergantung pada jumlah mask pada layer, 
posisinya dalam urutan tumpukan mask, dan mode masing-masing. Cara terbaik untuk 
merasakan bagaimana berbagai mode mask akan berinteraksi adalah dengan 
bereksperimen dengannya. 

 

C. Membuat Mask dengan Shape Tool 

Anda dapat menggunakan tool bentuk di After Effects untuk membuat mask atau layer 
bentuk. Mereka membuat bentuk sederhana seperti persegi panjang dan lingkaran, dan 
bentuk yang lebih kompleks seperti poligon dan bintang. Setelah dibuat, mask ini dapat 
diubah, dimodifikasi, dan dianimasikan. Dalam latihan ini Anda akan membuat proyek 
baru, mengimpor file video, dan membuat mask persegi panjang untuknya. 

1. Jika Anda telah membuka After Effects, Anda dapat melompat ke langkah 2; jika 
belum, pilih File > New > New Project. Jika Anda memiliki proyek lain yang terbuka 
dan belum menyimpannya, Anda akan diminta untuk melakukan penyimpanan. 

2. Dalam proyek baru, pilih File > Import > File. Di kotak dialog Impor, arahkan ke folder 
tempat footage akan digunakan. Klik dua kali pada file untuk mengimpornya. Di 
panel Project, seret item footage ke tombol New Composition di bagian bawah 
panel. Ini membuat comp baru yang cocok dengan properti file video. 

Menyeret suatu file apa pun ke tombol Komposisi Baru akan membuat komposisi 
baru yang sesuai dengan dimensi dan panjang rekaman tersebut. Dengan Komposisi 
baru yang aktif di panel Timeline, pilih Composition > Composition Setting untuk 
membuka kotak dialog Pengaturan Komposisi. Jika Start Time Code Comp tidak 
menyebutkan 0;00;00;00, ubahlah sekarang. Setelah selesai, klik OK untuk menutup 
kotak dialog. 

Anda juga dapat menggunakan pintasan keyboard untuk membuka kotak dialog 
Pengaturan Komposisi. Pada Composition yang terbuka, tekan Ctrl+K (Windows) atau 
Cmd+K (Mac OS). 

 
Gambar 4.2. Membuat Composition Baru 

 



3. Di panel Timeline, klik pada layer footage yang telah ada untuk menyorotnya, dan 
tekan tombol Enter (Windows) atau Return (Mac OS) pada keyboard untuk membuat 
bidang nama dapat diedit. Ganti nama layer ini Bahan 1. 

4. Pilih layer bahan 1 sehingga terlihat tersorot, klik Rectangle tool untuk 
mengaktifkannya, lalu klik dan seret di panel Komposisi untuk membuat mask pada 
layer ini. Tidak peduli seberapa besar Anda membuat mask; Anda dapat mengubah 
ukurannya kemudian. Untuk membuat mask, Anda harus memilih layer sebelum 
menggunakan shape tool. 

Saat Anda bekerja di panel Komposisi, mask baru sedang dibuat dan ditambahkan ke 
panel Timeline. Anda sekarang akan melihat Mask horisontal di bawah nama layer 
bersama juga tamil properti mask path-nya. 

 
Gambar 4.3. Rectangle Mask dalam Composition 

 

5. Pilih File > Simpan Sebagai. Arahkan ke folder ae05lessons di hard drive Anda. Di 
kolom Save As, beri nama file Creating Shape Masks-working.aep dan klik Save. 
Jangan tutup file ini; Anda akan membutuhkannya di bagian selanjutnya dari 
pelajaran ini. 

 

D. Memilih dan Memanipulasi Mask 

Jika Anda selalu dapat memodifikasi mask Anda dengan sempurna untuk pertama 
kalinya, Anda pasti orang yang sangat beruntung. Kemungkinan besar setelah Anda 
membuat mask, Anda harus mengedit ukuran atau posisinya setidaknya sekali. 
Mengedit mask mungkin tampak sedikit membingungkan bagi pemula, tetapi dengan 
sedikit latihan Anda akan menguasainya. Jika Anda terbiasa dengan program lain yang 
bekerja dengan grafik desain seperti Adobe Illustrator dan Photoshop, Anda akan 
terbiasa memiliki dua kursor, satu untuk memanipulasi seluruh jalur dan yang lainnya 
untuk mengedit setiap vertice. After Effects sedikit berbeda karena posisi mask di layar, 
dan posisi setiap titik, disesuaikan menggunakan selection tool. Dalam latihan ini, Anda 
akan menggunakan grid proporsional sebagai panduan untuk memperhalus bentuk dan 
ukuran mask yang Anda buat sebelumnya. 



1. Dengan proyek telah dibuka sebelumnya, pilih Proportional Grid dari drop-down 
menu Grid and Guide Options di bagian bawah panel Composition. 

2. Klik pada layer bahan 1 di panel Timeline untuk menyorotnya. Ini menampilkan tepi 
Mask horisontal bersama dengan verticenya. 

3. Jika belum aktif, klik Selection tool, lalu di panel Composition, klik dua kali pada salah 
satu vertice mask. Ini menyebabkan kotak pembatas muncul di sekitar mask. Kotak 
pembatas menentukan area batas mask dan digunakan untuk memindahkan, 
memutar, atau menskalakannya. 

 
Gambar 4.4. Menampilkan Propotional Grid dalam Composition 

 

Titik kontrol yang terletak di sekitar tepi kotak pembatas mask digunakan untuk 
menskalakannya. Namun, jika Anda memposisikan selection tool di luar kotak ini, itu 
akan menjadi kursor melengkung yang memungkinkan Anda memutar mask. 
Mengklik dan menyeret pada titik sudut menskalakan mask secara horizontal dan 
vertikal, sedangkan titik di bagian atas, bawah, dan samping membatasi penskalaan 
ke sumbu itu. 

4. Gunakan Selection tool, sesuaikan titik pembatas kotak agar cocok dengan contoh di 
bawah ini. Bentuk dan posisi baru mask menjadikannya tinggi dari dua baris pertama 
dari grid proporsional, sementara lebarnya harus diperpanjang sedikit di luar comp 
ke setiap sisi. Setelah Anda benar-benar mengubah ukuran mask, tekan tombol Enter 
(Windows) atau Kembali (Mac OS) pada keyboard Anda untuk mengonfirmasi 
perubahan dan untuk menghapus kotak pembatas dari sekitar mask. Animasi yang 
pada akhirnya akan Anda buat dalam proyek ini akan melibatkan mask ini bergerak 
ke atas dan ke bawah untuk mengungkapkan bagian dari layer video. Inilah sebabnya 
mengapa tingginya harus lebih tepat daripada lebarnya. 

Mengklik dan menyeret titik sudut kotak pembatas memungkinkan Anda 
menskalakannya baik secara horizontal maupun vertikal secara bersamaan 
sementara titik tengah membatasi skala ke arah tertentu. 

5. Dengan layer bahan 1 masih terpilih, klik pada Rectangle tool ( ) untuk membuatnya 
aktif. Klik dan seret dengan kursor Anda di panel Komposisi untuk membuat mask 



baru di sisi kiri panel yang merupakan lebar dari dua kolom pertama grid, dan 
tingginya sedikit melampaui batas komposisi. Anda dapat mengubah perbesaran 
panel Comp untuk melihat tepi atas dan bawah bingkai video. 

 
Gambar 4.5. Masking dalam Panel Composition 

 

Satu layer dapat memiliki banyak mask yang diterapkan padanya, ini dapat 
digunakan untuk membuat efek visual yang menarik karena mask yang berbeda 
berinteraksi satu sama lain. 

6. Simpan file Anda dengan memilih File > Save. Jangan tutup file ini; Anda akan 
membutuhkannya di bagian selanjutnya. 

Jika Anda menggunakan Adobe Illustrator, Anda akan mengetahui bahwa Anda dapat 
membawa path vektor dari Illustrator ke After Effects menggunakan perintah copy dan 
paste sederhana. Yang harus Anda lakukan adalah memilih shape vektor Anda di 
Illustrator dan menggunakan perintah Copy (Edit > Copy) untuk menyimpannya di 
clipboard komputer. Kemudian di After Effects, pilih layer yang ingin Anda terapkan 
masknya dan gunakan perintah Tempel (Edit > Tempel). Jalur Anda dari Illustrator akan 
diterapkan sebagai mask di After Effects. 

 

E. Menganimasikan Posisi Mask 

Dari empat properti mask yang dijelaskan sebelumnya, tidak satu pun dari mereka yang 
bernama Position Mask. Karena merupakan bagian dari sebuah layer, mask tidak 
memiliki jenis properti Transform yang sama dengan layer. Sebagai gantinya, properti 
Mask Path digunakan untuk menganimasikan semua properti transformasi mask: rotasi, 
posisi, dan skala. Hal ini dilakukan dengan menyimpan keyframe untuk posisi masing-
masing vertex di sepanjang jalur mask. Jadi, saat vertex dipindahkan baik secara terpisah 
(seperti saat Anda mengubah bentuk jalur) atau sebagai grup (seperti saat Anda 
menskalakan, memutar, atau memindahkannya), properti Mask Path yang terpengaruh. 
Dalam latihan ini, Anda akan menganimasikan posisi dan bentuk dari dua mask yang 
Anda buat sebelumnya untuk menampilkan video. 

1. Dengan proyek sebelumnya yang terbuka, sorot layer bahan 1 dan tekan tombol M 
pada keyboard dua kali berturut-turut dengan cepat untuk menampilkan semua 
properti Mask horisontal dan Mask vertikal. 



Menekan tombol M sekali hanya mengungkapkan properti Mask Path dari layer yang 
dipilih saat ini. 

2. Di panel Timeline, klik Mask horisontal untuk menyorotnya, lalu tekan tombol Enter 
(Windows) atau Return (Mac OS) pada keyboard Anda untuk membuat bidang edit 
nama. Ganti namanya mask horisontal. Klik Mask vertikal untuk menyorotnya dan 
tekan Enter/Return lagi, dan beri nama mask vertikal. Tekan kembali tombol Enter 
(Windows) atau Return (Mac OS) pada keyboard untuk mengonfirmasi perubahan. 

3. Pindahkan playhead ke awal Timeline dan klik Time-Vary Stopwatch di samping 
properti Mask Path dari kedua mask untuk mengaktifkan animasi pada properti ini 
dan membuat keyframe pertama. Meskipun mungkin tampak berlawanan dengan 
intuisi, menganimasikan properti Mask Path akan memengaruhi posisinya. 

4. Pindahkan playhead ke tanda 1 detik (0;00;01;00) pada Timeline. Dalam Timeline, 
klik mask bernama mask horisontal; di panel Komposisi mask telah tersorot dan 
memilih semua bingkai utamanya. Di panel Komposisi, tempatkan selection tool di 
sudut kanan bawah mask. Selection tool menjadi mata panah tanpa batang. Ikon ini 
menunjukkan bahwa tool akan memindahkan vertex yang dipilih. 

 
Gambar 4.6. Mengatur Properti Masking dan Keyframe 

 

Klik pada titik dan seret mask ke bagian bawah komposisi. Hentikan saat mask 
menempati dua baris terbawah dari grid proporsional. Setelah Anda mulai 
menggerakkan mask, menekan dan menahan tombol Shift pada keyboard Anda 
sambil menggerakkan mask akan membiarkan Anda membatasi gerakan ke jalur 
yang benar-benar horizontal. 

Saat menggunakan tombol shift untuk membatasi pergerakan objek di After Effects, 
penting untuk menekan dan menahan tombol shift hanya setelah Anda mulai 
memindahkan satu atau beberapa objek. 

Saat semua vertex dalam mask disorot, selection tool akan memindahkan mask 
sebagai objek tunggal. 

5. Di Timeline, klik pada mask bernama mask vertikal. Sama seperti sebelumnya, ini 
menyoroti mask di panel Komposisi dan memilih semua bingkai utamanya. Di panel 
Komposisi, tempatkan selection tool Anda di sudut kanan bawah mask. Klik pada 



vertex dan seret mask ke kanan komposisi. Hentikan saat mask menempati dua 
kolom kanan dari grid proporsional. 

Penting untuk memastikan bahwa semua vertex dalam mask disorot saat Anda 
mencoba memindahkannya di panel Komposisi. 

 
Gambar 4.7. Mengubah Posisi Masking di Frame Baru 

 

6. Pindahkan playhead ke tanda 14 frame 1 detik (0;00;01;14) pada Timeline dan klik 
tombol Add/Remove Keyframe di sebelah kiri properti Mask Path untuk kedua mask. 
Ini menciptakan keyframe baru yang memiliki nilai yang sama dengan yang ada pada 
1 detik. Mereka bertindak sebagai penampung untuk menjaga mask di posisinya saat 
ini selama 15 frame. 

 
Gambar 4.8. Menambah Keyframe dengan Pengaturan yang Sama 

 

7. Pindahkan playhead ke tanda 3 detik (0;00;03;00) pada Timeline dan pindahkan 
mask seperti yang Anda lakukan pada langkah 4 dan 5, sehingga cocok dengan 
gambar di bawah. Sekarang mereka harus diposisikan sehingga menempati dua baris 
tengah dan kolom dari grid proporsional, membentuk seperti logo palang merah. 

   
Gambar 4.9. Pengaturan Selanjutnya untuk Animasi Mask 

 

8. Pindahkan playhead ke tanda 3 detik 14 frame (0;00;03;14) pada Timeline dan sekali 
lagi klik tombol Add/Remove Keyframe di sebelah kiri properti Mask Path untuk 
kedua mask untuk membuat pasangan placeholder keyframe lainnya. 



9. Pindahkan playhead ke tanda 5 detik (0;00;05;00) pada Timeline. Sekarang setelah 
Anda memindahkan mask ke tengah komposisi, Anda akan menganimasikan jalurnya 
untuk memperbesarnya sehingga memperlihatkan seluruh video. Di Timeline, klik 
pada mask bernama mask horisontal untuk menyorotnya dan menunjukkan vertex 
mask. 

10. Dengan mask yang dipilih, klik dua kali salah satu vertex mask di panel Komposisi 
untuk mengaktifkan kotak pembatas mask. Tempatkan selection tool Anda ( ) pada 
titik kontrol tengah atas kotak pembatas, dan klik dan seret ke atas hingga mask 
mencapai atau sedikit melampaui batas komposisi. 

Ulangi proses ini dengan titik kontrol menengah ke bawah, kali ini seret ke bawah 
untuk membuka seluruh video. 

11. Di Timeline, klik pada mask bernama mask vertikal untuk menyorotnya dan 
menunjukkan vertex mask itu. Dengan memilih mask ini, klik dua kali salah satu 
vertexnya di panel Komposisi untuk mengaktifkan kotak pembatas mask. 

Tempatkan selection tool Anda di titik kontrol kanan tengah kotak pembatas, lalu 
klik dan seret ke kanan hingga mask mencapai batas komposisi. Ulangi proses ini 
dengan titik kontrol kiri tengah, kali ini seret ke kiri hingga mask meluas ke batas 
komposisi di kedua sisi. 

Karena mode kedua mask diatur ke Tambah, area mana pun yang tumpang tindih 
akan terlihat. 

   
Gambar 4.10. Pengaturan Akhir Masking dalam Keyframe 

 

12. Preview Timeline untuk melihat animasi Anda dengan menekan bilah spasi, lalu 
simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl + S 
(Windows) atau Command+S (Mac OS) pada keyboard. Beri nama animasi mask.aep 
untuk pembahasan selanjutnya. 

  

F. Bekerja dengan feather mask 

Mask adalah objek berbasis vektor, dan secara default, mereka memiliki tepi yang keras. 
Tapi ini mungkin tidak selalu sesuai dengan tujuan yang Anda inginkan dalam sebuah 
proyek. Salah satu properti bawaan yang dimiliki semua mask disebut Mask Feather. Ini 
memungkinkan Anda untuk melembutkan tepi mask dengan membuatnya buram dan 
kurang jelas. Hasil saat mask digunakan untuk mengungkapkan atau menyembunyikan 
gambar adalah tepi-tepi layer cuplikan tampak memudar ke dalam latar belakang 
Komposisi. Selain properti Mask Feather standar, After Effects memungkinkan Anda 



menyetel feather per vertex, sehingga memungkinkan Anda menyetel jumlah feather 
yang berbeda untuk setiap vertex individu pada mask. 

  

G. Mengatur Properti Mask Feather 

Properti Mask Feather memungkinkan Anda mengatur transparansi horizontal dan 
vertikal pada mask. 

1. Dengan proyek kerja yang telah terbuka, sorot layer bahan 1 dan tekan tombol M 
pada keyboard dua kali berturut-turut dengan cepat untuk mengungkapkan semua 
properti Mask horisontal dan Mask vertikal. Jika Anda masih memiliki properti Mask 
yang diungkapkan sebelumnya di pelajaran ini, Anda dapat melewati langkah ini. 

2. Pindahkan playhead ke awal (0;00;00;00) panel Timeline dan nonaktifkan Contrain 
Proporsitions properti Mask Feather pada mask horisontal. Klik nilai kedua pada 
property tersebut dan ubah ke 20.  

3. Setelah itu klik nilai pertama untuk feather mask dan ubah ke 20. Ini mengatur 
feather horizontal mask vertikal menjadi 20 piksel. 

4. Batalkan pilihan semuanya dengan memilih Edit > Deselect All, lalu matikan 
Proportional Grid menggunakan menu drop-down Choose grid and guide options. 

5. Preview Timeline untuk melihat animasi Anda dengan menekan bilah spasi pada 
keyboard Anda. Anda sekarang dapat melihat tepi kedua mask lebih lembut dan 
semi-transparan, membuat tepi video memudar dengan latar belakang Komposisi. 

6. Simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl+S 
(Windows) atau Command+S (Mac OS) pada keyboard. Anda sekarang dapat 
menutup file. 

 
Gambar 4.11. Ikon Constrain Propotion dalam Properti Mask 

 

Secara default, pada properti Mask Feather constain proportions aktif, menentukan nilai 
feather horisontal dan vertikal tetap proporsional satu sama lain. Karena masing-masing 
memiliki nilai default 0,0, ini biasanya akan menjaga kedua nilai tetap sama. 

 

H. Mask Bentuk Bebas 

Mask geometrik bisa menjadi tool desain yang sangat berguna, terutama saat membuat 
urutan judul atau grafik layar lainnya. Namun, kelemahan hanya bisa membuat mask 
dalam bentuk seragam menjadi jelas saat Anda membutuhkan mask untuk mengikuti 
kontur tertentu. Dalam situasi seperti ini, tool Pena adalah salah satu tool paling ampuh 
dan bermanfaat yang Anda miliki. Mirip dengan tool Pena dalam aplikasi seperti 
Photoshop dan Illustrator, tool Pena di After Effects membuat jalur vektor yang ketika 



ditutup, membentuk mask yang menyembunyikan atau mengungkapkan area layer. Tool 
Pena membuat titik sudut yang dapat berupa titik sudut untuk membentuk garis lurus 
atau titik Bézier untuk membentuk kurva. 

Dalam latihan ini, Anda akan membuat jalur yang terdiri dari kurva dan garis lurus yang 
mengikuti kontur objek dalam sumber video, lalu Anda akan menganimasikan vertice 
mask saat posisi objek di layar berubah. 

Mask selain dibuat menggunakan Rectangle, Ellipse, Polygon, dan Star yang bentuknya 
sudah ditentukan, dpat juga dibuat denegan bentuk bebas. Mask bentuk bebas ini dapat 
disesuaikan dengan bentuk gambar dengan menempatkan mask di sekeliling tepi 
gambar. Pembuatan mask bentuk bebas ini bias dilakukan menggunakan tool : 

 
Gambar 4.12. Tool untuk Menggambar Masking 

 

Jika Anda sudah pernah menggunakan Photoshop dalam bekerja, maka tools Mask ini 
tentunya tidak asing. Tool ini juga digunakan dalam Photoshop untuk memberikan mask 
pada gambar. Cara kerja pembutan mask bentuk bebas di Photoshop dan di After Effect 
ataupun produk lain dari Adobe yang memiliki Pen tool sama. 

1. Buka salah satu roject yang pernah Anda buat sebelumnya, atau buka project baru 
dan komposisi baru. Impor footage berupa gambar atau video orang atau mobil, 
atau gambar lain yang bagian tepinya ingin diberikan mask. 

 
Gambar 4.13. Tampilan Video Vehicle dalam Area Kerja 

 

2. Klik dobel ada gambar atau videonya sehingga terlihat di anel Composition. Klik Pen 
tool untuk mulai memberikan mask. 

3. Tempatkan Pen tool pada salah satu sisi mobil, klik untuk menambahkan satu vertex. 
Geser ke bagian lain mobilnya, klik lagi untuk menambah vertex lainnya. Lakukan 
untuk semua tepi mobil. 



Terlihat bahwa penambahan vertex akan menampilkan garis lurus (berwarna kuning) 
yang menghubungkan vertex satu ke lainnya. Jangan khawatir karena garis tersebut 
dapat diatur lurus atau melengkung menggunakan Convert vertex Tool. 

4. Klik dan tahan Pen tool yang ada di toolbar, maka akan menggungkap tool lainnya. 
Klik tool Convert vertex, letakkan di salah satu vertex. Anda dapat menekan tombol 
mouse, tahan dan geser, maka akan terlihat dua titik Direction Handle yang bergerak 
simetris dan mengubah kelengkungan garis mask. 

 
Gambar 4. 14. Direct Handle dalam Salah Satu Vertex 

 

5. Setelah menentukan kelengkungan yang sesuai, lepaskan tombol mouse. Jika dalam 
salah satu bagian garis masih ada yang kurang sesuai, klik salah satu titik Direction 
Handle geser sampai kelengkungan sesuai. 

6. Lakukan untuk semua vertex agar masking sesuai dengan gambar yang ingin 
ditampilkan dalam panel Composition. 

 
Gambar 4.15. Tampilan Akhir Composition Vehicle Setelah Ditambah Masking 

 

7. Anda dapat mengganti background video yang telah di berikan mask agar 
menampilkan nuansa yang berbeda. 

 

I. Mengatur Mask Feather Per Vertex 

Di After Effects, setiap vertex di sepanjang tepi mask dapat memiliki penentuan nilai 
feather yang berbeda untuknya. Tidak seperti menggunakan properti Mask Feather, 
yang memungkinkan Anda untuk mengontrol setiap feather horizontal atau vertical.  
Untuk mengatur feather di tiap vertex, Anda dapat menggunakan Mask Feather tool. 



Tool ini digunakan untuk membuat titik feather di sepanjang tepi mask. Anda dapat 
menghapus titik-titik ini untuk menambah atau mengurangi jumlah feather di sepanjang 
tepi mask di antara titik-titik. Di bagian pelajaran ini, Anda akan menggunakan variasi file 
yang sebelumnya Anda kerjakan. 

1. Pilih File > Open Project temukan file bernama animasi mask.aep dan klik dua kali 
untuk membukanya. Jika Anda belum menyimpan proyek Anda saat ini, Anda akan 
diminta untuk melakukannya sekarang. Pilih File > Sace As. 

2. Klik satu layer di panel Timeline dan tekan tombol M pada keyboard Anda sekali 
untuk membuka dua mask yang berisi layer ini. 

3. Di panel Tools di bagian atas interface After Effects, klik dan tahan Pen tool untuk 
membuka tool lain yang dikelompokkan dengannya. Klik Mask Feather tool setelah 
terungkap untuk mengaktifkannya. 

 
Gambar 4.16. Mask Feather Tool dalam Grup Pen Tool 

 

Klik dan tahan tool apa pun dengan panah di sudut bawahnya untuk membuka tool 
yang dikelompokkan dengannya. 

4. Pada panel Timeline, klik mask horizontal untuk membuatnya aktif, dan gunakan 
Mask Feather tool, klik bagian tengah bawah mask untuk membuat titik feather 
baru. 

5. Klik di sudut kiri bawah dan kanan bawah mask horizontal untuk menambahkan poin 
feather tambahan di masing-masingmya. Jika Anda hanya memiliki satu titik feather 
pada jalur mask, menyesuaikannya akan mengubah feather mask di semua sisi 
secara merata. 

Dengan Mask Feather tool, klik titik tengah feather dan seret ke bawah, menjauh 
dari mask. Ini menciptakan efek di mana mask lebih berfeather di bagian bawah 
daripada di setiap sudut. Mask Feather tool menjadi mata panah saat berada di atas 
titik feather. 

 
Gambar 4.17. Menggeser Posisi Mask Feather 



6. Batalkan pilihan semuanya dengan memilih Edit > Deselect All, lalu matikan Grid 
Proporsional menggunakan drop down menu Pilih Grid dan Guide. Ini akan 
memungkinkan Anda melihat feather-feather mask dengan lebih jelas. Anda dapat 
menganimasikan Per vertex mask feathering menggunakan properti Mask Shape. 

7. Simpan file Anda dengan memilih File > Save atau dengan menekan Ctrl+S 
(Windows) atau Command+S (Mac OS) pada keyboard. Anda sekarang dapat 
menutup file. 

 

J. Memahami Track matte 

Track mattes, juga disebut travelling mattes, adalah teknik yang digunakan untuk 
menyembunyikan atau mengungkapkan area video pada suatu layer. Mereka serupa 
dengan mask dalam hal ini tetapi sangat berbeda dalam cara menciptakan efeknya. 
Sementara mask menggunakan bentuk garis berbasis vektor untuk mengisolasi area 
layer, track matte dapat menggunakan alfa atau pencahayaan. Alpha adalah nama teknis 
untuk apa yang kebanyakan orang sebut transparansi, sedangkan pencahayaan adalah 
ukuran kecerahan. 

Sumber yang sangat umum untuk track matte adalah layer teks. Teknik ini, sering 
disebut mask kliping dalam program seperti Photoshop dan Illustrator, memungkinkan 
layer teks menutupi layer di bawahnya sehingga Anda dapat melihat gambar atau video 
di dalam bentuk teks. Karena track matte adalah layer, Anda dapat menganimasikannya 
dengan menambahkan bingkai utama untuk properti layer seperti skala, posisi, dan 
vertice, atau dengan menganimasikan efek yang mengubah tampilannya. 

1. Membuat track matte 

Anda dapat membuat track matte dari alpha channel atau pencahayaan dari layer 
video atau gambar diam. Layer dengan alpha channel biasanya paling mudah untuk 
dikerjakan, meskipun menggunakan luminansi bisa sama berhasilnya jika Anda 
memiliki gambar kontras tinggi untuk digunakan sebagai matte. Ada dua hal yang 
perlu diingat saat bekerja dengan fitur track matte di After Effects: yang pertama 
adalah track matte harus berada tepat di atas layer yang akan ditutup dan yang 
kedua adalah Anda hanya dapat memiliki satu track matte per layer bermask. Jika 
Anda perlu memiliki banyak layer yang berfungsi sebagai track matte, Anda harus 
terlebih dahulu menggabungkan layer tersebut menjadi komposisi baru. 

Di bagian pembahasan ini, Anda akan menggunakan animasi yang telah dibuat di 
After Effects untuk membuat efek track matte untuk menampilkan layer video 
tersembunyi. 

a. Pilih File > Open Project temukan file bernama animasi mask.aep dan klik dua kali 
untuk membukanya. Hapus mask horizontal dan mask vertical yang sudah 
ditambahkan sebelumnya. 

b. Pilih File > Impor > File dan arahkan ke subfolder tempat file video yang Anda 
miliki dan klik dua kali untuk mengimpornya. Seret file video dari panel Project ke 
Timeline. Letakkan di bawah layer apapun yang telah ada sebelumnya. 

c. Track matte harus berupa layer dengan kontras yang sangat tinggi (biasanya 
hitam dan putih) atau layer yang memiliki area transparan.  



Buatlah satu layer solid berwarna hitam dengan cara, klik kanan panel Timeline, 
pilih New, klik Solid. Biasanya bernama Black Solid 1 dan diletakkan paling atas. 

Tambahkan efek Fractal Noise pada layer Black Solid 1, dari klik menu Effect > 
pilih Noise & Grain > Fractal Noise. Efek fractal noise ini sangat sesuai untuk 
digunakan membuat layer track matte. 

 
Gambar 4.18. Penambahan Solid Layer dan Efek Fractal Noise 

 

d. Klik layer Black Solid 1 dan buka panel Effects Control. Atur layer Black Solid 1 
menjadi lebih terang dan kontras dengan mengatur beberapa bagiannya : 
1) Contrast menjadi +220 
2) Brightness menjadi +20 
3) Klik panah disamping kiri Transform, ubah nilai Scale menjadi 190. 
4) Animasikan Evolusion dengan menempatkan playhead di posisi awal frame 

dan klik stopwatch untuk menampilkan keyframe pertama, geser playhead ke 
posisi 04s dan ubah nilai menjadi 0x+360.0°. 

 
Gambar 4.19. Hasil Pengubahan Properti Fractal Noise 

 

e. Klik tombol Expand or Collapse Transfer Controls Pane yang terletak di kiri bawah 
Timeline untuk memperluas panel dan menampilkan opsi Track Matte. 

f. Untuk layer gambar, pilih Luma Matte dari menu drop-down Track Mattte di 
panel Timeline. Tampilan layer gambar hanya terlihat pada bagian layer Fractal 
Noise yang berwarna terang. Layer fractal noise akan tersembunyi, sehingga 
layer gambar tampil hanya sebagian. 

Layer video sekarang menggunakan luma channel dari layer diatasnya untuk 
mengontrol area mana yang terlihat. Di bagian layer yang berwarna terang, kini 



Anda dapat melihat layer gambar, sehingga seiring berjalannya animasi, Anda 
dapat melihat lebih banyak hingga terungkap sepenuhnya. Pada langkah 
selanjutnya, Anda akan membersihkan garis waktu dengan mengubah In Point 
dari layer video ini sehingga dimulai saat layer track matte selesai. 

g. Klik layer pertama (yang bernama [Black Solid 1]) untuk membuatnya aktif, lalu 
tekan tombol I pada keyboard Anda untuk memindahkan playhead ke In Point 
dari layer ini. 

h. Klik layer video (yang bernama [Antah Berantah.jpg]) untuk membuatnya aktif, 
lalu tekan dan tahan tombol Shift pada keyboard Anda sambil menyeret In Point 
dari klip ini ke posisi playhead saat ini. 

 
Gambar 4.20. Penggunaan In Point 

 

i. Klik tombol Expand or Collapse Transfer Controls Pane yang terletak di kiri bawah 
Timeline untuk menyembunyikan panel. 

j. Pilih File > Save As. Tentukan folder dan nama file, klik Save. 

2. Membuat Matte dari File Animasi Photoshop  

Meskipun ada beberapa orang yang hanya bekerja di After Effects, sebagian besar 
pengguna juga bekerja dengan program grafik lain seperti Photoshop dan Illustrator 
untuk membuat karya seni baik sebagai grafis yang berdiri sendiri untuk 
dianimasikan atau untuk membuat grafis pendukung seperti mask dan track matte. 
Kebanyakan orang mengenal Photoshop sebagai program pengeditan dan 
pewarnaan gambar, tetapi banyak yang tidak menyadari bahwa Photoshop juga 
memiliki Timeline yang sangat mirip dengan After Effects. Animasi Photoshop yang 
digunakan di bagian ini dibuat dengan menganimasikan brush untuk mengisi layar 
dari waktu ke waktu, hingga sebagian besar layar menjadi putih. Saat dokumen ini 
diimpor ke After Effects, itu akan diperlakukan sebagai file video. Di bagian ini, Anda 
akan membuat proyek baru dan menggunakan file Photoshop animasi untuk 
membuat track matte untuk file video. 

a. Pilih File > Baru > Proyek Baru. Jika Anda belum menyimpan proyek Anda saat ini, 
Anda akan diminta untuk melakukannya sekarang. 

b. Dalam proyek baru, pilih File > Import > Multiple Files dan arahkan ke subfolder 
video. Pembahasan ini menggunakan file video bernama Fix - Jejak Asap.mp4 dan 
klik dua kali untuk mengimpornya. Saat kotak dialog Impor terbuka, dan klik dua 



kali pada file photoshop animasi.psd untuk mengimpornya juga. Mengimpor file 
Photoshop akan membuka dialog untuk menentukan pilihan, di kotak dialog Opsi 
impor ini, pilih Footage sebagai Jenis Impor dan konfirmasikan bahwa tombol 
Merge Layer aktif. Klik OK untuk mengimpor file ini. 

 
Gambar 4.21. Kotak Dialog Impor Footage 

 

File Photoshop memiliki opsi tambahan yang dapat diatur dalam kotak dialog 
sekunder saat diimpor ke After Effects. 

 
Gambar 4.22. Panel Project Setelah Impor Footage 

 

Saat kotak dialog Impor muncul lagi, klik tombol Selesai (Windows) atau Batal 
(Mac OS) untuk menutupnya. 

c. Klik item footage Fix - Jejak Asap.mp4 di panel proyek dan seret ke panel 
Timeline yang kosong. Ini secara otomatis membuat komposisi baru dengan 
properti dan nama yang sama seperti file video, dan merupakan cara paling 
efisien untuk membuat komposisi yang cocok dengan pengaturan potongan 
footage tertentu. 

Membuat komposisi dengan cara ini mengatur warna latar belakang ke warna 
yang digunakan terakhir kali comp dibuat. Pilih Composition > Composition 
Setting dan di bagian bawah kotak dialog klik pada contoh warna latar belakang 
dan ubah menjadi hitam. Klik OK untuk menutup kotak dialog. 

Seret item footage animasi yang bernama photoshop animasi.psd ke Timeline 
dan letakkan di atas layer video. Anda sekarang akan melihat bintik tinta hitam 



besar pada latar belakang putih yang menutupi komposisi. Track matte harus 
selalu ditempatkan di atas layer yang ingin Anda aplikasikan. 

 
Gambar 4.23. Susunan Layer di Timeline dan Tampilan di Composition 

 

d. Geser playhead untuk mempreview animasi Photoshop. Blok tinta membesar 
hingga benar-benar menutup latar belakang hitam. Gambar dengan kontras 
tinggi akan membuat track matte berbasis luminositas yang baik.  

Perluas panel Transfer Controls dengan mengeklik tombol di sudut kiri bawah 
panel Timeline. 

e. Pilih Luma Inverted Matte “photoshop animasi.psd” dari menu drop down 
TrkMat layer video. Layer video sekarang terlihat dalam bentuk titik tinta, dan di 
sekelilingnya Anda melihat warna latar belakang komposisi. 

Track Mattes sering digunakan untuk membuat transisi khusus dalam video 
seperti yang Anda buat dalam latihan ini. 

 
Gambar 4.24. Pengubahan Track Matte Menjadi Luma Matte 

 

File Photoshop animasi bisa menjadi cara yang sangat baik untuk membuat 
transisi khusus dan sangat menyenangkan untuk dibuat. 

f. Pilih File > Import > File dan arahkan ke subfolder video dari folder ae05lessons. 
Temukan file bernama Creating Shape Masks.mov dan klik dua kali untuk 
mengimpornya. 

Seret item footage Creating Shape Masks.mov dari panel Project ke Timeline dan 
letakkan di bawah layer video sehingga menjadi layer terendah yang baru. 

g. Klik tombol Perluas atau Tutup Panel Kontrol Transfer ( ) yang terletak di kiri 
bawah Timeline untuk menyembunyikan panel. 

 



  

  
Gambar 4.25. Hasil Akhir Matte dari Photoshop Animasi 

 

h. Preview animasi dan kemudian simpan file dengan memilih File > Save As. 
Arahkan ke folder ae05lessons di hard drive Anda. Di bidang Simpan Sebagai, beri 
nama file Photoshop Track Mattes_final.aep dan klik Simpan. 

 



BAB V 

Vfx movie : WAKTU TERHENTI 
 

Projek ini akan menampilkan waktu terhenti, yang menampilkan video dengan dua orang atau 
objek yang salah satunya berhenti bergerak pada waktu tertentu, sedangkan yang lain tetap 
jalan atau biasa disebut time freezing. 

Intinya dalam video time freezing ini bisa diatur dengan mengatur time remapping dalam layer. 
Penggunaan keygrame dalam time remapping diperlukan untuk mengatur penghentian gerakan 
dalam layer. 

Ada juga pengaturan masking untuk menutup bagian yang tidak diperlukan, masking juga perlu 
diberikan keyframe agar dapat digerakkan sesuai dengan objeknya. Jika dua objek atau lebih 
bersinggungan dalam satu waktu, maka perlu juga diberikan masking pada semua objeknya. 

   

   
Gambar 5.1. Waktu yang Terhenti dalam Video 

 

Video tersebut menampilkan dua orang yang berjalan bersamaan dengan arah yang berbeda, 
salah satu orang (membawa barang) terjatuh, saat itulah gerakan orang tersebut terhenti. 
Orang yang lain (tidak membawa barang) gerakannya tetap berjalan. Setelah waktu tertentu, 
keduanya bergerak kembali bersamaan. 

 

A. Pengaturan Layer dan Penyisipan Obyek 

Projek ini berisikan satu video footage saja dengan nama Video Diam.mp4 yang berisi dua 
gerakan yang berbeda, dengan pengaturan : 

• Ukuran dimensi 720 px dan 405 px. 

• Frame rate 25 fps. 

1 2 3 

6 5 4 



• Durasi 14 detik. 

• Type mp4. 

Setelah mengetahui jenis, ukuran, dan frame rate video maka dapat dilakukan pembuatan 
video Time Freezing menggunakan footage video, langkahnya seperti di bawah ini : 

1. Buat Project baru, dan Composition baru dengan pengaturan sebagai berikut : 

a. Preset : Custom 

b. Width : 720 px 

c. Height : 405 px 

d. Pixel Aspect Ratio : Square Pixel 

e. Frame Rate : 24 FPS 

f. Duration : 14 detik 

g. Background : Black 

Pengaturan lain biarkan default. 

2. Tambahkan file Video Diam.mp4 dalam Project, dan tempatkan dalam Timeline. 

3. Geser play head pada posisi 07s, tekan Ctrl+Shift+D untuk memotong layer, atau 
gunakan menu Edit, klik Split Layer. 

 
Gambar 5.2. Layer yang Telah Terpotong 

 

4. Ubah nama layer menjadi : 
Layer 1 : Video Diam. 
Layer 2 : Background. 

Mengubah nama layer dapat dilakukan dengan klik dalam layernya, tekan tombol Enter 
dalam Keyboard, kemudian ketikkan nama baru, tekan Enter. 



5. Klik Current Time (Click to Edit) dalam jendela Composition. Ini dapat digunakan untuk 
menempatkan play head sesuai posisi waktu yang Anda inginkan dengan tepat. Setelah itu 
ketikkan nilai 00:00:01:10, tekan Enter. 

6. Klik layer Video Diam, tekan tombol T dalam Keyboard, ubah Opacity menjadi 50%. 
Pengubahan ini akan menampikan kedua layer menjadi transparan, agar dapat dilihat dan 
diatur gerakan dari kedua video tersebut. 

7. Klik area kosong Timeline dalam kolom Layer Name. kemudian klik kanan layer Background, 
pilih Time, klik Enable Time Remapping (lihat Gambar 5.3). 

 
Gambar 5.3. Tampilan Setelah Dilakukan Pengaturan Poin 4-7 

 

8. Mengatur Time Remapping dapat dilakukan dengan menambahkan keyframe pada frame 
yang diinginkan. Dalam project ini penghentian waktu menggunakan tampilan video yang 
ada di frame 03:14s. 

a. Klik dalam Current Time  (Click to Edit), ubah nilai menjadi 00:00:03:14. 

b. Klik Add or remove keyframe at current time, terlihat keyframe pada posisi tersebut. 

c. Ubah bagian akhir layer Background sejajar dengan layer Video Diam. 

 
Gambar 5.4. Penambahan Keyframe dalam Time Remapping 

 



d. Tempatkan play head di frame 03:20s, tambah keyframe baru di posisi tersebut. Geser 
keyframe ke frame 06:00s, tambahkan keyframe baru di posisi play head. 

e. Hapus keyframe yang ada di posisi 06:00s, geser keyframe di frame 03:20s ke frame 
06:00s, kemudian tempatkan playhead di posisi frame 07:20s, tambahkan keyframe. 

f. Seleksi 2 frame terakhir (frame 06:00s dan 07:20s), drag keyframe 07:20s, ke frame 
terakhir. 

   
Gambar 5.5. Penambahan dan Pergeseran Posisi Keyframe 

 

B. Memberikan Masking dan Pengaturannya 

Masking digunakan untuk menutup bagian yang tidak ingin ditampilkan, pada frame yang 
berhenti mulai frame 03:14s sampai frame 06:24s perlu diberikan masking agar tampil 
gambar video yang diinginkan. 

Sebelum memberikan masking, duplikasi terlebih dahulu layer Background dan geser ke 
atas layer Video Diam. Setelahnya geser video bar bagian awal sampai posisi awal keyframe 
Time Remapping, dan geser video bar bagian akhir sampai posisi frame 06:24s. Ubah nama 
layer Background 2 menjadi Foreground. Setelah itu ikuti langkah berikut ini : 

1. Klik layer Foreground. 

2. Klik Rectangle tool dalam Toolbar. 

3. Buat kotak dalam jendela komposisi seperti gambar di bawah ini. 

 
Gambar 5.6. Masking 



Masking akan berwarna kuning dengan 4 titik untuk pengaturan ukuran. Mengedit 
masking dapat dilakukan dengan cara double klik maskingnya, kemudian ubah 
ukurannya dari salah satu titik berwarna putih. Mengakhiri pengubahan ukuran dengan 
cara double klik dalam garis/titik masking. Sedangkan untuk menggeser masking, cukup 
drag dari garis kotak berwarna kuning. 

4. Klik dan tahan Pen tool dalam toolbar, klik Add Vertex Tool. Vertex adalah istilah untuk 
vertex dalam masking, penambahan vertex masking dapat dilakukan dari Add Vertex 
Tool, sedangkan menghilangkan vertex masking dari Delete Vertex Tool. 

 
Gambar 5.7. Tool Masking 

 

5. Tambahkan vertex masking dan ubah masking seperti gambar di bawah ini : 

 
Gambar 5.8. Pengubahan Masking 

 

Penambahan masking dengan cara klik pada garis masking menggunakan Add Vertex 
Tool. Sedangkan untuk menggeser vertex gunakan Selection Tool dalam toolbar. Geser 
vertex sesuai dengan bentuk objek. Pada bagian kiri video masking tidak diubah karena 
pergerakan orang dalam layer Video Diam tidak sampai sisi kiri video. 



6. Setelah menentukan masking dalam layer Foreground, selanjutnya klik layer Video 
Diam, tempatkan play head pada frame di posisi awal Video Diam (frame 01:10s).  

7. Tambahkan masking berbentuk kotak, gunakan Rectangle tool dalam toolbar. Buat 
masking seperti gambar di bawah ini. 

8. Setelah itu buka pengaturan layer Video Diam, dengan klik pada tanda panah sebelah 
kiri layer, klik tanda panah Mask, klik icon stopwatch pada Mask Path agar muncul 
keyframe. 

 
Gambar 5.9. Masking dalam Layer Video Diam 

 

Layer Video Diam memiliki gerakan pada objek orang, layer Foreground dan Video Diam 
saling bertumpuk dalam satu waktu. Ini akan menyebabkan layer yang paling atas saja 
yang akan terlihat, untuk itu perlu memberikan masking. 

9. Tempatkan play head di frame 03:02s, tambahkan vertex sebanyak 6 vertex pada bagian 
sisi kiri masking seperti pada gambar di bawah ini. 

 
Gambar 5.10. Penambahan Vertex pada Masking di Video Diam 



Penambahan vertex pada masking digunakan untuk mengubah bentuknya, karena ada 
posisi frame 03:12s ada bagian layer Background yang masih tertutup oleh Video Diam. 
Oleh karena itu, perlu diubah bentuk masking menggunakan vertex baru yang 
ditambahkan. Gambar di bawah ini merupakan tampilan yang masih tertutup. 

 
Gambar 5.11. Lingkaran Merah Menunjukkan Bagian Video yang Tertutup 

 

10. Tambahkan keyframe pada posisi frame 03:11s, ubah bentuk masking sesuaikan dengan 
bagian yang masih tertutup, sebagai acuan bisa melihat gambar di bawah ini. 

 
Gambar 5.12. Posisi Vertex Sesuai Bagian yang Tertutup 



11. Setelah diubah bentuk masking pada layer Video Diam, bagian yang tertutup pada layer 
Background akan terlihat. Geser play head ke posisi 03:20s untuk melihat tampilan hasil 
project ini. Hasil dari tampilan, ternyata dalam layer Video Diam ada bagian yang 
tertutup juga, maka diperlukan perubahan masking pada layer Video Diam. 

  
Gambar 5.13. Bagian Video yang Tertutup dan Bentuk Masking juga Posisi Vertex 

 

Tambahkan keyframe Setelah mengubah masking pada posisi yang telah di tentukan 
maka akan terlihat kembali bagian yang tertutup dalam layer Video Diam, dikarenakan 
pada Mask Path telah diaktifkan icon stopwatch, maka keyframe akan terlihat. 

Penambahan keyframe dan perubahan bentuk masking akan menimbulkan gerakan 
pada masking, pastikan kembali di setiap frame posisi masking dari tiap layer tidak 
menutup tampilan video. Jika masih tertutup, maka dapat diubah kembali bentuk 
masking disesuaikan dengan posisi frame dari video. 

12. Tempatkan play head pada posisi frame 06:16s, tambahkan keyframe pada Mask Path, 
bentuk keyframe tidak perlu diubah. Setelah itu, geser play head pada posisi 06:23s dan 
tambahkan keyframe baru. Atur bentuk keyframe seperti gambar di bawah ini. 

  
Gambar 5.14. Penambahan Keyframe dan Pengubahan Bentuk Masking 



13. Ubah panjang Comsition menjadi 08:00 detik. Lihat hasil pengturan masking dalam 
project dengan klik pada tombol Play/Pause dalam jendela Preview, atau tekan spasi 
dalam keyboard. 

 

C. Hasil Akhir Project VFX Video : Waktu Terhenti 

 

  

  



BAB VI 

Vfx movie : suasana siang ke malam 
 

Pembahasan dalam bab ini akan menjelaskan tentang bagaimana memberikan visual efek 
movie untuk mengubah suasana siang hari (terang/panas) menjadi suasana malam 
(gelap/dingin) dalam video yang telah dihasilkan dalam produksi movie. 

Pengubahan suasana dari siang hari menjadi malam hari, sangat erat kaitannya dengan suasana 
terang/panas dan gelap/dingin. Ada banyak efek yang bisa digunakan untuk mengubah suasana 
seperti tersebut diatas, Anda hanya perlu menentukan apakah yang akan digunakan sebagai 
acuan adalah terang ke gelap, atau panas ke dingin. 

Efek pengubahan suasana berkaitan dengan pengaturan koreksi warna, After Effects CS6 
banyak memiliki efek untuk mengkoreksi warna dalam video klip. Tiap efek koreksi warna 
mempunyai fungsi yang berbeda. Terkait dengan pengubahan suasana dari siang ke malam, 
efek yang akan digunakan dalam bab ini adalah Hue And Saturation, dan Curve. Unsur warna 
yang akan diatur adalah warna merah identik dengan panas, dan biru yang identik dengan 
dingin, selain juga seluruh warna (RGB). 

 
Gambar 6.1. VFX Movie Mengubah Suasana Siang Ke Malam 

 

Bab ini juga menyertakan video sebagai footage file (vehicle.mp4) agar mudah dalam mencoba 
mengubah suasana siang ke malam. Pengaturan efek yang digunakan bisa diatur sama dengan 
pengaturan dalam bab ini. Berikut ini langkahnya,  

1. Buka After Effects CS6 dan buat Composition baru dengan klik pada menu Comosition, klik 
New Comosition. 

2. Berikan pengaturan :  

a. Preset : Custom. 

b. Dimensi Width : 720px, Height : 405px (aspect ratio 16:9). 



c. Pixel Aspect Ratio : Square Pixels. 

d. Frame Rate : 25 

e. Duration : 3 detik, kemudian klik OK 

 
Gambar 6.2. Composition Setting. 

 

3. Setelah membuat komposisi baru, akan muncul project dengan nama komposisi Comp1. 
Selanjutnya tambahkan footage file (vehicle.mp4). 

a. Klik kanan dalam jendela Project. 

b. Pilih Import, klik File. 

c. Arahkan dalam folder tempat file vehicle.mp4 berada. 

d. Klik file tersebut, klik Open. 

e. Terlihat file footage vehicle.mp4 dalam jendela Project. 

 
Gambar 6.3. Menambahkan File Footage 



4. Setelah muncul file footage (vehicle.mp4), proses penambahan file footage yang lain bisa 
dilakukan dengan cara yang sama. Penambahan file footage bisa lebih dari satu file footage 
jika berada dalam satu folder, dengan menambahkan tombol shift atau ctrl dalam memilih 
file footage. 

 
Gambar 6.4. File Footege dalam Project 

 

5. Langkah selanjutnya, masukkan file footage dalam jendela Timeline untuk mengubah 
suasana siang ke malam, dengan cara drag file footage vehicle.mp4 ke timeline. Ukuran 
dimensi video vehicle.mp4 lebih besar dari komposisi yang disiapkan. 

6. Ubah ukuran video vehicle.mp4 sesuai dengan komposisi yang telah disiapkan dengan 
mengubah scale layer vehicle.mp4 dengan cara,  

a. Klik dalam tanda panah dalam layer vehicle.mp4 

b. Kemudian klik tanda panah dalam Transform. 

c. Ubah scale menjadi 57%, dalam salah satu angkanya. 

 
Gambar 6.5. Mengatur Scale Video Agar Sesuai Ukuran Komposisi 



A. Menambahkan Efek 

1. Tambahkan efek, untuk memberikan efek, klik nama layer vehicle.mp4 dalam timeline. 

a. Klik menu Effect, pilih Color Correction. 

b. Klik Hue/Saturation. 

c. Ubah nilai Master Saturation menjadi -30 dengan menggeser slider. Pengubahan ini 
bertujuan untuk mengurangi ketajaman warna dalam video. 

 
Gambar 6.6. Pengturan Master Saturation dalam Hue/Saturation 

 

d. Kemudian tambahkan efek Curve, atur nilai channel RGB, channel Red, dan channel Blue 
seperti gambar di bawah ini : 

   
Gambar 6.7. Pengaturan Curve 

 



Pemberian efek Curve digunakan untuk mengatur warna video agar dapat memberikan 
nuansa malam hari. Selain itu efek Curve dapat juga digunakan untuk menyeimbangkan 
warna ketika hasil shooting tidak sesuai. Node curve dapat ditambahkan dengan cara 
klik pada garis Curve dalam salah satu channel, kemudian drag kearah yang diinginkan. 

e. Hasil pengaturan dapat dilihat seperti di bawah ini : 

      
           Gambar 6.8. Tampilan Awal Video             Gambar 6.9. Gambar Setelah Ada Efek 
 

f. Gambar 6.9, menunjukkan bahwa nuansa video sudah berubah, bagian langit masih 
terlalu terang untuk tampilan suasana malam. Pengaturan dapat dilakukan dengan 
menggunakan efek Curve setelah menduplikasi layer vehicle.mp4. Perintah untuk 
menduplikasi bisa menggunakan Ctrl+D dari keyboard. 

g. Setelah diduplikasi layer vehicle.mp4, klik Reset di pengaturan efek Curve, dan 
pindahkan efek Hue/Saturation ke bawah efek Curve dalam jendela Efect Control. 
Memindahkan efek Hue/Saturation dengan cara drag efeknya ke bawah. 

h. Atur efek Curve untuk memberikan nuansa gelap pada langitnya. Pengaturannya sama 
hanya posisi node control berbeda (lihat Gambar 6.10). 

i. Ubah pengaturan nilai efek Hue/Saturation, seperti di bawah ini : 
1) Klik Colorize, hingga muncul cek list. 
2) Nilai Colorize Hue : 0x+205° 
3) Colorize Saturation : 60 

    
Gambar 6.10. Pengaturan Efek Curve dan Hue/Saturation 



j. Tambahkan mask dalam layer vehicle.mp4 hasil duplikasi, tutup bagian bawah layer 
tersebut agar tampil bagian atasnya saja. Ini dilakukan untuk memberikan nuansa gelap 
pada bagian langitnya yang masih terang. Menambahkan Mask dapat dilakukan dengan 
cara : 

1) Klik dalam layer vehicle.mp4 hasil duplikasi. 

2) Klik tool Rectangle dalam toolbar. 

3) Buat mask yang cukup besar diluar Composition, gunakan scroll mouse untuk 
mengubah zoom out/in Composition. 

 
Gambar 6.11. Garis Mask Di Luar Comosition (Warna Kuning) 

 

4) Tentukan nilai Mask Feather dalam layer yang ada mask di Timeline dengan 185. 
Feather digunakan untuk memberikan gradasi transparansi di sekeliling mask, 
sehingga layer tercampur baik. 

 
Gambar 6.12. Pengturan Feather dalam Mask 

 

2. Menambahkan cahaya pada lampu mobil dan sorotan cahaya pada tanah dapat dilakukan 
dengan menambahkan efek CC Spotlight dan Lens Flare. 

a. Buat solid layer baru dengan cara klik kanan dalam jendela Timeline, pilih New.  

b. Klik Solid. 

c. Atur warna abu-abu dengan nilai RGB 117. 



d. Klik OK, maka tampil layer baru menutup 2 layer vehicle.mp4. 

e. Tambahkan dan atur efek CC Spotlight dengan langkah sebagai berikut : 

1) Klik layer Gray Solid 1. 

2) Buka jendela Effects & Presets dari menu Window, kemudian klik Effects & Preset. 

3) Ketik CC Spotlight dalam Search box. 

4) Drag efek CC Spotlight yang terlihat di bawah, ke jendela Composition. 

 
Gambar 6.13. Efek CC Spotlight 

 

5) Drag efek CC Spotlight yang terlihat di bawah, ke jendela Composition. 

6) Tentukan nilai pengaturan efek CC Spotlight diantaranya From, To, Height, Cone 
Angle, Edge Softness, Intensity, dan Render, seperti dalam Gambar 6.14. 

 
Gambar 6.14. Pengaturan Efek CC Spotlight 



7) Ubah Blending Mode layer Gray Solid 1 menjadi Classic Color Dodge dengan klik 
kanan pada layer Gray Solid 1, pilih Blending Mode. 

8) Aktifkan 3D Layer dalam layer Gray Solid 1, atur posisi agar merebah di tanah 
dengan mengubah nilai Rotation pada sumbu X menjadi 77°. 

9) Duplikasi layer Gray Solid 1, pindah ke sisi lain dari lampu mobilnya. 

 
Gambar 6.13. Bagian Pengaturan CC Spotlight dan Layer 

 

10) Klik pada teks CC Spotlight dalam jendela Effect Control, jika ingin mengtur sorotan 
efek CC Spotlight. 

3. Tambahkan cahaya lampu mobil dengan menambahkan efek Lens Flare dalam solid layer 
baru. 

a. Buat solid layer baru dengan warna background hitam. 

b. Tentukan blending mode Add. 

c. Tambahkan efek Lens Flare dengan cara klik menu Effect, pilih Generate, klik Lens Flare. 

d. Tentukan pengaturannya seperti gambar di bawah ini : 

 
Gambar 6.14. Pengaturan Lens Flare 



e. Atur posisi lens flare tepat berada di lampu mobil, dengan drag lens flare dalam jendela 
Composition. 

f. Tambakan efek Hue/Saturation agar warna cahaya lampu menjadi sedikit lebi kuning, 
kemudian tambahkan juga efek Curve agar sebaran cahaya tidak penuh satu layer. 
Pengaturan efek curve ini untuk mengurangi warna terang pada low tone color. 
Pengaturan Hue/Saturation dan Curve dapat dilihat pada gambar di bawah ini. 

       
Gambar 6.15. Pengaturan Hue/Saturation dan Curve 

 

g. Duplikasi layer Black Solid 1, dan geser ke posisi lampu yang lain. Hasil dari penambahan 
efek Lens Flare dalam project ini dapat dilihat pada gambar di bawah ini. 

 
Gambar 6.16. Hasil Penambahan Layer Solid dan Efeknya 

 



B. Menganimasikan Layer dan Efek 

Animasi adalah upaya untuk menggerakkan obyek agar terlihat seolah-oleh hidup/nyata. 
Menganimasikan obyek pada intinya adalah menentukan posisi awal dan akhir suatu obyek 
yang berbeda. Nilai posisi obyek dapat disimpan dalam suatu obyek yang disebut Key Frame, ini 
merupakan bagian utama animasi. 

Dikarenakan ini merupakan video, maka setelah semua layer dan efek ditambahakan dalam 
project, Langkah selanjutnya adalah mengatur animasi semua layer Black Solid 1, dan layer Gray 
Solid 1. Animasi untuk sorotan cahaya lampu mobil (layer Gray Solid 1) dapat dilakukan dengan 
menambahkan layer kosong baru atau disebut Null Object. 

1. Penambahan layer Null Object baru dapat dilakukan dengan cara klik kanan dalam jendela 
Timeline, kemudian pilih New, klik Null Object. 

2. Terlihat layer baru bernama Null 1, merupakan layer kosong sebagai acuan animasi sorotan 
cahaya lampu mobil. 

3. Atur tampilan composition tampak atas, kemudian zoom out sampai terlihat semua layer 
Gray Solid 1 dan layer Bull 1 dalam tampilan Composition. Geser layer Null 1 sejajar dengan 
semua layer Gray Solid 1. Ini dilakukan agar pergerakan layer Null 1 tidak terlalu jauh. Letak 
semua layer Gray Solid 1 terlalu mundur dari posisi Composition, sedangkan layer Null 1 
sejajar dengan Composition. 

   
Gambar 6.17. Mengatur Posisi Layer Gray Solid 1 Setelah diubah Composition View 

 

4. Atur parenting semua layer Gray Solid 1 ke layer Null 1, dengan cara seleksi semua layer 
Gray Solid 1, dalam kolom Parent di jendela Timeline drag simbol parent  ke layer Null 1. 
Terlihat menu di samping kanan simbol parenting akan berubah dari None menjadi :             
1. Null 1. 

 
Gambar 6.18. Pengaturan Parenting Layer 



Dengan demikian, gerakan semua layer Gray Solid 1 akan mengikuti gerakan layer Null 1. 

5. Geser play head ke frame awal (00s), klik dalam layer Null 1, tekan tombol P, kemudian 
Shift+S, kemudian Shift+R dalam keyboard. Pengaturan nilai Position, Scale dan Rotation 
dalam Timeline akan terlihat. 

6. Klik tombol stopwatch pada Position, Scale, dan Rotation untuk menambahkan key frame. 
Geser play head ke kanan, maka akan terlihat icon key frame dalam Timeline window. 

 
Gambar 6.19. Penambahan Keyframe 

 

7. Geser kembali play head ke posisi awal frame (00s), atur posisi waktu video seperti gambar 
di bawah ini, jika perlu potong video menggunakan menu Edit, klik Split Layer. 

 
Gambar 6.20. Gambar Posisi Mobil dalam Video dan Layer Null 1 

 

8. Geser posisi play head ke 10s, ubah posisi layer Null 1 untuk menggeser posisi layer Gray 
Solid 1. Ulangi langjah tersebut sampai akhir video. 

9. Ubah juga posisi layer Black Solid 1 (cahaya lampu mobil) sesuaikan dengan posisi mobil, 
gunakan keyframe seperti dalam layer Null 1. 



 
Gambar 6.20. Posisi Keyframe dalam layer Null 1 dan semua layer Black Solid 1 

 

C. Tampilan Akhir VFX Video Suasana Siang Ke Malam 

 
 

 
Terlihat dalam gambar di atas posisi cahaya lampu dan sorotannya mengikuti gerakan mobil 
setelah diatur animasi dalam layer Null 1 dan Black Solid 1. Semua layer Gray Solid 1 mengikuti 
gerakan layer Null 1 karena sudah diatur parenting dengan layer Null 1. Semoga Bermanfaat. 

 



BAB VII 

Vfx movie : efek jejak asap 
 

Visual efek digunakan untuk memberikan nuansa atau kesan yang berbeda dalam suatu movie. 
Selain juga untuk menjadikan seolah-oleh nyata, adegan yang ada dalam movie. Visual efek jejak 
asap yang juga disebut Smoke Trail menjadi salah satu efek yang banyak digunakan untuk efek 
misil, roket, dan lainnya. 

Jejak asap akan disampaikan dalam bab ini menggunakan salah satu plugin dari ihak ketiga yaitu 
Trapcode Particular. Bab ini tidak membahas bagaimana memasukkan plugin Trapcode 
Particular, Anda bias mendownload plugin tersebut di website resmi Red Giant agar bias 
menggunakan plugin tersebut. 

Selain plugin Trapcode Particular, ada beberapa efek lain yang digunakan seperti Curve, Lens 
Flare, dan mungkin juga Fast Brur. Layer baru yang digunakan dalam bab ini diantaranya ada 
layer Camera, Light, dan Adjustment. 

 

A. Persiapan Awal Membuat Efek Jejak Asap 

1. Buat project baru dengan nama Jejak Asap.aep, buat komposisi baru dengan pengaturan 
seperti dalam project sebelum ini. 

2. Import file gambar untuk background project dalam bab ini dengan durasi bebas. Jika 
ingin sama dengan project ini atur durasinya 7 detik. 

3. Masukkan dalam jendela Timeline. 

4. Klik 3D Layer dalam layer gambar untuk background, kemudian berikan garis disekeliling 
gambar dalam jendela komposisi berarna merah deng klik pada kotak Label. 

 
Gambar 7.1. 3D layer dan Label serta Hasil Pengaturannya 



5. Tambahkan layer Camera baru atur nilai Preset menjadi 28 mm, klik OK. 28 mm adalah 
ukuran focal length kamera.  

Focal length merupakan perhitungan jarak antara pusat optik lensa dengan sensor 
kamera, biasanya berbentuk milimeter (mm). Lensa ultra wide atau disebut fisheye 
memiliki focal length 24 mm (sebagian besar), bisa juga lebih kecil. Focal length 28 mm 
sampai dengan 35 mm digunakan untuk lensa wide. Lensa 50 mm hingga 85 mm 
digunakan untuk kategori normal/short-tele. Sedangkan yang lebih besar nilinya 
termasuk dalam kategori telephoto. 

6. Tambahkan layer Light baru dengan cara yang sama seperti menambah layer Solid atau 
Camera, untuk membuat layer light pilih Light. Tentukan :  

a. Nama layer dengan Emitter (harus), ini untuk mempermudah pengaturan 
selanjutnnya dalam menggunakan efek Particular. 

b. Atur nilai Light Type menjadi Point, kemudian klik OK. 

7. Ubah pengaturan Accepted Light menjadi Off pada layer gambar background, pada 
project ini bernama Antah Berantah. Setelah diubah maka efek light menjadi hilang. 
Layer Emitter ini selanjutnya akan menjadi acuan gerakan Jejak Asapnya. 

 
Gambar 7.2. Susunan Layer dan Pengubahan dalam Layer Background 

 

8. Tampilkan dalam mode Top, geser posisi layer background jauh ke belakang dan geser 
layer Emitter di belakang layer Camera 1. 

  
Gambar 7.3. Pengubahan Posisi Layer Background dn Layer Emitter 

 



9. Tampilkan kembali dalam mode tampilan Active Camera. Dikarenakan mundur, tampilan 
layer Background terlihat kecil, ubah ukuran layer Background sehingga tampil penuh       
satu komposisi. 

 

Catatan : 

Agar pengubahan ukuran gambar dalam layer Background proposional, saat mengubah 
ukuran dari salah satu titik yang ada di sudut, tekan tombol shift dan tahan. Lanjutkan 
menggeser titiknya sampai dengan ukuran yang diinginkan. 

 

 
Gambar 7.4. Tampilan Active Camera 

 

10. Animasikan layer Emitter maju mendekati layer Background, gunakan tampilan Top view. 
Buat dua keyframe pada Position layer Emitter. Setelah itu tambahkan script untuk 
menggerakkan otomatis layer Emitter. Penambahan perintah dapat dilakukan dengan 
menekan dan tahan tombol Alt, kemudian klik pada icon stopwatch Position. Isikan dengan 
perintah wiggle(.5,150), yang maksudnya menggerakkan setiap setengah detik 150 pixel. 

Keyframe yang ditambahkan dalam position, posisinya berbeda antara keyframe pertama 
dan kedua, ini untuk mengatur agar layer Emitter bergerak (lihat gambar di bawah ini). 

 
Gambar 7.5. Pengubahan Scale Composition 



Untuk melihat garis bantu pergerakan layer Emitter dalam Composition, klik icon Show 
Post Expression Graph (lihat gambar 7.5 yang dilingkari merah).  

 
Gambar 7.5. Pengaturan Animasi Layer Emitter 

 

Setelah dipersiapkan semua objeknya dan sudah dianimasikan juga selanjutnya adalah 
memberikan efek pada obyek yang telah disiapkan agar tampil seperti yang dibutuhkan 
dalam project Jejak Asap. 

 

B. Menambahkan Efek 

1. Buat layer solid baru dengan warna putih, akan tampil dengan nama White Solid 1. 
Tambahkan dalam layer White Solid 1 efek Particular, dengan memilih menu Effect, pilih 
Trapcode, klik Particular. 

 
Gambar 7.6. Tampilan Setelah Ditambahkan Efek Particular 

 

2. Berikan pengaturan dalam properti Emitter dalam jendela Effect Control. Ubah nilai 
Emitter Type menjadi Light(s). Pengubahan ini bias dilakukan jika nama layer light adalah 



Emitter. Tentukan nilai Velocity sampai Emitter Size Z dengan 0 (sementara). Lihat 
hasilnya dalam jendela Composition. 

3. Tambahkan gambar Cloud.png ke dalam project, gambar ini nantinya digunakan untuk 
mengubah texture Paricular agar mendekati realistis tampilannya. Setelah itu masukkan 
dalam jendela Timeline, invisible tampilannya. 

4. Atur property Particle dalam jendela Effect Control, ubah pada bagian Particle Type 
menjadi Sprite, kemudian ekspan Texture dan ubah nilai Layer menjadi Cloud.png. Ubah 
juga nilai Size menjadi 60. 

    
Gambar 7.7. Pengaturan Sementara Properti Emitter dan Particle 

 

Jika pergerakan sudah fix maka ini tidak perlu diubah lagi. Jika setelah melihat tampilan 
hasil dan dirasa ada yang kurang pas atau tidak sesuai, maka ikuti langkah selanjutnya. 

 
Gambar 7.8. Hasil Setelah Particle Diubah Gambar 

 

5. Setelah dilihat, Anda mungkin merasa hasilnya terlalu mulus, Anda pasti akan berkata 
tidak mungkin ada asap seperti itu. Oleh karena itu selanjutnya perlu dilakukan 



pengaturan gerakan animasi layer Emitter. Mundurkan lagi layer Background lebih jauh, 
dan ubah posisi layer emitter mendekati layer Background, geser pada keyframe ke-2. 
Anda dapat melakukannya dalam jendela Composition, Top view. 

6. Ubah dalam property Emitter nilai Velocity from Motion menjadi 17. 

7. Ekspan Rotation dalam property Particle. 
a. Rotation Z menjadi 0x314° 
b. Ubah nilai Random Rotation menjadi 11. 
c. Rotation Speed Z menjadi 0.2. 
d. Ubah Size lebih kecil menjadi 43, 
e. Size Random (%) menjadi 32, 

 
Gambar 7.9. Perubahan Jejak Awan Setelah Dilakukan Pengaturan 

 

8. Pada Properti Physics  
a. Ekspan Air, Ubah Air Resistance menjadi 2, 
b. Aktifkan Air Resistance Rotation klik pada check box, 
c. Ekspan Turbulence Field, ubah nilai Affect Position menjadi 104, 
d. Scale menjadi 5, 
e. Evolution Speed menjadi 20. 

 
Gambar 7.10. Hasil Pengaturan di Property Physics 



9. Untuk memperpanjang waktu tampil particle, ubah nilai Life [sec] menjadi 15. 
10. Ubah Size After Life dan Opacity After Life seperti di bawah ini. 

 
Gambar 7.11. Pengaturan Agar Ukuran Jejak Asap Membesar di Akhir Tampilan 

 
11. Duplikasi layer Emitter sebanyak dua kali, atur Position tiap layer agar berada di posisi 

yang berbeda dengan langkah, tempatkan play head pada posisi keyframe terakhir, klik 
pada teks Position, geser layer Emitter menggunakan garis hijau atau merah. 

 
Gambar 7.12. Urutan Pengubahan Posisi Layer Emitter 

 
12. Klik Layer White Solid, tambahkan :  

• Efek Fast Blur, Tentukan nilai Bluriness 3.0 
• Curve. Atur sesuai dengan kebutuhan. 

 
Gambar 7.13. Tambahan Efek dan Hasilnya 



13. Optical Flare data digunakan untuk menambahkan cahaya pada asap, optical flare 
merupakan plugin efek dari pihak ketiga juga yang memberikan banyak pilihan cahaya 
dan pengaturan yang detail. Setelah menginstal plugin efek Optical Flare, cukup ubah 
pengaturan Source Type menjadi Track Light dalam Positioning Mode. 

 

C. Hasil Akhir 

Setelah semua layer dibuat dan sudah diberikan efek, hasilnya akan terlihat seperti gambar 
di bawah ini. Secara otomatis cahaya akan mengikuti gerakan asap, karena gerakan cahaya 
dan asap mengikuti gerakan layer light yang bernama Emitter. 

    

    
Gambar 7.14. Hasil Akhir Project Jejak Asap 



BAB VIII 

Vfx movie : shield like dr. strange movie 
 

Dr. Strange adalah film animasi super hero yang diproduksi oleh Marvel Studio berdasarkan 
komik marvel. Dr. Strange karakter utama dalam film tersebut dalam melakukan aksi menumpas 
kejahatan memiliki kekuatan berupa shield dan portal. 

    
Gambar 8.1. Dr. Strange Shield dan Portal 

(Sumber : Wallpaper.com dan Vectorid.net) 

 

Bsnysk ysng tertarik dengan efek yang digunakan dalam film tersebut, khususnya shield. Meski 
banyak juga yang tertarik untuk bias membuat kedua efek dalam film Dr. Strange. Dalam bab ini 
akan membahas secara detail tentang efek shield menggunakan tool dan efek yang ada dalam 
After Effects CS6. 

Bab ini juga akan membahas banyak tentang penggunaan shape tool untuk membuat objek 
bangun dalam After Effect, sebagai bahan dasar pembuatan shield yang digunakan oleh Dr. 
Strange. Selain juga ada efek glow, cloud, dan lainnya. Langkah dalam membuat shield dapat 
dilakukan seperti di bawah ini. 

 

A. Menyiapkan Project, Composition dan Objek 

1. Buat Project baru beri nama Shiekd.aep. 

2. Buat Composition baru dengan preset Custom, tentukan ukuran dimensi width 720 px, 
dan height 405 px. 

3. Tentukan Pixel Aspect Ratio : Square Pixel, Frame Rate 25 FPS, Durasi 10 detik, dan 
background black. 

4. Setelah terbuka komposisi baru, selanjutnya membuat objek shape untuk shield, cukup 
banyak objek shape yang digunakan. Tool untuk membuat shape seperti di bawah ini : 



 
Gambar 8.2. Shape Tool 

Shape tool dalam After Effect mempunyai dua fungsi, bisa sebai mask atau shape. Jika 
dalam menggunakan shape tools ada layer yang terpilih, maka akan menjadi mask. 
Sedangkan jika tidak ada layer yang terpilih, akan menjadi shape jika digunakan. 

 
Gambar 8.3. Shape yang Digunakan untuk Membuat Shiled 

 

5. Buat objek lingkaran menggunakan Elips tool, tekan dan tahan Rectangle tool sampai 
terlihat seluruh tool di dalamnya, klik Elips tool (lihat gambar 8.2). Selain itu dapat 
menggunakan tombol keyboard dengan menekan huruf Q berulang sampai menampilkan 
simbol Circle tool. Letakkan ditengah komposisi, duplikasi dengan menggunakan Shift D, 
perbesar ukurannya. 

6. Buat objek kotak menggunakan Rectangle tool seukuran lingkaran besar, Duplikasi layer 
putar 45°. Hasil pembuatan langkah 5 dan 6 bisa dilihat di bawah ini. 

 
Gambar 8.4. Gambar 4 Objek Lingkaran dan Kotak 



7. Isikan dalam lingkaran kecil dengan kotak kecil yang diatur susunan dan rotasinya seperti 
gambar di bawah ini. Setidaknya ada 6 kotak dalam lingkaran kecil. Tempatkan dalam 
satu objek shape keenamkotak kecilnya. 

8. Setelahnya, klik kanan dalam layer shape kotak kecil, klik Pre-Compose untuk 
menjadikannya komposisi. Berikan mask untuk menutup kotak kecil dalam lingkaran. 

 
Gambar 8.5. Penambahan Shape Kotak dan Mask dalam Lingkaran 

 

9. Buat shape Star, buka pengaturan shape dalam panel Timeline, Contents, Polystar 1, 
Polystar Path 1, ubah nilai Points menjadi 8 aka menjadi bentuk bintang segi 8, ubah juga 
nilai Inner Radius, sesuaikan nilainya agar berubah bentuk menjadi polygon segi 8. 

  
Gambar 8.6. Penambahan dan Pengubahan shape Star Menjadi Polygon 

 

10. Duplikasi Polystar 1 yang diubah menjadi polygon, ubah nilai Inner Radius dan Outer 
Radius. Sesuaikan perubahan nilai sehingga menjadi shape seperti gambar 8.7. 



    
Gambar 8.7. Pengubahan Polygon Hasil Duplikasi 

 

11. Klik Contents kemudian klik tombol Add, klik Merge Path untuk memotong dua Polystar. 
Ubah nilai Mode dalam Merge Path 1 menjadi Intersect. 

     
Gambar 8.8. Hasil Perubahan Polystar Setelah Diatur Intersect 

 

12. Duplikasi layer shape polystar, perkecil ukuran objek sekitar 20% dengan mengubah nilai 
Scale. Ulangi langkah ini sekali lagi, sehingga ada 3 objek polystar. 

13. Buat objek lingkaran sebanyak 5 objek shape (gunakan duplikasi), atur ukuran dan 
ketebalan garis objek seperti gambar di bawah ini. 

 
Gambar 8.9. Tampilan Akhir Pembuatan Objek Shield Menggunakan Shape Tools 



14. Setelah semua objek shape dibuat dan ditata seperti pada gambar 8.9, seleksi semua 
objek shape. Klik kanan dalam salah satu nama layer shape yang terseleksi, klik Pre-
Compose untuk menjadikan komposisi baru. Berikan nama Shape Shield pada komposisi 
tersebut, dengan menjadikan komposisi akan mempermudah pengaturan selanjutnya. 

15. Invisible layer Shape Shield, buat teks dengan area yang sangat lebar. Gunakan Type tool 
dalam toolbar untuk membuat teks. Isi tulisan bebas, gunakan huruf jenis simbol. 
Sebagai contoh seperti di bawah ini : 

 
16. Klik layer Text yang telah di buat, tambahkan Mask, buat mask lingkaran. Ubah nilai Mask 

1 dalam Mask dari semua Add menjadi None. Kemudian ubah juga nilai Path dalam Path 
Option dari semula None menjadi Mask 1. Ukuran dan posisi mask disamakan dengan 
ukuran dan posisi dari area untuk teks. 

 

 
Gambar 8.10. Pembuatan dan Pengaturan Teks Melingkar 

 

17. Ulangi langkah pada poin 16 di atas untuk membuat teks melingkar lainnya. Gunakan 
jenis huruf dan ukuran huruf yang berbeda. Buat tiga teks melingkar seperti gambar 8.11. 



 
Gambar 8.11. Tampilan Seluruh Layer Teks Melingkar 

 

Tampilan teks dapat diputar agar sesuai dengan kebutuhan dalam project. Memutar teks 
dapat diatur dari property text seperti gambar di bawah ini : 

 
Gambar 8.12. Pengaturan Jika Ingin Memutar Huruf 

18. Seleksi semua layer teks melingkar, jadikan komposisi seperti objek shield memggunakan 
perintah Pre-Compose, berikan nama Teks Shield di komposisinya. Visible layer Shape 
Shield, sehingga tampil gabungan kedua layer seperti di bawah ini : 

 
Gambar 8.13. Tampilan Seluruh Komposisi Shield dan Teks 



B. Menambahkan Efek 

Efek yang digunakan untuk membuat shield seperti dalam film Dr. Strange, salah satunya 
adalah efek Glow. Glow adalah visual efek untuk untuk menampilkan cahaya berpendar 
disekiling objek. Agar tampilan efek glow bias maksimal dan baik, perlu di ubah color depth 
dari project. Secara default color depth diatur 8 bpc, silahkan bias diubah menjadi minimal 
16 bpc (bit per channel). 

      
Gambar 8.14. Pengubahan Color Depth dalam Project 

 

Selain Glow, efek lain yang digunakan ada beberapa seperti Fractal Noise, Fast Blur, Curve, 
Tint (optional), dan Swirl. Penggunaan Track Motion juga bisa diberikan jika ingin 
menggerakkan shield mengikuti gerakan tangan. Tambahan efek lain seperti particle untuk 
percikan cahaya juga bisa ditambahkan jika dirasa perlu. 

Penambahan efek shield seperti pada film Dr. Strange, data dilakukan seperti pada langkah 
sebagai berikut : 

1. Buat komposisi baru, Anda bisa menggunakan menu Composition, klik New Composition. 

2. Masukkan komposisi Shape Shield dan Text Shield ke komposisi baru misalnya Comp 2. 

3. Berikan pengaturan dalam komposisi Shape Shield dan Text Shield tampil transparasi di 
beberapa bagian komposisinya seperti gambar di bawah ini. 

 
Gambar 8.15. Pengaturan Transparansi di Sebagian Komposisi 



Pengaturan transparansi pada komposisi dapat ditambahkan efek fractal noise dan track 
matte layer. Fractal noise dapat dianimasikan menggunakan script agar berjalan 
otomatis. 

4. Buat layer solid baru, tampil dengan nama Black Solid 1, tambahkan efek Fractal Noise 
dengan klik menu Effects, pilih Noise & Grain, klik Fractal Noise, berikan pengaturan : 

a. Contrast : 400. 

b. Brightnes : 21 

c. Scale : 110 

d. Tambahkan script pada Evolusion dengan nilai : time*150, untuk menambahkan 
script, tekan dan tahan tombol Alt, klik pada icon stopwatch Evolusion. 

 
Gambar 8.16. Pengaturan Fractal Noise 

 

5. Ubah track matte pada layer Shape Shield menjadi Luma Matte, cara pengubahannya 
dilakukan seperti di bawah ini : 

 
Gambar 8.17. Mengubah Track Matte pada Layer Shape Shield 

 

6. Tambahkan efek Fast Blur dalam layer Black Solid 1, dengan cara klik layer Black Solid 1, 
klik menu Effect, pilih Blur & Sharpen, klik Fast Blur. Ubah nilai Bluriness menjadi 27 
(optional). 



7. Buat layer solid baru akan tampil dengan nama Black Solid 2, tempatkan di atas layer 
Text Shield. Tambahkan juga Fractal Noise seperti dalam layer Black Solid 1. Pengaturan 
Fractal Noise dapat dilakukan dengan copy efek. Copy efek bisa dilakukan dengan cara 
klik Fractal Noise dalam layer Black Solid 1, tekan Ctrl+C atau klik menu Edit, klik Copy, 
selanjutnya klik layer Black Solid 2, tekan Ctrl+V atau klik menu Edit, klik Paste. Copy juga 
efek Fast Blur. 

8. Duplikasi layer Shape Shield, dan Black Solid 1. Geser ke atas layer Black Solid 2, klik layer 
Black Solid 1 hasil duplikasi, tambahkan efek Fast Blur, ubah nilai Bruriness menjadi 15. 
Ubah blending layer dalam layer Shape Shield hasil copy menjadi Add. 

 
Gambar 8.18. Pengaturan Blanding Layer Hasil Copy 

 

9. Hasil akhir pengaturan di atas seperti pada gambar 8.15. 

10. Buat komposisi baru, tampil dengan nama Comp 2, Masukkan Comp 1 ke Comp 2, 
tambah efek seperti di bawah ini dan hasilnya 

 

 
Gambar 8.19. Efek yang Digunakan dan Hasil Akhir dari Penambahan Efek 

 



11. Klik layer Comp 1, klik menu Effect, tambahkan efek sebagai berikut : 

a. Color Correction, Curve, pengaturannya di bawah ini : 

   
 

   
Gambar 8.20. Pengaturan Efek Curve dalam Layer Comp 2 

 

b. Stylize, Glow, Pengaturannya di bawah ini : 

 
Gambar 8.21. Pengaturan Efek Glow dalam Layer Comp 2 

 

c. Copy Glow Effect, ubah pengaturannya seperti di bawah ini : 



 
Gambar 8.22. Pengaturan Efek Glow 2 dalam Layer Comp 2 

 

d. Color Correction, Curve, pengturannya di bawah ini : 

    
Gambar 8.23. Pengaturan Efek Curve dalam Layer Comp 2 

 

C. Hasil Akhir 

Setelah menambahkan efek dalam layer Comp 2, selanjutnya dapat dilakukan pengaturan 
animasi pada objek yang diinginkan. Dalam project ini, animasi diberikan pada objek polystar 
yang terbesar, semua objek teks. Animasi objek tersebut ada yang bergerak ke kiri, atau ke 
kanan, ada yang cepat dan ada yang lambat. Silahkan Anda tentukan sendiri, sesuai dengan 
kebutuhan tampilan project Shield Anda. Berikut ini tampilan akhir project Shield sepeti efek 
dalam film Dr. Strane. 



   

   
Gambar 8.24. Tampilan Hasil Akhir Efek Shield 
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After Effects merupakan software animasi membuat dan menambahkan 
visual efek, biasa juga disebut VFX, hingga motion graphic ke dalam sebuah 
video. Selain itu, mendukung penambahan objek dari produk Adobe, seperti 
Photoshop, Illustrator, dan lainnya. Ini sangat memudahkan desainer kreatif 
bidang editing video untuk mengembangkan karyanya. 

Buku ini menggunakan After Effects CS6 dimaksudkan untuk meringankan 
beban kebutuhan hardware dan software ketika ingin membuat efek atau 
belajar membuat efek. Buku ini dikhususkan bagi pemula atau pelajar yang 
sedang belajar membuat efek. Selain itu buku ini juga bisa digunakan oleh 
mereka yang ingin meningkatkan kemampuan dalam menggunakan After 
Effects. 

Selain pengertian dan konsep tiap perintah dalam After Effects, buku ini juga 
berisi langkah pembuatan project yang menarik dan terpeinci. Semoga buku 
ini bias menjadi referensi bagi desainer kreatif bidang editing video dan 
animasi. 
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